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Delta Media Servers: the hardware that provide optimised superfast delivery of uncompressed video
and audio across multiple synchronised devices to any number of output channels.

Part 1: DeltaServer Software

DeltaServer: the playback server software with comprehensive integration to external show control
devices and a limited user interface. DeltaServer serves its shows into the Playback Window, which is
usually shown full screen during playback.

Part 2: DeltaGUI Software

DeltaGUI: the graphical user interface with full editing capabilities. DeltaGUI allows full control over
the display environment parameters, for multichannel, flat, curved, dome or mapped projection
surfaces.

Part 3: DeltaOffline

DeltaOffline: this is a dongle licence-limited edition of the full DeltaServer and DeltaGUI software,
designed for offline use by show creators on a PC rather than a Delta Media Server. Anything created
in DeltaOffline can be played back without limitations on a full Delta licence with Delta Media Servers.

Getting Help: Learning Delta

This guide covers the functionality of Delta Media Servers, using the DeltaGUI display setup, and
creating shows from mixed media, multiple effects, and controls. The version described and
illustrated here is Delta 2.8, but most of the principles are just the same as Delta 2.4 to 2.7.

From DeltaGUI Help menu:

30

56

444
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opens the eBook guide installed with your software.

Online Help
takes you to the latest online guides to all 7thSense Design products.
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Overview: Delta System Architecture

New starter? For workflow in Delta media systems, see:

Ø Delta Workflow for New Users 

This includes installing and setting up a control PC with DeltaGUI.

Media shows and displays that are designed, shaped and sized for specific environments rely on
systems integration to translate and control flat media and audio to real space.

Delta Media Servers are the hardware that provide optimised superfast delivery of uncompressed
video and audio across multiple synchronised devices to any number of output channels.

DeltaServer is the playback server software with comprehensive integration to external show control
devices and a limited user interface. DeltaServer serves its shows into the Playback Window,
which is usually shown full screen during playback.

DeltaGUI is the graphical user interface with full editing capabilities. DeltaGUI allows full control over
the display environment parameters, for multichannel, flat, curved, dome or mapped projection
surfaces.

DeltaGUI is a comprehensive user interface to all instances of DeltaServer found on the
network. DeltaGUI communicates through Ethernet, finding the server(s) automatically, and
presenting the resources available for interactive editing. It contains all the tools to position,
coordinate, and play multiple, layered timelines containing media resources, so users can
create complex shows and save them to disk for later playback. DeltaGUI is not essential for
playback, only for show creation.

DeltaAudio is a tray application and sub-component of DeltaServer, which runs automatically when
DeltaServer launches, to provide a common interface to audio devices. This application is
essential for audio playback.

Delta Web Service provides a web-based user interface to control multiple Delta servers. Overview,
Backup and Restore, playback Preview, user-created control pages, and scheduling are built-in.

https://portal.7thsense.one/user-guides/M084-delta-workflow-guide/
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· Delta uses various ports and protocols, including servers scanning for an available GUI, so the
Delta network should not be connected to an IT network or the internet, for security reasons as
well as interruption of timing between racks.

· External Control is available to each Server through RS232 or Ethernet.

This manual covers the functionality of Delta Media Servers, using the DeltaGUI display setup, and
creating shows from mixed media, multiple effects, and controls.

Multi Rack Architecture

Please note: From 2020 7thSense deprecated the terms master and slave for the dependencies
between devices. We now refer throughout to ‘Leader’ and ‘Follower’ in our products.

To maintain functionality, both terminologies continue to work internally, but our documentation no
longer uses the former terms. Users of pre-2020 products will need to observe the equivalence and
continue to use the previous legacy terms.

Delta is multi-rack capable, with the ability for DeltaGUI to be run from anywhere on the local network,
on one of the servers or, more normally, a separate machine. The servers can be grouped together,
with one as Leader rack, the others as Followers. The Leader rack then controls all timing, so that all
machines in the same group are locked in time (playhead control in Follower servers is locked to the
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Leader server, including any Stop and GoTo sequence commands). Only one instance of DeltaGUI
can control a specific server group, at a time.

DeltaGUI and servers communicate via Ethernet on a Gigabit local network.

Choosing a particular server to view its resources, timeline or preferences is simply a matter of
choosing the timing Group it lives in and then selecting the individual server by the server name. This
name is the PC’s machine name, which replaces the ‘My Computer’ desktop icon name. The text for
the Computer Name is the name reported to DeltaGUI. By default, the name is the serial number, e.g.
‘Delta3765’.

When interacting with multiple servers, you are presented with some multi-rack choices at certain
times. For example, when choosing File New, you are asked whether you wish to perform this on the
selected server, on all servers in this group, or on all servers.

When altering the Preferences, those shown are for the selected server.

Delta Versions

7thSense Delta software is under constant improvement and enhancement to meet the needs of
our users. This does not imply the need to upgrade any stable installation, unless you need new
enhancements. However, it is important that the installed version and build number of DeltaGUI
used, matches that of all the servers to which it is connected.
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Which version of Delta do I have?

DeltaServer Version

Go to the DeltaServer software dialog menu: About > About Server for the server software version.
Here (and in DeltaGUI > Help > About) you will find a precise build ‘fingerprint’, which you may be
asked for when seeking 7thSense diagnostic support.

You can also view the ‘Details’ information on the server front panel.

Alternatively, you can send a Telnet command ‘statusex’ to its IP address (e.g. over the free PuTTY
Telnet client), which will return VERSION=

DeltaGUI Version

Go to the DeltaGUI menu: Help > About GUI.

Help, Support and Upgrading

Please always quote every element in the build description line.
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If you require an installation package for a specific build of DeltaServer, please feel free to contact
support@7thsense.one.
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Installing and Uninstalling Delta

What is installed and where

In C:\Program Files\7thSense\Delta:

· DeltaAudio.exe

· DeltaGUI.exe

· Deltaserver.exe

· DeltaUninstall.exe

During installation, C:\Effects is created and populated.

In C:\7thSense\Watchdog are all program-related files for the Watchdog app to communicate with
the R-Series server front panel display. Watchdog also automatically restarts Delta if it closes
unexpectedly.

In C:\7thSense Data\7thSense (x64)\Delta\Guides:

· the Delta User Guide and Managing Delta Servers in pdf and eBook formats (.exe)

In C:\Program Files\7thSense (x64)\Delta\HelpFiles:

· ExternalControlHelp.html – the web page of all external control and sequence commands

In C:\Program Files\7thSense\Delta (x64)\Licencing:

· Licence.txt (7thSense licence terms)

In C:\Program Files\7thSense\Delta (x64)\Sequences:

· Sequences.xml (core system sequences)

In C:\Program Files\7thSense\Delta (x64)\System:

· configuration files for Delta applications

In C:\Program Files\7thSense\Delta (x64)\Utilities:

· 7thMovieViewer64.exe

· 7thUDP2TCP.exe

· 7thUDPAppLauncher.exe

· BackPack.exe

· DeltaFinder.exe
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· plus other files used by Delta and optional applications.

Uninstalling with DeltaUninstall.exe

· Removes all files from C:\Program Files\7thSense\Delta\ and creates a \backup folder in the
same location, and removes folder C:\Effects.

Backup folder contents

\Logs (all files from C:\Program Files\7thSense\Delta\Logs, 
all files from C:\Program Files\7thSense\Delta\Utilities\Logs, 
from C:\Program Files\7thSense\Delta\), plus these logs:

· bpLog

· DeltaAudioDebugLog

· DeltaServerDebugLog

\Sequences (copied from C:\Program Files\7thSense\Delta\Sequences)

\System (all files from Program Files\7thSense\Delta\System)

and from C:\Program Files\7thSense\Delta:

· installhistory.log which contains the install date and version of Delta

· version – the version of Delta that has been deleted.

When uninstaller is run, any previous backup folder is completely deleted and then recreated.

All C:\ user asset folders for images, movies, audio, shows, etc. are not touched by the uninstall
process.
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Terms and Definitions in Delta

Term Context Explanation

29.97 media NTSC standard, the TV broadcast video framerate, originating from
early colour TV transmission problems between chrominance and audio
carrier signal phasing at 30 fps. Resolved through use of drop
frame  timecoding.

3D active display Active 3D separates left and right eye images by displaying them as
alternate frames, with synchronised battery-operated shutter glasses to
allow eyes also only to see alternately.

3D passive display In passive 3D, left and right eye images are separated by cross-
polarisation of alternate pixel rows by the projectors, and glasses with
polarising lenses in opposing axes. Effectively the eyes see alternate
rows.

Art-Net show creation A UDP communications protocol for DMX512-A lighting control and for
remote device management (RDM).

azimuth projection See heading .

blend display Overlapping projectors are used to create seamless continuous display.
Edge blending adjusts the amount of overlap and consequent increased
intensity of the overlapped display area. A single channel, mesh or
textured image can also be blended to soften its edges. In Delta, blends
can also be shaped and fully characterised.

canvas display The total area or display surface to be covered by projection media by a
DeltaServer show.

carving media A means of reducing overall server load by cutting media frames down
to just the area required per channel. Typically employed for large dome
displays.

channel display The feed route, in or out, of media, or part of total media of a multi-
channel system (audio channel, L / R / Rear / etc.; projection channel
covering part of the canvas, or display panel area).

channel view display The section of a canvas ‘seen’ by a display or projection channel.

chroma key show creation Sets which colour will become transparent to layers below.

composition mode display The arrangement of compacted media frame elements on a canvas.

display display The total surface receiving a visual channel or arrangement of
channels.

distortion: point display Distortion of a surface by the displacement of a node or nodes to affect
an area of the surface.

distortion: surface display Smooth overall distortion of an image or channel around midlines or
corners.

distortion: timeline display Bowing, skewing and stretching an image or channel.

dome mode display Projection of media onto a spherical or elliptical surface.

drop frame media In order to match video at 29.97 fps with real time clocks at 30 fps, this
time code drops two frames every minute, on the minute, except every
tenth minute. Drop frame timecode is written with a semi-colon

19

20
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Term Context Explanation

HH:MM:SS;FF

EDID display Extended Display Identification Data. A metadata format describing
properties and capabilities of a display device for communicating to a
video source (graphics card), thus maximising compatibility without the
need for manual configuration.

EDID emulation display Also called ‘spoofing’, the graphics card can read a proxy source rather
than the actual display’s EDID. Delta Media Servers use software EDID
emulation to maintain the required grouping arrangement on working
displays should one (or more) display fail. If the display EDIDs are not
emulated, and connection between server and a display is broken, then
the display arrangement reverts to single display mode, causing media
distortion across the working displays, or black output across multiple
displays.

effect show creation Manipulation of an image or channel to change its appearance; any
form from fading to Notch effects.

elevation projection See pitch .

enumerate general When Delta programs generate lists of servers, media &c.

eyepoint display The point from which a display is ideally viewed; the viewpoint from
which media has been designed.

follower system A server assigned to follow the playback activity of a leader server.

foot-lamberts (ftL) projection A measure of the amount of light reflected per square foot by a screen.
SMPTE recommends 16 ftL as the level for a dark theatre. This would
increase to maybe 60 ftL in situations of high ambient light.

frame rate display The rate at which a frame-based video sequence is meant to be played
back, expressing frames per second (fps). For an audio track, the video
playback rate to which it is synchronised in production. SMPTE LTC
timecode  tracks have standard frame rates.

In DeltaServer, media assets run on a timeline with its own defined
framerate. For smooth playback, the Delta timeline frame rate should
match or be a multiple of the display refresh rate (e.g. the
timeline/content could be 25 fps, while the output refresh is 50 Hz). See
also refresh rate .

frustum projection The pyramidal section representing the rectangular field of view of a
projector or camera.

genlock time & timing The synchronisation of devices by linking them to a common timing
signal.

group system A master-slave(s) relationship of two or more servers to synchronise
their timing.

heading projection Angular displacement ‘west’ of ‘north’ (0-180° -ve) or ‘east’ of ‘north’ (0-
180° +ve) where ‘north’ is straight ahead of the projector / observer. In
movement, equivalent to yaw; in astronomy, azimuth.

house sync time & timing Method by which an signal generator produces the time reference
(clock signal) for all genlocked servers in group, together with their
channel outputs and devices. The signal may be a square-wave pulse or
word clock for audio synchronisation.

interactive view projection In dome and mesh mode, moves the model around to enable the
viewpoint to be changed in DeltaGUI and the playback window.

22

22
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Term Context Explanation

layer show creation Also sublayer: render priority of simultaneous media.

leader system The server assigned to determine the timeline activity of a group.

location display Co-ordinates of media on a canvas, relative to the top-left corner or
centre.

LTC timecode time & timing LTC Timecode, or longitudinal timecode, is a SMPTE standard (see
SMPTE 12M specification) for encoding a timecode on an analog audio
waveform. It is called longitudinal, because it was originally recorded
lengthwise alongside other audio/video tracks on audio tape or film. In
the digital world, it is more often handled as a separate audio track
element that would be played in sync with other audio/video tracks, or
used as a positional reference signal sent out from one device to
another via an audio output, and an interpreting input at one or more
receivers. These receivers can then ‘chase’ the source. LTC timecode
has a disadvantage in that it cannot be read in a static state, because
the timecode is rolled out over time (longitudinally), so the audio signal
must be ‘rolling’ for a receiver to interpret it, and receivers require some
short amount of ‘pre-roll’ time before they lock to the signal.  The
standardised timebases for LTC time are 23.98, 24, 25, 30 drop-frame,
and 30 non-drop.

LTC chasing time & timing Synchronising playback to a reference LTC audio signal.

luma key show creation Sets which monochrome luminance value will become transparent to
layers below.

lumen (lm) projection SI or ANSI unit of total amount of emitted visible light. Used as a
measure of projector brightness. Higher brightness generally implies
higher available contrast.

Lux (lx) projection The unit of luminance (1 lx = 1 lm/m2) but see screen gain .

master system (deprecated term) The server assigned to determine the timeline
activity of a group.

mesh display A polygon mesh is a 3D graphic surface contructed from faces joined
by straight common edges. The end of an edge is a vertex, so a mesh
can also be described as the set of vertices that define a polyhedral 3D
surface. 

mesh mode display The Delta display mode for mapping media onto a 3D surface based on
a computer graphics object model of it.

MPCDI display Multiple Projection Common Data Interchange. A VESA  standard
data format for projection calibration systems to communicate with
devices in a multi-display configuration to produce seamless displays.
(Version 1, 2013; Version 2, 2015)

NDI® comms Network Device Interface developed by NewTek. A royalty-free IP
standard for allowing multiple video streams on a shared connection.
NDI supports high quality, low latency, frame-accurate video over
standard Ethernet networks.

node display Any selectable intersection point on a geometric grid or mesh.

non-drop frame
(NDF)

media 30 fps timecode video source played back at 29.97 fps. Note that being
played more slowly this drifts from real time.

NotchLC media A Luma & Chroma (YUV) codec that achieves compression rates
between 5:1 and 8:1 with minimal perceived quality loss. Suitable for
very large canvases, from Delta 2.8.

22
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OSC show control A network messaging protocol originally designed for musical
performances or show control. Introduced with Delta 2.8, provides a
dynamic, configurable and low-latency interface for Delta External
Control commands.

pitch projection Angular displacement above (0-180° +ve) or below (0-180° -ve) the
horizon from the observer / projector. Also referred to as altitude or
elevation. 

preview show review Web-based view of the Delta playback window.

real time show creation Real time clocks (RTC) ‘tell the time’ rather than relative time
displacement. DeltaRealTime is an application that enables gaming-
style assets in real time to be integrated into timeline playback media.

refresh rate display Refresh rate is the number of times an output image is drawn, per
second, whether in a digital projector, an LED display panel or a monitor
display. Expressed as frequency, e.g. 60 Hz. See also frame rate .

reserve timeline show creation Delta can fade from the current playing timeline to a Reserve Timeline
to enable fading back to a different position in the current timeline.

roll projection Angular displacement around the north (normal forward) axis,
anticlockise (0-180° -ve), clockwise (0-180° +ve).

screen gain projection Ratio of projected light to screen-reflected light, usually in the same
axis. As the viewing angle increases away from this axis, gain will
decrease (the screen appears progressively less bright). A gain of 0.8
means 80% of the projected light is reflected back. A screen with a gain
higher than 1 implies that the reflected light is focused to a narrower
angle than the incident light (which also means a narrower viewing
angle). The highest gain screens can cause hot spots and reflect
colours unequally. Lower gain screens will reduce light scatter in a
dome theatre, for example 0.55. For ‘screen brightness’:

lumens ÷ screen area × screen gain = ftL (see also foot-lamberts .)

sequence show control User-editable macros which can be called at any time from DeltaGUI or
via external control. They are useful for assembling a list of commonly-
used playback controls.

slave system (deprecated term) A server assigned to follow the playback activity of a
leader (previously master) server.

SMPTE Society of Motion Picture & Television Engineers: professional
membership and standards-setting association (www.smpte.org)

spline show creation A linear path described by Bezier curves for a resource to move along.

tearing time & timing Display image discontinuity caused by display synchronisation
problems.

timecode (SMPTE) time & timing An 80-bit data format in HH:MM:SS:FF (the range of frames FF being the
number of frames per second).

timecode (generic) time & timing A coded signal which carries timecode positional information for
coordination of devices. The most common formats of timecode signal
are LTC  and VITC .

timeline show creation A space in DeltaGUI measured in SMPTE timecode  along which
layers of media, effects and controls can be arranged to create a show
or part of a show.

20
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timing mode time & timing In Delta: display a Delta timeline in SMPTE , frames or seconds.

transition show creation Any time-spanned effect moving from one visual state to another, e.g.
fade, transparency, morph 

vertex media A point of intersection in a 3D graphical model where edges or
polygonal faces meet.

vertex group media A group of linked vertices in a graphical model; can be one element in
an .obj file.

VESA Video Electronics Standards Association

viewport display The visible portion of a total image or canvas.

VITC Timecode time & timing VITC Timecode, or vertical interleave timecode, is a SMPTE
standard for encoding a timecode signal into the vertical blanking
interval of a video signal. VITC has a very similar payload definition to
LTC, but has the advantage of being able to be read back even when the
video is playing back very slow or stopped. Whilst often used in
production, VITC is very uncommonly used for Pro AV device positional
coordination today, because it requires embedding in a video signal
versus a more easily processable audio waveform.

warp display Alter the geometry of a display channel or image, mainly to match flat
media to a non-flat display surface.

WebRTC show review Web Real-Time Communication streams Delta playback over IP for
viewing in a web browser.

word clock time & timing A digital audio signal designed for keeping digital audio devices in sync
with a constant, precisely-timed bit-rate of 44.1 or 48 kHz.

zenith projection The point directly overhead of the projector / observer (pitch = 90°).

^ top of page

Term Context Explanation

29.97 media NTSC standard, the TV broadcast video framerate, originating from
early colour TV transmission problems between chrominance and audio
carrier signal phasing at 30 fps. Resolved through use of drop
frame  timecoding.

3D active display Active 3D separates left and right eye images by displaying them as
alternate frames, with synchronised battery-operated shutter glasses to
allow eyes also only to see alternately.

3D passive display In passive 3D, left and right eye images are separated by cross-
polarisation of alternate pixel rows by the projectors, and glasses with
polarising lenses in opposing axes. Effectively the eyes see alternate
rows.

Art-Net show creation A UDP communications protocol for DMX512-A lighting control and for
remote device management (RDM).

azimuth projection See heading .

blend display Overlapping projectors are used to create seamless continuous display.
Edge blending adjusts the amount of overlap and consequent increased

22
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intensity of the overlapped display area. A single channel, mesh or
textured image can also be blended to soften its edges. In Delta, blends
can also be shaped and fully characterised.

canvas display The total area or display surface to be covered by projection media by a
DeltaServer show.

carving media A means of reducing overall server load by cutting media frames down
to just the area required per channel. Typically employed for large dome
displays.

channel display The feed route, in or out, of media, or part of total media of a multi-
channel system (audio channel, L / R / Rear / etc.; projection channel
covering part of the canvas, or display panel area).

channel view display The section of a canvas ‘seen’ by a display or projection channel.

chroma key show creation Sets which colour will become transparent to layers below.

composition mode display The arrangement of compacted media frame elements on a canvas.

display display The total surface receiving a visual channel or arrangement of
channels.

distortion: point display Distortion of a surface by the displacement of a node or nodes to affect
an area of the surface.

distortion: surface display Smooth overall distortion of an image or channel around midlines or
corners.

distortion: timeline display Bowing, skewing and stretching an image or channel.

dome mode display Projection of media onto a spherical or elliptical surface.

drop frame media In order to match video at 29.97 fps with real time clocks at 30 fps, this
time code drops two frames every minute, on the minute, except every
tenth minute. Drop frame timecode is written with a semi-colon
HH:MM:SS;FF

EDID display Extended Display Identification Data. A metadata format describing
properties and capabilities of a display device for communicating to a
video source (graphics card), thus maximising compatibility without the
need for manual configuration.

EDID emulation display Also called ‘spoofing’, the graphics card can read a proxy source rather
than the actual display’s EDID. Delta Media Servers use software EDID
emulation to maintain the required grouping arrangement on working
displays should one (or more) display fail. If the display EDIDs are not
emulated, and connection between server and a display is broken, then
the display arrangement reverts to single display mode, causing media
distortion across the working displays, or black output across multiple
displays.

effect show creation Manipulation of an image or channel to change its appearance; any
form from fading to Notch effects.

elevation projection See pitch .

enumerate general When Delta programs generate lists of servers, media &c.

eyepoint display The point from which a display is ideally viewed; the viewpoint from
which media has been designed.

22
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follower system A server assigned to follow the playback activity of a leader server.

foot-lamberts (ftL) projection A measure of the amount of light reflected per square foot by a screen.
SMPTE recommends 16 ftL as the level for a dark theatre. This would
increase to maybe 60 ftL in situations of high ambient light.

frame rate display The rate at which a frame-based video sequence is meant to be played
back, expressing frames per second (fps). For an audio track, the video
playback rate to which it is synchronised in production. SMPTE LTC
timecode  tracks have standard frame rates.

In DeltaServer, media assets run on a timeline with its own defined
framerate. For smooth playback, the Delta timeline frame rate should
match or be a multiple of the display refresh rate (e.g. the
timeline/content could be 25 fps, while the output refresh is 50 Hz). See
also refresh rate .

frustum projection The pyramidal section representing the rectangular field of view of a
projector or camera.

genlock time & timing The synchronisation of devices by linking them to a common timing
signal.

group system A master-slave(s) relationship of two or more servers to synchronise
their timing.

heading projection Angular displacement ‘west’ of ‘north’ (0-180° -ve) or ‘east’ of ‘north’ (0-
180° +ve) where ‘north’ is straight ahead of the projector / observer. In
movement, equivalent to yaw; in astronomy, azimuth.

house sync time & timing Method by which an signal generator produces the time reference
(clock signal) for all genlocked servers in group, together with their
channel outputs and devices. The signal may be a square-wave pulse or
word clock for audio synchronisation.

interactive view projection In dome and mesh mode, moves the model around to enable the
viewpoint to be changed in DeltaGUI and the playback window.

layer show creation Also sublayer: render priority of simultaneous media.

leader system The server assigned to determine the timeline activity of a group.

location display Co-ordinates of media on a canvas, relative to the top-left corner or
centre.

LTC timecode time & timing LTC Timecode, or longitudinal timecode, is a SMPTE standard (see
SMPTE 12M specification) for encoding a timecode on an analog audio
waveform. It is called longitudinal, because it was originally recorded
lengthwise alongside other audio/video tracks on audio tape or film. In
the digital world, it is more often handled as a separate audio track
element that would be played in sync with other audio/video tracks, or
used as a positional reference signal sent out from one device to
another via an audio output, and an interpreting input at one or more
receivers. These receivers can then ‘chase’ the source. LTC timecode
has a disadvantage in that it cannot be read in a static state, because
the timecode is rolled out over time (longitudinally), so the audio signal
must be ‘rolling’ for a receiver to interpret it, and receivers require some
short amount of ‘pre-roll’ time before they lock to the signal.  The
standardised timebases for LTC time are 23.98, 24, 25, 30 drop-frame,
and 30 non-drop.

LTC chasing time & timing Synchronising playback to a reference LTC audio signal.

luma key show creation Sets which monochrome luminance value will become transparent to
layers below.

22
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lumen (lm) projection SI or ANSI unit of total amount of emitted visible light. Used as a
measure of projector brightness. Higher brightness generally implies
higher available contrast.

Lux (lx) projection The unit of luminance (1 lx = 1 lm/m2) but see screen gain .

master system (deprecated term) The server assigned to determine the timeline
activity of a group.

mesh display A polygon mesh is a 3D graphic surface contructed from faces joined
by straight common edges. The end of an edge is a vertex, so a mesh
can also be described as the set of vertices that define a polyhedral 3D
surface. 

mesh mode display The Delta display mode for mapping media onto a 3D surface based on
a computer graphics object model of it.

MPCDI display Multiple Projection Common Data Interchange. A VESA  standard
data format for projection calibration systems to communicate with
devices in a multi-display configuration to produce seamless displays.
(Version 1, 2013; Version 2, 2015)

NDI® comms Network Device Interface developed by NewTek. A royalty-free IP
standard for allowing multiple video streams on a shared connection.
NDI supports high quality, low latency, frame-accurate video over
standard Ethernet networks.

node display Any selectable intersection point on a geometric grid or mesh.

non-drop frame
(NDF)

media 30 fps timecode video source played back at 29.97 fps. Note that being
played more slowly this drifts from real time.

NotchLC media A Luma & Chroma (YUV) codec that achieves compression rates
between 5:1 and 8:1 with minimal perceived quality loss. Suitable for
very large canvases, from Delta 2.8.

OSC show control A network messaging protocol originally designed for musical
performances or show control. Introduced with Delta 2.8, provides a
dynamic, configurable and low-latency interface for Delta External
Control commands.

pitch projection Angular displacement above (0-180° +ve) or below (0-180° -ve) the
horizon from the observer / projector. Also referred to as altitude or
elevation. 

preview show review Web-based view of the Delta playback window.

real time show creation Real time clocks (RTC) ‘tell the time’ rather than relative time
displacement. DeltaRealTime is an application that enables gaming-
style assets in real time to be integrated into timeline playback media.

refresh rate display Refresh rate is the number of times an output image is drawn, per
second, whether in a digital projector, an LED display panel or a monitor
display. Expressed as frequency, e.g. 60 Hz. See also frame rate .

reserve timeline show creation Delta can fade from the current playing timeline to a Reserve Timeline
to enable fading back to a different position in the current timeline.

roll projection Angular displacement around the north (normal forward) axis,
anticlockise (0-180° -ve), clockwise (0-180° +ve).

screen gain projection Ratio of projected light to screen-reflected light, usually in the same
axis. As the viewing angle increases away from this axis, gain will

22
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decrease (the screen appears progressively less bright). A gain of 0.8
means 80% of the projected light is reflected back. A screen with a gain
higher than 1 implies that the reflected light is focused to a narrower
angle than the incident light (which also means a narrower viewing
angle). The highest gain screens can cause hot spots and reflect
colours unequally. Lower gain screens will reduce light scatter in a
dome theatre, for example 0.55. For ‘screen brightness’:

lumens ÷ screen area × screen gain = ftL (see also foot-lamberts .)

sequence show control User-editable macros which can be called at any time from DeltaGUI or
via external control. They are useful for assembling a list of commonly-
used playback controls.

slave system (deprecated term) A server assigned to follow the playback activity of a
leader (previously master) server.

SMPTE Society of Motion Picture & Television Engineers: professional
membership and standards-setting association (www.smpte.org)

spline show creation A linear path described by Bezier curves for a resource to move along.

tearing time & timing Display image discontinuity caused by display synchronisation
problems.

timecode (SMPTE) time & timing An 80-bit data format in HH:MM:SS:FF (the range of frames FF being the
number of frames per second).

timecode (generic) time & timing A coded signal which carries timecode positional information for
coordination of devices. The most common formats of timecode signal
are LTC  and VITC .

timeline show creation A space in DeltaGUI measured in SMPTE timecode  along which
layers of media, effects and controls can be arranged to create a show
or part of a show.

timing mode time & timing In Delta: display a Delta timeline in SMPTE , frames or seconds.

transition show creation Any time-spanned effect moving from one visual state to another, e.g.
fade, transparency, morph 

vertex media A point of intersection in a 3D graphical model where edges or
polygonal faces meet.

vertex group media A group of linked vertices in a graphical model; can be one element in
an .obj file.

VESA Video Electronics Standards Association

viewport display The visible portion of a total image or canvas.

VITC Timecode time & timing VITC Timecode, or vertical interleave timecode, is a SMPTE
standard for encoding a timecode signal into the vertical blanking
interval of a video signal. VITC has a very similar payload definition to
LTC, but has the advantage of being able to be read back even when the
video is playing back very slow or stopped. Whilst often used in
production, VITC is very uncommonly used for Pro AV device positional
coordination today, because it requires embedding in a video signal
versus a more easily processable audio waveform.

warp display Alter the geometry of a display channel or image, mainly to match flat
media to a non-flat display surface.
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WebRTC show review Web Real-Time Communication streams Delta playback over IP for
viewing in a web browser.

word clock time & timing A digital audio signal designed for keeping digital audio devices in sync
with a constant, precisely-timed bit-rate of 44.1 or 48 kHz.

zenith projection The point directly overhead of the projector / observer (pitch = 90°).

^ top of page 19
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Part 1: DeltaServer Software

Delta Media Servers hold all the media resources, each delivering up to 16 video channels and up to
32 audio channels*. One server may do all the work, or they can be grouped as Leader and Followers
to distribute and optimise performance. Show creation and display alignment uses the DeltaGUI
application, running on a separate PC or laptop, communicating over Ethernet to the DeltaServer
software. All user-created shows, media and settings are stored on the Delta Media Server so that
the DeltaGUI is not required during normal daily running of the show. A subset of show and server
controls is available over the web interface built into the server, including a live streamed preview of
the show.

* using timeline channel offsets, this can be increased, for example 4 × 32 channel files.
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DeltaServer Application

The DeltaServer software comprises the server user interface and the playback window. In normal
operation, the Delta PC runs DeltaServer on boot and starts the Playback Window in full screen mode,
then plays the default show chosen by the user.

To access the DeltaServer user interface on the server, press the F key if looking at the Playback
Window to toggle full screen mode off (press F again to restore full screen).

Status

This server’s IP
Shows the current IP Address, set in the Windows Local Area Network dialog (Internet Protocol
settings)

Connected to GUI on IP
shows the DeltaGUI IP address when connected

Telnet Connected on IP
shows a list of current Telnet connections

Mode
Leader or Follower
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Pool Resources
shows the total count of resources found on the media disk(s)

Timeline Resources
shows the total count of resources on all timelines for this show

Telnet IP
shows the Telnet address when connected

Timeline Controls

The SMPTE time code is shown on the left, then playback controls; Rewind, Step Back, Stop, Play,
Advance. Note these only appear on a Leader server.

Hold Shift whilst clicking the play button and play will reverse. The playbutton will stay in reverse
mode until Shift+Play are combined again.

Main Menu

File

From this menu, you can Load or Save a Delta file, clear the timeline (File > New), exit the application
(File > Exit).
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Display

Toggle the Playback Window between full screen and windowed, using the View menu.

Timeline

Jump to a specific frame using the Timeline > Jump to Frame menu.

Preferences > System

This simple dialog allows you to set basic server parameters such as:

Server Group
which group this server belongs to (1-64)

Server Type
Leader or Follower

Force Timing Broadcast
By default, timing packets are not broadcast if no Follower servers are detected in this group (in
order to lower network traffic). Enable this option to always force timing packets to be
broadcast in case other equipment depends on that timing.
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Startup Options (actioned in this order)

Startup Sequence
This sequence will be run on boot.

Load Default File
a full path to the default Delta show

Merge Permanent Resource File
a full path to the Delta show that will be merged after loading the main show (for masks etc.)

Merge Permanent Display File
Set an XDL file to be loaded after any file load (see display configuration files -xdl files).

Play On Start
If Yes, the Default file will be played when Delta starts, after the main show is loaded, before it
starts playing.

Start Delay: the seconds to wait before loading the default show

Timeline
which timeline to play on start

Note: Start Delay

Since Delta can play a show immediately after the PC boots, having a delay before Delta loads and
plays the default show allows the various Windows boot procedures to finish using any network,
CPU or disk resources that could interfere with Delta’s playback, for example to receive a valid IP
address if using DHCP from a network device.

It is recommended to set Follower Delta servers to a delay of at around 20 seconds, and a Leader
Delta server to 30 seconds to ensure the Follower servers are ready to play as a group.

Preferences > Communication

Ø See also Network Ports used by Delta Server. 

http://portal.7thsense.one/user-guides/M685-systems-comms-ports/index.html?ports_ports-used.html
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· Set the ports for DeltaGUI / Server comms. Leave as default unless there are specific network
restrictions, so that a default installation of DeltaGUI will find the server. If non-default ports are
used, configure any DeltaGUI applications to also use these ports.

· Choose which Ethernet adapter to use and what ports.

· Set optional DeltaGUI and Telnet timeout in seconds – use this if there is a possibility of the
network being removed so that the DeltaGUI can reconnect.
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Preferences > Video Capture

This page lists any capture devices found and their assigned IDs which map physical input
connectors to the resource on the timeline.

Normally, this list is populated automatically and needs no interaction, but if, for example, you would
like to swap the IDs around on a multiple input card, you can edit the Assigned ID for each card here –
this will be remembered in the registry next time the server application starts.

Note: do not allow two devices to have the same Assigned ID.

Delete Stored Capture Devices – press this button to remove all capture devices and enumerate
them again. Note this loses any previously edited Assigned IDs and is usually only used if a capture
device has been removed physically from the server, but the driver has not been removed properly –
this process attempts to find only real hardware.

GUI

Close DeltaGUI (wherever it is open) from this server.
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About

About Server
DeltaServer software and licensing details.

Shortcut Keys
See Appendix E: Shortcut Keys

Command Line Switches
See Appendix F: Command Line Switches

Update Licence
See Appendix B: Licensing the Server

Save System Log
See System Diagnostic Logs

Show External Control Traffic
See Troubleshooting External Control

Playback Window

The playback window launches with DeltaServer. It can be toggled full-screen with the DeltaServer
menu option: Display, or just by keying F. This window is not sized to the canvas.

Timecode / Movie Timecode Display

Drag either or both Timecode resources from the Resource (Text) pool onto the timeline, and enable
or disable as required. The text size, colour, opacity and position are set in the resource properties
(double-click, or right click the text resource on the timeline for the Resource Editor).

Information and Performance Display

Information can be overlaid on the show, as seen here (the same is available to be viewed in Web
Preview). Top left: timeline information, bottom left: playback settings, bottom right: audio VU meter
bars, and in the centre: the playback performance graph (with legend, top right).

465
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If enabled in Preferences > User Stats, the features available can be switched on and off with quick
keys:

G : view the graph

I : view the timeline information (shown top, above)

A : view the audio VU meter

S : view the playback stats (shown as the lower block, above)

The following view adjustments are persistent whilst DeltaServer is running, and have been used in
the illustration above:

Shift+arrows : Position the playback statistics on screen

Ctrl+arrows : Size the width and height of the playback statistics block (and type size)

Ctrl+Shift+arrows : Position the graph block

Ctrl+Shift+Q/W : Make graph block narrower/wider

Ctrl+Shift+Y/H : Make graph block taller/shorter



39

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 1: DeltaServer Software

Interpreting the information

1. Timeline 1 – Indicates the Timeline selected in DeltaGUI.

2. FrmDropped – Indicates the number of dropped graphics frames since last reset. Dropped
frames can be caused by many things, including open VNC windows, non-fullscreen playback,
additional applications running, timing issues, or graphics overloading.

3. MovieFrmDropped – Indicates the number of dropped Movie frames since last reset. Movie
frames drop when the disk bandwidth cannot keep up with the read request bandwidth in
playback. This may happen with too many movies on the timeline, too large of files for a specified
system, or indicate drive failures.

4. TotalFrm – Indicates the number of frames (always increasing) since the show load.

5. FrTm – Indicates the nominal time in ms per frame.

6. FrTm() – Indicates the time in ms that the current frame goes through render loop.
(A developer debug tool only.)
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7. LastUpload ms:GB/s () – Indicates the upload time of the last asset.
(A developer debug tool only.)

8. Delta2036 – Delta Sever / PC Name.

9. Leader – Indicates if this server is a Leader or Follower.

10. Servers in Group – Indicates the number of Delta Media servers in a given server group.

11. Servers Ready to Play – Indicates the number of Delta Media servers in this server’s group that
are cued.

12. SL=off – Indicates whether Seamless Loop is enabled or disabled.

13. Preview (Timeline): WebRTC – Indicates that Preview is enabled with the device name: WebRTC.

14. GFX (GLMem=2) – Indicates the registry setting: MoviesUseLocalGLMem = 2.

15. 1920 × 1200 – Indicates the graphics resolution of the desktop (when in desktop playback mode).

16. ATI Technologies Inc: AMD FirePro W8100 – Identifies the GPU in use by the Delta Media server.

[SDI systems insert a line containing SDI performance indicators, status of Direct DMA (direct
memory access), and SDI frame format.]

17. Movies – Cache 0/0 (d0/40:0) – Indicates the number of movies and resolution of those movies
for playback.

18. ReadyToPlay : Playing – Indicates Delta Media server’s play status.

19. AudioTracking – 16 Channels (Stereo) – Indicates the number of audio channels for which Delta
is configured.

20. ASIO Renderer (MAXSWChans 32) – Indicates the maximum number of parallel Audio voices, set
in the GUI preferences. The setting dictates the total number of audio tracks allowed to be loaded
into RAM for playback. Exceeding the maximum parallel voices (for instance by having 4 qty 8-
channel audio files and 2 single-channel audio files overlapping on the timeline) will result in not
all audio channels being audible.

21. Timing – Auto – Indicates the timing mode as set in the DeltaGUI Preferences > Timing tab. Auto
will choose the best timing method for smooth playback.

22. FPS – 60.000 – Indicates the framerate as set in the DeltaGUI Preferences > Timing tab.

23. FrTm – 16.668ms – 1000ms / FPS

24. MstAv FrmTm – 16.681ms – indicates the actual framerate (master average) at any given time.
This value will fluctuate slightly on normal playback.

25. Swp – 9.156ms – Indicates the difference in frame time and upload time.

26. (10Bit-Desktop) – Indicates that the desktop settings, Delta registry settings, and cabling are all
set for 10-bit mode. This message will not appear in 8-bit mode or if any of these values do not
allow for 10-bit desktop mode to be active.

27. Output Bandwidth=0.386 GB/s – Indicates the bandwidth used under the current graphics setup.
(Desktop resolution * framerate * RGB when in desktop mode).
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28. Licence=Unlimited – Indicates the licenced bandwidth allotment for this Delta Media server.
Exceeding this value will overlay a ‘Bandwidth Exceeded’ message on the output raster.

29. Timeline 1 : Frame – 2697 – Indicates the current frame number of the specified timeline.

30. SMPTE – 00 : 00 : 44 :: 57 – Indicates the SMPTE time of the specified timeline.

31. RED LINE – A reference line to the timing value specified in 5/23, over time.

32. YELLOW LINE – A reference line to the timing value specified in 24, over time.

33. GREEN LINE – A reference line to the timing value specified in 6, over time.

34. BLUE LINE – A reference line to the audio stray in ms, over time.

SDI systems insert a line containing timing data, status of Direct DMA (direct memory access), and
format

What the Graph Lines Mean

The two red lines denote the limits of playback: the bottom red
line is represents a zero baseline, and the top shows how many
milliseconds it takes to draw a single frame. The top red line is
not always clearly visible as should be under the yellow line.
The line spacing at 30 FPS playback therefore represents
33.3 ms, whilst at 60 FPS playback it represents 16.7 ms and at
120 FPS playback, 8.3 ms.

The yellow line shows the time taken for the graphics card to
actually draw the frame: if this spikes, it means that the
graphics card is reading the movie frames but is unable to write
them in time and so the (video) frame is dropped.

The green line refers to the performance/load of the whole
server: the CPU, RAM and GPU.

· When spiking between the red lines, it demonstrates an appropriate level of use that the server
components can manage.

· If the green line spikes up above the top red line once, it means that the performance/load of the
server was increased for a split second: this may cause a video frame drop due to the
performance/load being too much for the graphics card to draw a frame in time.

· If it is constantly spiking up above the top red/yellow lines then your server is not coping with the
demand on it, so you may need to reconsider its load.

· If the green line drops or spikes down this may be because the performance/load of the server is
decreased and movie frame(s) cannot be read. This shows as a movie frame drop, as the frame
cannot be rendered/drawn.
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The blue line monitors the audio and is only in view if you have audio devices attached and audio
resources on the timeline.

See also:

Ø Viewing and Previewing Shows  

Ø User Information / Stats

425

131
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Delta Supported Media and File Locations

DeltaServer can use many different types of media to create a show, including many effects and
transitions. The supported types and their functions are listed below. Their group locations follow
their type names on the C:\ drive (movies are on the E:\ drive because of their size).

Drive locations are set in Preferences > Disk Drive Configuration .

File Type Function

Movies A sequence of images (e.g. stars_0001.tga, stars_0002.tga) played back at the specified framerate.
TGA, 7TH/STH or DPX format files are preferred for performance

Images Single bitmap images in a variety of formats, up to 16384 × 16384 (graphics card dependent) pixels,
including full 8-bit alpha plane in TGA, TIF and PNG images

Audio Audio files in a variety of formats

Effects Includes: Fade: Fade the image to black or up from black over specified time. When placed on an audio
layer, also fades audio volume.

Transparency: Fade the image transparency to the lower layers over time.

Dynamic Transparency: You can set the opacity of these from external control by layer or resource
name using the LAYERFADE command.

Geometry Static distortion correction to match projectors to screens (flat, curved or full dome).

Morphed distortion to provide fly-in or transition effects.

As background layer affects a specified output channel; on a layer, applies effects to only that layer.

Video Capture Using an optional capture card or USB Web camera, multiple live video sources can be placed on the
timeline in exactly the same way as images. Spout input and web pages also appear as capture
resources.

Timing Controls Loop: Restart playing at the start of the timeline.

Stop: Stop playing at this point on the timeline.

Goto: Jump to a specific frame (or Marker).

Comment: Add user notes to the layer.

Marker: Named marker, allowing interactive or external control to go to that point.

Placeholder: A placeholder reserves a space on the timeline to be allocated to media.

GUI Beep: An audible beep on the DeltaGUI PC only.

Load Show: Load a different show at this point on the timeline.

Sequence: Call a sequence at a point on the timeline.

Section: Show a part of the timeline in a user-set colour to highlight it.

Text The text resource is a simple way of placing custom titling onto a show. The standard text resource can
be placed multiple times on the timeline, and the font, size, colour, animation and location specified
independently for each.

The Timecode text resource shows the timecode only of that timeline.

The Movie Timecode text resource (when placed on the same layer as a movie) shows the current
filename of the frame-based movie, or the filename and path of a codec movie.

Serial Events External devices can be serially controlled on a frame accurate basis by placing serial events on the
timeline, such as Start Projector or Select Source.

102
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File Type Function

Blending Edge blending to allow overlapped projected images to be blended into one seamless, continuous
display surface.

Colour Static colour correction to match adjacent projectors to each other.

Splines The Spline resource is a user-drawn path over which visual resources on that layer will follow. You can
draw the shape of the spline in the Spline editing page.

Art-Net Art-Net input and output controls allow interaction with external lighting, smoke or motion systems.

Container Containers include a Playlist for simple looping play of media and AV Assembly to allow grouping of
media into one set.

Shader Effects Types of shaders include Effects, Colours and Transitions, and Notch Effects  (with licence) can be
added.

Meshes, Show files and Autoalignment all have their own base folders on the same drive (typically C:
\).

Ø See also this guide: Managing Media for Delta Media Servers 

Movies

These are sequential image frames stored on a fast, hard disk. Supported playback file types
include; 7TH (STH), TGA, YUV, A7S, DPX, DPX 2.0HDR, OpenEXR SDR and HDR, CIN, SGI.

Codec filetypes (MXF, MOV, MP4, LXF, ASF, WMV, DV, MPEG-PS, MPEG-TS, GXF, FLV, AVI, MKV,
WebM, HapQ, 7thHapQS) are supported.

Codecs

Note: codecs are supported for media prototyping type purposes only, and are never
recommended as the final deliverable/show content.

With codec movie formats, the audio is in-built and speaker mapping is encoded in the file itself, so
Delta audio control available is therefore only volume control (no channel mapping as is possible
with separate audio files – see audio files below).

Since codec playback in Delta is CPU-based, this typically allows only 1-2 movies at HD 60p or
equivalent resolutions. For anything more, codec movies should be converted to image sequences
using Distributed File Manager.

NotchLC

This is a Luma & Chroma (YUV) codec that uses LZ4 to achieve compression rates between 5:1
and 8:1 with minimal perceived quality loss, and is suitable for very large canvases. From Delta 2.8,

49

51

52

52

53

53
413

https://portal.7thsense.one/user-guides/MC256-managing-media/
https://portal.7thsense.one/user-guides/MC256-managing-media/mm_distributed_file_manager.html
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NotchLC codec in .mov wrappers can be played, but note that audio is not enabled in this format. If
exporting from Adobe Media Encoder, first deselect ‘Export Audio’. 

Used in its .mov wrapper, NotchLC is CPU intensive and takes longer to process each frame. To
avoid this, whilst retaining the NotchLC format, use the ‘NotchLCTo7th.exe’ utility installed with
Delta 2.8.7 on.

Ø See: MC256 Managing Media for Delta, NotchLC to NotchLC7th utility. 

Supported file types for recording (also known as carving or slicing) are JPG, JPEG2000, BMP, TIF and
PNG, in addition to all movie formats listed above.

Individual movies are stored in separate folders under the MOVIES folder like this:

Note that the movie name presented in the DeltaGUI is the name of the First file found, minus the
frame count (e.g. Movie1_0001, Movie1_0002.tga, Movie1_0003 will be shown as ‘Movie1_’ in the
resources area (note the underscore).

Movie thumbnails

By default, DeltaServer creates a thumbnail of the first frame of every movie whenever the Resource
Pool is refreshed, and stores these in C:\7thSense\web\data\thumbnails. Thumbnails are used as
resource pool icons and on the timeline to help identify assets.

Movie files beginning other than frame numbered ~00 will show a thumbnail of the first frame found,
and display the number of the first frame, in the file Information shown on timeline resource hover,
and dialogs where a Start Frame is set. (A feature added with Delta 2.7.)

Example: Movie starts with frame ‘name_0140.tga’. Thumbnail of frame 140 is shown and in dialogs,
this additional information:

https://portal.7thsense.one/user-guides/MC256-managing-media/mm_notchlc-to-notchlc7th.html
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Note: ‘Start Frame 00’ becomes relative, so to stop at stop frame of 50 would mean frame filename
ending ‘name_0190.tga’.

Notes on Movie File Sequences

· The movie filenames require a fixed number of digits for the framecount, preceded by an
underscore, so:

Movie_0998, Movie_0999, Movie_1000 is acceptable
Movie_998, Movie_999, Movie_1000 is not suitable.

· For best playback performance of uncompressed media, use TGA, DPX sequences or convert
image sequences to one of the 7TH file format using the supplied DFM utility.

· Best performance is achieved when the Movies are served from one drive or RAID set, and all
other content is served from a separate drive.

Configure this in Preferences > Disk Drives in the DeltaGUI.

· TGA, SGI, CINeon, DPX or YUV single file per frame format require Solid State drives (SSD) to play
these movies in realtime.

· TGA single file per frame movies can also have an alpha plane – this will require fast disks.
Uncompressed or RLE compressed TGA files only

· DPX: .dpx formats are broadly supported:

o 8-bit (4:4:4)

o 10-bit (YUV and 4:4:4)

o 12-bit (4:4:4)
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o full support of little- and big-endian

o filled and packed types are both supported

o 8-bit RGBA

o 10-bit RGBA

o V2.0HDR is supported from Delta 2.7 build 7.

Encrypting Movies

Movies can be encrypted using 7thSense Distributed File Manager (DFM) with a valid date range and
venue code which is locked to a single or multiple USB keys to protect content from being used
elsewhere. 

Ø See: Managing Media for Delta Servers 

Movie Formats

Note: All outputs from a single server must be configured to the same video format and refresh
rate. See also Timing Configuration .

Format Image Quality Hardware Requirement

7th 6to1 Medium 6:1 compression, lowest hardware requirements; a legacy format no longer used

7th 420 Good [4:2:0] This is 2:1 compression, and can be the best compromise between quality
and performance

High performance disks required

7th 420 Z Good [4:2:0] 2:1 compression with lossless compression.

High performance CPU and disks required

7th 422 Excellent [4:2:2] This is 1.5:1 compression, and improves on the 420 format for quality.

High performance disks required

7th 422 Z Excellent [4:2:2] 1.5:1 compression with lossless compression.

High performance CPU and disks required

7th 422 10 bit Excellent [4:2:2] Added colour depth.

This is 1.5:1 compression, and improves on the 420 format for quality.

High performance disks required

7th RGB Z Perfect Lossless compression.

High performance CPU and disks required

7th 444 Perfect [4:4:4] No compression. 8-, 10- or 12-bit

High performance disks required

7th 444A Perfect [4:4:4:4] No compression

104

https://portal.7thsense.one/user-guides/MC255-managing-servers/
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Format Image Quality Hardware Requirement

High performance disks required
Alpha Layer

7th HapQ (YCoCgS) Good to Excellent 3:1 compression

YUV 422 Excellent [4:2:2] Raw, single 422 frames in 2VUY [UYVY] 8-bit format.

SSD disks required

DPX Perfect No compression, can be 8, 10 or 12-bit

SSD disks required

CIN Perfect No compression, can be 8 or 10-bit

SSD disks required

A7S Perfect No compression (can be losslessly compressed), can be 8 or 10-bit, RGB or 422
colour space.

SSD disks required

TGA Perfect Uncompressed or RLE compression, 24-bit (can have 8-bit alpha plane) or 16-bit
(optional 1-bit alpha plane). Single file per frame TGA files are supported (will
require SSD disks).

SGI Perfect No compression, 8-bit

SSD disks required

Note that TGA, A7S, CIN, DPX and SGI sequences can be used as movies with a system using SSD
and NVMe disks.

BMP, TIF, JPG2000 and JPG are not optimised for real-time playback, but can be used as a source
movie for recording out to another format.

Images

Images can be JPG, JPEG2000, BMP, DPX, DPX 2.0HDR, OpenEXR SDR and HDR, PSD, TIF, TGA,
PNG, GIF or A7S format. These are stored in the IMAGES folder, and can be grouped into

subfolders as required.

· Images can be up to 16384 × 16384 pixels in size depending on graphics card capabilities.
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· Images larger than this will be scaled down to 16384 × 16384 pixels.

The alpha channel is available in TGA, TIF (LZW and normal) and PNG file types.

Audio

Audio files are single sound files of WAV, MP3, MP2, AIFF type. These are stored in the AUDIO
folder, and can be grouped into subfolders as required.

Surround sound audio can be created using multi-channel WAV (up to 32 channels) or individual mono
WAVs (preferred), which can be directed to the appropriate output within Delta.

Ø Resource Editor: Audio Files  

Effects

Default effects include dynamic effects accessible to External Controls, and timeline effects
(transparency, fade, alpha) and a transform animator (movement effects). Other custom effects

can be added.

Ø Timeline Effects  

Ø see also: Shader Effects

Edge Blending

Preset blending files have the extension 7BL. These are created and stored using the DeltaGUI.
These are stored in the BLENDING folder, and can be grouped into subfolders as required.

Blends (if any) are also stored in each show file you save.

321

407

53
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Ø Display Configuration: Blending  

Geometry Correction / Warp

Preset warp / geometry files have the extension 7GM. These are created and stored using the
DeltaGUI. These are stored in the GEOMETRY folder, and can be grouped into subfolders as

required. Geometry (if any) is also stored in each show file you save.

Ø Geometry  

Serial Events

Serial Event files have the extension 7SE. These are shown using the DeltaGUI. These are
stored in the SERIALEVENTS folder, and can be grouped into subfolders as required, although

these groups do not show up in the DeltaGUI. Serial Event controls (if any) are also stored in each
show file you save.

158

364
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Com ports are configured in the Preferences dialog, see the relevant section below.

Notes

External Control is a built-in serial event device. You can output any string on the external control com
port or Telnet, e.g. to notify the controller that a specific point on the timeline has been reached.

If you create a file named ‘External Control.7SE’ in the SERIALEVENTS folder, the contents of this will
be available when adding an external control event to the timeline. This allows standard external
control commands to be available. The format of this file is the same as other serial event 7SE files.

Serial Events can be set to repeat for a number of counts and at a set frame interval.

Telnet Serial Events

A Serial Event can be output to a specific IP Address and port.

Ø Serial Events  

Colour Correction

Preset colour files have the extension 7CO. These are created and stored using the DeltaGUI.
These are stored in the COLOUR folder, and can be grouped into subfolders as required. Colour

controls (if any) are also stored in each show file you save.

Colour lookup table (LUT) files are also held here, in .CUBE file format.

384
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Ø Display Configuration: Colour Balancing and Convergence  

Ø Colour LUTs

Splines

A motion path for visual resources to follow can be created in the Splines menu. This path can
be saved to disk for use in other shows. Spline files have the extension 7BZ. These are shown

using the DeltaGUI. These are stored in the SPLINES folder, and can be grouped into subfolders as
required, although these groups do not show up in the DeltaGUI. Spline controls (if any) are also
stored in each show file you save.

Ø Splines  

Art-Net

An input or output Art-Net control with preset channels and values can be created in the Art-Net
and DMX Editor. This control can be saved to disk for use in other shows. Art-Net files have the

extension 7AN. These are shown using the DeltaGUI. These are stored in the ARTNET folder, and can
be grouped into subfolders as required, although these groups do not show up in the DeltaGUI. Art-
Net controls (if any) are also stored in each show file you save.

161
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Ø Art-Net and DMX  

Containers

Playlists or AV Assemblies can be created interactively in the DeltaGUI and saved out as Presets
to the Preset folder. Container controls (if any) are also stored in each show file you save.

Ø Playlist / AV Assembly  

Shader Effects

Shader Effects allow users to create and control the behaviour of the way all media assets are
rendered, through Delta by writing OpenGL fragment and vertex shaders. Effects can be

controlled either through the DeltaGUI or via external control over TCP, UDP or HTTP. Shader Effects
resources are in C:\Effects.

File types depend on the effects used, but are typically .frag and .xml. These are stored in the Effects
folder, and can be grouped into subfolders as required. One such folder could be \Notch for those
specific effects.

Licensed Notch users with a Notch Playback key, can import DFXDLL files for playback with exposed
parameters. Notch Effects must be saved to C:\Effects\Notch.

Ø Shader Effects  

Ø Using Notch Effects

390

398

408

413



54

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 1: DeltaServer Software

Sequences

Sequences are user-editable macros which can be called at any time from DeltaGUI or via external
control. They are useful for assembling a list of commonly-used playback controls. Timeline control
sequences are stored in individual XML files in C:\Sequences. Subfolders can be used by prefacing
the filename with a new folder name when creating the sequence.

Note: the full list of sequence code supported is accessed from the Sequence Editor > Help button.

Ø Sequences  365
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Part 2: DeltaGUI Software

Well worth it: learn some of the many shortcut keys for DeltaServer, DeltaGUI and
Playback Window:

Ø Appendix E: Shortcut Keys  

For Server Control

DeltaGUI is above all the server coordinator, connecting to and communicating with all Delta servers
on the network. It is not required to play a show, since DeltaServer itself can be controlled from many
external control inputs, as well as a browser-based preview facility and a customisable web-based
control interface for interacting dynamically with shows.

For Display Configuration

The Delta Graphical User Interface is the editing heart of the system. Here is where you set up your
display or projection theatre for all your projection, screens, sound and effects peripherals. Alignment,
colour convergence, warps, blends and meshes are all applied here.

These adjustments and calibration parameters for flat and curved screens, domes and mappings,
can then be applied to any media show for perfect, immediate delivery.

Alignment and blending for each mode: Flat plane, Dome and Mesh are described in more detail in
separate guides. To optimise performance, movie media may also require ‘carving’, i.e. each frame
cropped down to only the area required for a particular channel.

As Show Editor

DeltaGUI is also the resource editor: layering, sizing and manipulating media to create complex shows
on multiple timelines. It coordinates and synchronises all events, including live sources. Modified
resources, such as applied geometry, blends, colours, captures, playlists and animations, can be
saved and reused, and there is a macro language for creating repeat-use sequences.

465
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Server Connections

Individual Delta servers are assigned to a Group in the server Preferences menu:

DeltaGUI tries to connect automatically to all servers in the network, but individual server groups can
be blocked. This is done in the Configure > Preferences > Communication dialog to [Block Groups] so
that DeltaGUI will refuse connections from certain groups.
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Connect to a specific group on opening

If, when you start DeltaGUI up, you know what group you want to address, hold Shift down as you
open DeltaGUI. This will instead offer a selection dialog:

The drop-down list will show all 64 potential groups, and overrides any blocked server groups. Select
the required group and DeltaGUI will open connected to that group. The Preferences > Communication
> Blocked Groups option will be greyed out.

Ø (See also Communication Configuration .) 

View connected servers

You can view what servers are attempting to connect to this instance of DeltaGUI, by choosing the
Help > Server Connections option from the DeltaGUI menu.

107



59

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

This example dialog shows 5 servers:

Three have mismatched server versions, but the server at 10.100.101.74 has been accepted as not
blocked and is the correct version.

You can clear this list by pressing the Clear button – note that the list will now only show servers
which attempt to connect from then on – previously connected servers will not show up.

Shown below is a graphical view of all blocked or active groups, with attached or blocked servers and
the reason for blocking (blocked or mismatched versions):
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Clicking on any of the groups will select that group in DeltaGUI.

If ‘Group’ flashes red

If you are using a group of servers, there should always be a Leader server with the others set to
Follower.

If the Group flashes red (as below), there are other servers attached to the group which may not
actually belong to it (i.e. not in a Leader/Follower configuration): individual and groups of servers
should always be given their own group in the server software.
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Multi-Rack Control

The DeltaGUI is inherently multi-rack aware, and will find all Delta servers on the network if they are
not currently attached to a DeltaGUI instance.

You can choose to place servers into a Group (1-64), and then set one server to Leader, the others to
Followers. The Leader server will then broadcast timing information to the Followers over Ethernet.

You view a specific server by choosing its group, then the server by name. DeltaGUI therefore shows
one server’s timeline at a time.

Server List Dialog

To view all servers, choose Servers > View Server List from the main menu. This dialog offers a
summary of the current status of all servers and all timelines available.

You can start, rewind or stop all servers and set them all to fullscreen or windowed.

Copy Timeline

This action copies all timelines and/or display configurations from the show loaded on the selected
server into the currently-loaded show file on all selected destination servers.

As a convenient shortcut, the menu item Server > Copy Timeline allows you to propagate the show or
configuration from the currently selected server to either the current group or all servers.
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Note that the exact resources from one server are sent to the others, so if resources are kept in
different paths, or are missing, the show will not be constructed properly.

The current show is overwritten with the new show.

For all modes below, you can choose to copy the following:

Timeline
Copy the non-background timeline resources only.

Display Mode and Canvas
Copy the canvas dimensions, display mode (Flat / Stereo etc.).

Channel Configuration
Copy all channel configuration as well.

Mesh
For Mesh Mode, copy mesh configuration.

Include Background
For multi-server systems, display alignment geometry and blending may be placed on the
background and Copy timeline would normally overwrite these with the current server’s
timeline. If you uncheck the ‘Include Background’ checkbox, it will copy all layers except the
background, preserving server-specific background resources.
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Single Multiple

Copy from the chosen server to a single server selected in the drop-
down list.

Copy from the chosen server to a single server selected in the drop-
down list.
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Group All

Copy from the chosen server to all servers in the selected group. Copy from the chosen server to all servers in all groups.
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User Interface

When you interact with DeltaGUI, you are in fact changing the media live on the server and you can
see the changes immediately in the Playback Window, also when you save a Delta show, it defaults
to saving to the server PC, not the DeltaGUI PC.

In the example below, Layers editing is selected from the Workspace menu. [Click the labels to find
out more.]

Main Menu
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File

New (Ctrl+N)
show the File New dialog, which offers clearing the timeline resources from the selected server,
all servers in the current group, or all servers attached to the DeltaGUI. You can also optionally
reset display configuration to flatplane and clear background resources, and optionally stop
persistant sequences from running.

Open (Ctrl+O)
open a show file that is stored on the server. Note that non-persistent sequences will be
stopped.

When saving shows, they must not be running.

Save (Ctrl+S)
save the current show file to the selected server.
There is no dialog box for this: if the show xml file is previously unsaved, it will be saved as
Default.xml and overwrite any show previously saved to this name.
(Default.xml is not the same ‘default’ as the default startup show file: see Save As below.)
If previously named, it will be saved with the same name with which it was opened.

Save As
prompt for a filename, then save a show file to the selected server. The dialog box allows a
show to be allocated as your default startup file (see also Startup and File Load
Configuration ).100
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Merge
open a show file that is stored on the server, and merge it with the current timeline contents.

Open Locally
open a show file that is stored on the DeltaGUI PC. Note that a subsequent File Save will save
on the server.

Save As Locally
prompt for a filename on the DeltaGUI PC, and save the current show file to the DeltaGUI PC.

Save All As Locally
prompt for a filename, then save shows from all servers in the current group into separate
folders under the chosen folder.

For example, with 2 servers in the group, choosing C:\backups\myfile4.xml as a save file will
create file/folders like this:
C:\backups\MYSERVERNAME1_192.168.1.99\myfile4.xml
C:\backups\MYSERVERNAME2_192.168.1.111\myfile4.xml

In this way, even with the same filename, any differences on each server are maintained in
their own folders.

Open All
shows the File Open dialog, where you can choose whether to load a show with this name on
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the selected group or all servers attached to the server. Note that if the file does not exist, no
changes will be made to that server.

Merge All
same as the Open All dialog, but resources will be merged with the existing timeline contents
on the group or all servers.

Save All
shows the Save All dialog, where you can choose to save on the selected group or all attached
servers. You can also optionally stop persistent sequences from running.

Save All As
same as the Save All dialog, where you can choose to save with the same name to the selected
group or all attached servers.

Note that on all of: File Open, Save As, Open All and Save All As, you can also choose to set the
named show file as the Default File so that this file will load when the server is next booted.

About Merging

When one file is open, another can be opened to merge with it. Resources are merged according to
their Timeline and Layer. Timelines that are inactive in the first file will remain inactive, though
populated by resources from a merged file. Use Ctrl+T to figure timeline activity.

Edit

Items on this menu are universal shortcut keys for use when editing within the timeline area (Copy,
Paste, Undo etc.). Selection is by rubber-banding / marquee of items, and Copy selection to the
clipboard.

Paste At... (Ctrl+B)

This control has a dialog, which in ‘Basic’ mode allows pasting in relation to Mouse (enter a time
position), or Current (timeline cursor position).

Expand the dialog with the ‘Advanced’ button to select a time position in relation to a timeline Marker.
This also allows for repeated pasting at set intervals:
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In this example, three repeats at 1-second intervals (shown above) introduce a chime sound starting
from the timeline marker selected:

Display

Windowed / Fullscreen
displays the Server Playback window in restored size or full screen (the same as pressing F
directly in the playback window).
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Reserve Mode (Ctrl+R)
fade from active timeline to the reserve timeline, or back to the selected timeline. Set the fade
time in Preferences > Misc Settings.

Apply Show Mode
in one operation, configure the server to be ready for an audience. Selecting this option applies
the following immediately:

Playback goes full screen
Graph, Playback Statistics and Grid are turned off
Test patterns are turned off
Geometry, Edge Blending and all Beams are turned on
Channel mode is selected if in Dome (Frustum) mode

Servers

View the list of connected servers (see Server List Dialog )

Display switches (go to the Switches workspace) (see Switches )

Copy Timeline to other servers (see Copy Timeline )

Save Group as TGA opens a dialog to copy the playback window as a .tga image

View (Delta) Web Service opens Delta Web Service in the default browser on the DeltaGUI PC.

(see Managing Delta Media Servers: Delta Web Service)

View

Control what you need to see in DeltaGUI, but usefully, global views of resources available and in use:

Ø Toolbars  and Status Bar  

Ø Configure Timelines  (Ctrl+T shortcut for this dialog)

Ø Folders in the Resources Area

61

280

61

94 74

91

83

https://portal.7thsense.one/user-guides/MC255-managing-servers/mds_delta_web_service.html
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Ø Show the Timeline Summary

Ø List all timeline Markers

Ø Open the Audio Equaliser

Ø Open the Sequence Editor  (also Ctrl+Shift+S)

Ø Show the interactive Sequence Panel

Ø Open the Resource Finder  (Ctrl+F)

Ø Open the Art-Net and DMX editor

Ø List timeline names: see Using Timelines

Ø Populate the Resources Area  with resources available on disk, or just on the timeline, and by
type

Encrypted Movies

For handling content-protected (encrypted) movies, see the separate Delta Content Protection
System Guide. Here you can list or ingest encrypted movies.

Wizards

Wizards to help create:

Ø 3D Stereo Shows  

Ø Slideshows

Ø import (ingest) resources up to 200 Mb per file (see Ingesting (importing) Resources ).

Your User Licence code as provided by your supplier can also be ingested here (see Appendix B:
Licensing the Server ).

Configure

Preferences configuration
see ‘Setting DeltaGUI Preferences ’.

TCP connections
see TCP Connections

Help

About GUI
shows the full software version, and licence details and options.

307

298

440

369

382

306

351

89

83

148

416

308

457

98

96

https://portal.7thsense.one/user-guides/MC256-managing-media/mm_delta_content_protection_syste.html
https://portal.7thsense.one/user-guides/MC256-managing-media/mm_delta_content_protection_syste.html
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Contents
links to the user guide PDF.

Online Help
opens http://portal.7thsense.one/online-help/ in a web browser, containing all 7thSense user
guides.

Shortcut Keys
shows a summary of shortcut keys in DeltaGUI.

Server Connections
shows a summary of all connection attempts by servers to this GUI.

External Control
launches a web browser, showing the external control / sequence help file located on the
server, or if found locally on the DeltaGUI PC, from there.

Command Line Switches
shows a summary of the available switches you can use when running the server application to
alter its behaviour, such as forcing the server to start fullscreen or as a Leader server:

Affects this run only
-minimized : show the server dialog and playback window minimized
-minimizedialog : miminize the server dialog only in startup
-fullscreen : make the playback window fullscreen
-delay n : Delay the server startup for n seconds
-nopool : Do not look for resources on disk at startup

Changes are also stored for next run
-leader : Change the current mode to Leader
-follower : Change the current mode to Follower
-group n : Change the current group to n
-smpte_on : Enable the SMPTE tracking
-smpte_off : Disable the SMPTE tracking

Workspace Menu

These menus open different workspaces.

http://portal.7thsense.one/online-help/
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The upper menu row presents three workspaces: select between Layers (vertical), Layout
(canvas area) or Switches  (projection) view. 

The lower menu row opens workspaces for display configuration – the alignment of background
effects, as they affect projection to the whole canvas: Warp  (display geometry), Blend ,
Colour , and Spline  editors, and Display  (canvas) Configuration pages.

Server Selection

Each server is identified uniquely by its Ethernet IP Address. The machine name is presented here
under Servers, and either L: or F: to indicate whether this machine is configured as a Leader or
Follower machine within the group.

You can configure the selected server in Configure > Preferences .

Timeline Selection

Servers can have up to 32 independent timelines depending on model, you can select between these
timelines using this dropdown. Colours indicate status:

Timeline 1 has been named ‘Live Audience’ and is live (green line)

Timeline 2 is disabled (grey line)

Timeline 1 shown with Reserve timeline active (red line)

You can name timelines for the selected server using the Menu > View > Timeline Names dialog.
These names are shown as above, but can also be used during external control, for example naming
timeline 1 to be ‘upper’:

MEDIALAYER myresource 3 TL=upper

instead of 

MEDIALAYER myresource 3 TL=1

86 356

280

150 158

161 388 133

99
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Status Bar

The main window status bar carries some useful controls for quick access. Main menu > View allows
you to show or hide the status bar.

Main and Auto

These scrollable bars show active timelines (dark green) and whether they are set to autoplay (bright
green). Normally they are not interactive, but this can be switched in Preferences > User Interface >
Features, ‘Active Timeline Indicators’, so that you can toggle active and autoplay settings:

Display

This quick access menu allows for display of the alignment grid, a test pattern, to switch geometry
and blends on and off, or to revert to full audience-ready show mode in one click:
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Beams

Switching RGB beams on and off by all in a Group or by channel can be useful in display setup and
channel identification:

Snap Off

This provides quick access to the same settings as in Preferences > User Interface > Features,
‘Graphics’ for how resources snap to the timeline layer grid.

Forward

Switch the play mode (direction) from Forward to Reverse even during play (from version 2.6.74).
Note that the Spacebar is a stop/play control in the Preview Window, and Shift+Spacebar will reverse
play.

fps

Quick access to the timeline play rate as found in Preferences > Timing.

Layers Menus

There are two additional menus available in Layers view, ‘Layers’ and ‘Update’.
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Layers

 

Layers menu: Show

These menu options are mainly to help provide detail only when necessary, and declutter the Layout
panel if not. These settings are retained when DeltaGUI is closed.

Traces
Show Traces shows or hides the horizontal lines that extend from the transparency or fade up /
down resources. These are useful if you have complex sets of up/down fades and don’t want
the added complexity of the lines:

Tooltips
This enables or disables tooltips for timeline resources (mouseover to reveal properties):
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Highlighting
This enables or disables timeline resource highlights (i.e. displaying yellow with resource start
and end times when clicked for dragging):

Controls Text
Controls can be assigned (Resource Editor > Marker > Timeline) to keys (e.g. F2). This normally
shows in red, but can be turned off here:
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Remaining Time
When on, this shows the time position of the playhead within a resource:

 

Control Lines
In the above illustrations you will see the yellow Control Line, showing where a marker is, in the
layer. This can also be a help when adding a new resource: hold shift when dragging a new
resource and it will snap to the control line of the marker when close, even if the normal snap
controls are off.

Layer Menu: Snap

Off / Grid Only / Grid & Resources are also set in Preferences > User Interface > Graphics ‘Snap’, or from
the DeltaGUI status bar, where grid size and units can also be set:
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Select

This will select all resources showing to the left or right of the playhead position.

Collapse / Enable / Lock / Remove

This treats all layers together on this timeline.

Update menu
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The DeltaGUI timeline refreshes constantly (Preferences > User Interface > Graphics ‘GUI Update
Frequency’). Here you can lighten the load on the DeltaGUI PC (e.g. for a lower-spec laptop).

Disconnect GUI playhead from Server timecode
This is the same as the padlock button in the timing area – when disconnected (magenta), you
can go off and edit somewhere else on the timeline instead of being near the server’s playhead
position, so that playback is not interrupted. The timecode cursor also turns magenta (see also
Timing Area ).

Update GUI on play
Where there are many resources on a timeline, the flow can become juddery when playing. You
can choose not to see the DeltaGUI timeline moving along when playing. This setting still allows
normal tracking along the timeline when editing a show.

Update Serial Devices
Don’t output serial device resource commands (i.e. temporarily disable them to allow show
programming without triggering external equipment in a live scenario).

Play GUI beeps
Beeps are audible markers that can be placed as timeline markers. Switch the (local server)
sound on or off here .

Server Messages

Next to the Layers and Update menus is an area that both displays timeline error messages (in red)
and a log of all messages sent by this instance of DeltaGUI as client to any DeltaServer. Find the
small arrow on the right to open the log:

82
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All messages are listed, with their source:

To track just one server connection, add the required IP Address to the filter, and only messages to
this server will be logged. The log can be useful for identifying connection issues with any server.

Press Clear to delete all entries in the log. This page is also cleared when DeltaGUI is closed.

Timeline Controls

Reverse Playback

This feature was added to DeltaGUI from Delta 2.6.74. It is not available in earlier versions and builds.

Hold Shift whilst clicking the play button and play will reverse. The play button will stay in reverse
mode until Shift+Play are combined again. Alternatively, use the Reverse/Forward menu in the right
side of the status bar:
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The same holds true for the DeltaServer dialog playback controls.

In the DeltaServer Playback window, the spacebar is the normal play/stop keyboard control. Playback
can be toggled in the Playback Window, between forwards and reverse using Shift+Spacebar.

In reverse playback, the following are disabled:

· audio

· looping

· Art-Net

· recording

Timing Area

This allows the user to interact with the current frame, moving back and forth along the timeline, and
zooming in or out to show different parts of the timeline.

Timing resources are shown here, such as Loop, Stop, Markers etc. You can edit by dragging them,
right click to disable, delete etc., or double click to edit the properties.

The two Scroll Points can be dragged from the left / right edge into the middle so that the timeline
advances there, showing what’s coming on the timeline more easily.

The Shuttle controller can move forwards and backwards through the timeline at different speeds,
drag more to the left or right to speed up, release to stop again

The DeltaGUI Lock / unlock toggle switch is used to toggle between locking DeltaGUI to the server’s
timecode (default behaviour when DeltaGUI runs) or unlocking DeltaGUI from the server’s timecode
so that you can edit the timeline somewhere other than the current server timecode.
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GUI locked to server (padlock icon is black / locked): GUI timecode cursor is black and tracks the
server’s timecode. Adding new resources or editing, changing configuration and file loading or saving
are all disabled while the server is playing, so that playback is not interrupted.

GUI unlocked from server (padlock icon is magenta / unlocked): GUI timecode cursor is magenta and
is independent of the server’s timecode. All editing, configuration or file operations are available while
the server is playing, but note that playback can be interrupted (stall or stutter in playback) if, for
example, file saving or other operations are used.

Zoom Extents (Shift+Z) zooms the timeline out to show all resources.

Resources Area

Delta servers hold resources, which can be media (images, movies, colours), transformations and
manipulations, device controls and effects, captures of external media, containers of other media, or
‘macro’ sequences for control within a show.

Clicking the Resources / Timeline tab switches from viewing
all the available media and resources on the disk
[Resources] to viewing the resources that are present on the
current timeline [Timeline].

Pressing the various Media buttons on the Resources area
selects different types of media to be listed – in the example
above, Movies are selected.

You can drag media from here to a timeline layer when
viewing Resources, and edit the resource on the timeline by
double-clicking.

Hover the mouse over an icon to view further information
about that media.

If new content has been added to the server, press Refresh.
(The list is not dynamically updated in order to avoid adding
network traffic.)

To show only Presets, Resources or Presets and Resources,
press the Show button.

To swap between icon and detailed view, use the two
buttons on the lower right.

The middle button:  will expand the width of the resource
panel.

Alt+V+F is the quick key to reveal the full resource folders.
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Indexing (Enumeration)

When Delta starts, available resources are indexed afresh. This will normally take a minute or two,
depending on the number of resource files. In exceptional cases, where systems are being restarted
with a very large number of files, this may cause a problematic wait time. For these cases there is an
additional registry key in Delta 2.8 (7thSense/Delta/ResourceCarveGroup). This allows you to exclude
unnecessary folders from particular servers (e.g. carves not required) by name. See Appendix J:
Selective Resource Indexing .

Resource Folders

In the image above, the Resource Folders are shown (Menu: View > Resource Folders).

With this active, only the resources contained in the folder on the server at the top are shown,
allowing you to see only those you are interested in by grouping the various resources within
subfolders.

Extending the Pool View

In detailed, rather than icon view, long resource names can be read more easily by expanding the
view. Press the expand button or use Ctrl+Q to toggle the extra panel width.

486
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Customise the expanded width

There are two registry settings that configure the expanded width, in:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\7thSense\DeltaGUI\Layout\Flat
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· Close DeltaGUI.

· ResourceTreeWidth: This is initially set at 480. Set your custom width.

· ResourceTreeWidthEnable: 1 = start DeltaGUI using the custom width; 0 = start DeltaGUI using
the default width.

· Restart DeltaGUI.

Layers Area

This shows the various user-created layers containing the media. Note that layers higher up the
screen obscure those below them (Layer 1 in this example would obscure Layer 7 after the
transparent fade and where there is active content on Layer 7).
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You can edit properties on a resource by double clicking it, or right click and select Properties from the
menu.

Hovering the mouse over the resource will give further information on it:

A resource position and length on the timeline can be altered by dragging it in the middle or either
end.

If, by dragging, one resource overlaps another in its layer, the left-most resource will be ‘bumped’
down within the layer. By applying render order to visual media of a kind, in the same layer, more
control can be given to their positioning. This places them into sublayers (see also: Timeline
Summary ):307
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Delta can have up to 250 layers on a timeline. These are sequentially numbered, so
inserting or removing a layer will adjust other numbers. These number references can
be used in show programming (Sequences). To preserve numbering you can assign

groups of media (e.g. a movie with its audio tracks) to layer groups (e.g.: layers 1-10, 100-110, 200-
210).

How Layers Work

There are three kinds of layer:

Playback layers
Any media can be applied to these layers, including animations, geometry, sequences etc.
These layers can be deleted, re-ordered, enabled, collapsed and locked, and reside above Art-
Net and Background layers.

The Art-Net and DMX lighting control layer
All Art-Net controls reside separately in their own layer.

The background and display layer
This layer contains warps, blends and colour, and is included in the information that comprises
the display configuration file (.xdl). It therefore applies to all Timelines.

In the Delta ‘Layer’ concept, movies, images, audio etc. can be placed on up to 250 separate layers.
Where images and movies occupy the same part of the canvas at the same time, the higher layer will
be shown. Imagine looking into a pool, where lily pads may obscure all or part of the water, where fish
viewed between the pads themselves obscure weed below them, and so on. Whatever the Layer
number, the stack of layers is like the pond, with the surface at the top. Opacity / transparency is a
property of a resource in a layer, not of the the layer itself.

You can alter each image or movie’s transparency, so that layers below are only partially obscured,
and even perform crossfade-type transitions between layers to provide smooth effects (see Timeline
Effects ).407



89

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

How visual layers appear (note layer 1 obscures layer 12):

How layers are actually arranged inside Delta – Layer 1 is higher than layer 12, which is higher than
the background layer:

The same applies to sublayers (render order) within a layer.

Using Timelines

Delta can have multiple timelines, which are independent of each other within the same server. This
allows you to create and present timeline 1 to the audience while editing timeline 2 in the background,
then smoothly crossfade between the 2 timelines. You can also use other timelines for purely audio,
or as control timelines for Serial Events.

Timelines are interleaved by opacity masks of their own. How timelines interact in terms of their
opacity and layer precedence, is determined by the Timeline Mode, in the Timelines Dialog (Configure
Timelines ).91
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Reserve Timeline

This is an interactive mode such that when active, only those resources on the reserve timeline (not
single-channel Delta Nano) are shown, and pressing the [R] button on the toolbar (or Ctrl+R, or
through external control) fades between normal operation (current timelines shown) and Reserve
Mode (Reserve timeline only shown).

This enables users with live events happening at unknown times (for example) to play a movie, then
gracefully fade to a background image, move the timeline head to a new position (the audience still
see the background image while this is happening), then start playing a new movie and gracefully
fade up.

You can choose which active timeline is the Reserve timeline on the Timeline dialog (Ctrl+T), and set
the fade time in Preferences > Misc Settings.

‘Out of the box’, there are two active timelines, 1, and 8 assigned as default [R]eserve. This is
suitable for placing an image onto timeline 8 to which to fade, non-playing. Once you configure
multiple timelines, your Reserve must be one of these, and can hold and play movie and audio
resources.

Timeline Names

Timelines are numbered 1 to 32, but you can name each timeline such that external control or
sequences can use the named timeline:

Mediainsert type=image resourcename=white TL=Backup

instead of:

Mediainsert type=image resourcename=white TL=3

You can access the timeline names in DeltaGUI from the menu, View > Timeline Names.

This name will show to the left of the timeline dropdown, also above the slider for that timeline in the
Timelines dialog and in the DeltaGUI title bar.
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Note that timeline names are stored in the show XML, File > New will reset them to numbers only
and they are not loaded with XDL files (as with other timeline parameters).

Configure Timelines

Access the timelines dialog with Ctrl+T, or from the TL button in the bottom left of DeltaGUI, or View
Timelines from the menu.

This brings up the timelines dialog from where you can change the opacity of each of the timelines,
configure how many live timelines you have, and play/stop/cue individual or all timelines.

Note: Cue is not ‘Pause’! It preloads frames so that Play is then instantaneous.
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Pressing Configure activates the controls at the right of the dialog, and the ‘Visual’ (uncheck to
disable visual resouces only) checkboxes per timeline. You can now choose how many Active
timelines you need.

You can also set which active timeline is designated as Reserve so that pressing Ctr+R, or the R
toolbar button in DeltaGUI – or calling the Reserve command in a sequence – fades down to this
timeline. You can also turn off Reserve capability completely, allowing all 32 timelines to be used.

Timeline Mode

Choice of mode can improve rendering efficiency, but implies careful design considerations. The
simplest approach is Normal, but is most demanding. The most efficient is Global Z.
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Normal
Higher timelines (1 is the highest) obscure lower timelines and the opacity values set the
opacity of the entire timeline. The opacity is a black background to each timeline. This does not
affect the opacity of individual resources in their layers.

Global Z
Layers across all timelines are Z Order, so layer 1 on any timeline is higher than layer 66 on any
other timeline.

Composite
This mode is the same as Normal, but with transparency between timelines.
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Affects

Choose This Server for one server only, or All In Group where opacity sliders will affect all servers in
the group.

You can also set a timeline to be Visual or not with the checkboxes below each timeline – Visual
timelines increase rendering load, so you may have a non-visual timeline for audio-only, for
example, which does not add to the graphics rendering load

Timeline Playback Controls

You can select All, 1-32 or R for the play/stop/cue controls etc.

You can also Stop or Play all movies set to Autoplay in the selected server or all servers. Autoplay
movies will always start playing from frame 1.

Timeline Up/Down buttons
Pressing these triggers a 1 s up or down timeline opacity fade.

Toolbars

There are three toolbars positioned by default at the top of the DeltaGUI layout. These can be
undocked separately and redocked in any order. The default positions are resumed after closing
DeltaGUI.
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File New Toggle Playback Statistics (group) display on preview

File Open Toggle Graph (group) display on preview

File Save Toggle VU Meter on preview

Configure Preferences User Information toggle (playback window)

Display Windowed (group) Toggle Freezing Video Capture (group)

Display Fullscreen (group) Toggle Reserve Timeline (group)

Launch VNC Viewer
(configure password in 
Config > Preferences > System)

Show on-screen pixel grid

Launch Delta Web Service (on Local GUI PC) using
default browser

Channel ID: toggle playback window display of server, channel
numbers and SMPTE timecode

Overall Audio Level (group) Overall Video Fade (group)

Note: Display buttons, on-screen graph and playback statistics buttons, Reserve Mode, and the
interactive sliders, affect all servers in the same group.
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TCP Connections

Select Configure > TCP Connections (Ctrl+Shift+T) from the main menu. This enables Delta to
connect as a client to other devices.

Note that this is not the same as TCP connections into Delta (as server) for external
control, as set up in Configure > Preferences > Communications (see Communication
Configuration ).

Establish permanent Telnet connections (e.g. to projectors), kept open for sending messages, along
timeline as serial events.

Once established, TCP connections can then be added to the timeline from Serial Event resources,
then selecting the connection by name, and adding target device commands in the resource editor:

107
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Setting DeltaGUI Preferences

Start DeltaServer and DeltaGUI. Choose Configure > Preferences from the menu. If the server requires
licensing, see Appendix B: Licensing the Server .

Ø System Configuration

Ø Startup and File Load Configuration

Ø Default Paths Configuration

Ø Disk Drive Configuration

Ø Timing Configuration

Ø Communication Configuration

Ø Server Information

Ø DeltaGUI User Interface

Ø Preview Window / Record Preview setup

Ø Misc Settings

Ø Interactivity

Ø Resource Defaults

Ø Configuration Defaults

Ø Extra Resource Paths

Ø Audio Type

Ø Audio Mapping

Ø Art-Net and DMX Config

Ø User Information / Stats  

457
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System Configuration

On the System Configuration page, the current server name and its Ethernet IP Address is shown:

You can configure which group this server belongs to, using the Server Group drop-down list.

The Server Type is either Leader or Follower for multi-rack configurations. For single rack systems
set this to Leader.

Avoid having two Leaders in the same group; this leads to conflicts in timing.

Note that Edit Station licences can only be a Leader and will not control Follower nodes.

Force Timing Broadcast
If off, timing information is broadcast from the Leader server only when Follower servers in that
group are detected by the Leader server – this cuts down on network traffic. With this option
on, timing information is always broadcast for this group, which can be used by other
equipment listening to this timing.

VNC password is used with the V toolbar button to automatically login to the Delta server
Default password: 7th

Enable Logging
If enabled, will write a debug log to disk (C:\Program Files\7thSense\Delta\Logs), a new log will
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be started each day if the server application is run on that day. If DeltaServer crashes, an
additional file is generated, prefixed ‘DeltaServer_MiniDump-[version]~.dmp’.

Rotate Logs / After N days
If enabled, log files older than N days will be deleted.

Enable Pico GPIO
Check if you are using the GPIO capability of a Pico media server. GPIO pin behaviours are set
by external control.
By default this is not enabled in order to maximise performance for media.

Enable Real Time Recording
Real-Time Recording  (also named Preview recording in previous versions of Delta) also
occupies bandwidth when enabled. Enable here for real-time recording only; show recording is
not affected.

Startup and File Load Configuration

On the Startup and File Configuration page, you can configure how the server behaves at start up and
on any file load.

435

https://portal.7thsense.one/user-guides/M285-delta-server-hardware-operation/index.html?hw_back_panel_connections.html#picogpio
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Play on Start
Set to Yes to immediately play the default file when the server runs. This is the default for a
standalone server. This will make the Playback Window full-screen when the server is started.

Start Delay
the number of seconds after loading that Delta will wait before loading and playing the default
show. On a Leader rack, set this to 10 seconds longer than the Follower rack delay to give the
Follower racks time to get ready.

Timeline
which timeline you would like to play on start from a multi-timeline setup.

Load Default Show File
the file to be loaded when the server starts.

Merge Permanent Show File
specifies an XML file (saved from Delta, contains resources only) which is loaded after any file
load to allow you to have a separate XML containing any resources which are common across
all files.

This can be used for example to load a Masks.XML which contains image masks common to all
show files used to mask out particular areas of the display.

Merge Permanent Display Config
specifies an XDL file (saved from Delta, contains background geometry, blending and display
config only) which is loaded after any file load to force the display config into any show. (See
Display Configuration )

Merge Permanent AutoAlignment (licenced option)
Enable this if the optional autoalignment software is installed to apply the output of that
software to the display channels. Warp, Blend and Black Level Offset can be optionally enabled.

See Autoalignment Process: Preparation  for using Scalable Display Manager™.

Play Startup Sequence
This runs a selected sequence when the server starts up, after the default show is loaded and
before starting to play.

Notes

· When permanent files are entered above, any File Load will also merge these files.

· Files are loaded in this sequence:

o Default Show file (or any show file manually opened)

o Permanent Show File is merged

133

214
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o Permanent Display Config file is merged (background resources in first 10 frames deleted
first so the warp and blends are replaced each time).

· If a Permanent Show File is loaded, then saved, it contains the contents of both files, so if then
merged again, you would create duplicates.

Default Paths Configuration

Enter default paths into this dialog:

Default Show Path
Used in File Open / File Save dialog

Default Record Path
Used for recording back out of Delta

Default Mesh Path
Used for Mesh Mode OBJ file location

Disk Drive Configuration

This dialog is used to configure where the server looks for Media. In the example below, the server
looks for Movies on drive E: and Z: and all other media (not just images and audio) on drive C:
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If you have more than one drive location where movies are held, set the other Movie Drives to point at
the other locations. If you press the Set All button, Movie drives 2 – 6 are set to the same as Movie
Drive 1.

Reset Missing Disks to C: on Startup
If the Movie drive is not found, Delta can be set to reallocate the Movie drive to C:.

RAID7th

RAID7th is a technique used by 7thSense to increase resilience against disk failure. In a RAID 0 array
if one disk fails, the array fails. With RAID7th, frames are striped sequentially across all disks in the
array, so if one disk fails only the frames on that disk are missed. In this Movie Sources tab, for
servers with this type of disk format, the drives in the array are assigned as such an array. Here 4
movie drives configured as RAID7th are enabled:

Notes

· Movies are very disk intensive, so Delta servers are configured with fast disk drives for movies.
Other content is usually stored on a separate drive to maintain the fast disk solely for movies.

· If Server and GUI are running and your resources are not found, check in this dialog where the
disks are set to look.

· When you change the disk drives, DeltaServer automatically searches the drive for media, and
presents this in the Resources Area.
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Timing Configuration

Configure the timing for the frame rate you require. A faster framerate gives smoother playback, but
depending on the file size of the movie you are loading, you may run out of horsepower in the PC, and
the framerate will not be maintained. Note also that some movies are designed for a particular
framerate – playing them faster or slower may not give the intended effect.

It is always better to choose a framerate at which the media does not drop frames (stutter), so if your
movie cannot play steadily at (for example) 60 frames per second, drop it to the next lowest
framerate (30 FPS). Alternatively, reduce the resolution of the media, or remove other parallel media
in order to reduce the load.

Optimal framerates are displayed in the listbox, which are integer divisions of the graphics card
framerate, so if set to 60 Hz, optimal rates are 60, 30, 20, 15, 7.5 etc.

You may want an optimal framerate of 50 FPS. To achieve this, set the graphics card monitor refresh
rate to 50 Hz (using the normal Windows Display configuration dialog), and restart the server. This
may require editing or adding EDID data to the graphics card.

The Timeline Length determines what length of the timeline is controlled by the scrollbar in the
Timing Area. Simply set this slightly larger than the show length or enable Automatic to auto-
calculate this length.

Time can be shown as SMPTE (e.g. Hours, minutes, seconds and frames – 00:01:20:12) or Frames
(e.g. 1200 frames). This is simply how the time is viewed on the Timing Area, and does not affect
how the show is played.
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Timing Mode

This should normally be in Automatic. Other timing Modes:

Use Hardware
Time from the internal hardware timer (graphics refresh rate).

Use Software
Time from a software timer

Windowed
Use this mode if timing is not constant when the playback window is non-fullscreen

Gfx Lock
Re-syncs the GPU to hardware frame boundaries when the timeline rate is a subdivision of the
VSync rate, used for example for 24 fps on a 60 Hz refresh rate, will re-sync every 5th frame
(since 120 is the nearest value common to both).

For Automation
Render will run at full rate independent of the timeline rate (so animations can run at 60 fps
even with timeline rate set to 30 fps) – Note that there is significantly higher GPU load.

Timing Control Network Connection

Choose Use Default (which is configured on the Communication page), or untick this option, then
select the network interface for timing packets in order to separate them from the other network
traffic.

Timing Configuration – Genlocked / LTC Chase

Ø See Synchronising Delta Media Systems for an overview of synchronisation between show
media, Delta Media Servers, display and audio devices, and other elements of show control. 

In a genlocked system, LTC chasing via suitable hardware is available. This allows an external LTC
audio track to directly control the playback.

Note that for perfect timing when chasing LTC, the LTC timecode should be synchronous with the
genlock video sync. This usually means the LTC source requires a genlock signal which is also sent
to the server. Even without a genlocked LTC source, the server will still chase LTC.

Timeline
Select this and the Enabled button to set specific timelines to chase LTC.

https://portal.7thsense.one/user-guides/M280-synchronising-delta/
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Enabled
This switch is replicated on DeltaGUI in the timing area, when enabled, timeline controls such
as stop, play, rewind are hidden, and external control of the playback position is enabled.

SMPTE Device
When available, the list of LTC input devices available is presented: select the one which will be
the LTC input Leader.

Local LTC: Select if you’re receiving LTC timecode through a standard audio input on the server. You
will select this in conjunction with running LTCReader or Soundman.

Adrielec: Select if you’re receiving LTC timecode through an Adrielec card in the server.

Delta : Select to choose a different Delta group to be the LTC Leader to this server. Note that
this server will therefore play in sync with the Leader server from the selected Delta group.

Sony422 VTR BlackMagic (COMX) : Select to receive LTC from the RS422 input of a
BlackMagic SDI card.

Sony422 VTR Bluefish : Select to receive LTC from the RS422 input of a Bluefish SDI card.

CSony422 VTR (com78) : Connect to a Sony protocol LTC device on com78.

For all options apart from Delta, there are options for Framerate : Auto, Drop or Non Drop and
Drop and Non Drop can choose 60, 30, 29.97, 25 or 24 fps rates.

SMPTE Offset
Since there is no negative time in the LTC timecode, many LTC audio tracks start at 59mins, 50
secs, which allows a 10s preroll, and the show starts at 1 hour. The LTC Offset allows you to
type in 59 min, 50s, which will be subtracted from the incoming timecode which means the
Delta content can start at 0 time on the timeline.

Incoming Rate
This is the LTC timecode rate read from the LTC Input Device.

Preroll Show Last Frame
During the preroll period, show the last frame rendered instead of black.

Preroll Frames
The number of frames to preroll before showing the content.
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Communication Configuration

Serial Ports

Up to 32 serial com ports can be configured, even if there are fewer than that installed in the machine,
allowing you to configure and save COM port details to a file for a different server.

A COM port will show up in the Baud/Parity/Data and Stop columns if it is present on that server. If a
different application to Delta has grabbed that COM port, it will be listed as Taken.

Choose the COM port parameters to match the external device, and then the device from the Serial
Devices list. This list contains those devices found in the \SerialEvents folder as well as external and
transport controls

External Control and Transport Control are saved in the PC (in the registry), all other comport
devices are held in XML files. If a file contains serial devices which conflict with existing external or
transport control com ports, the file devices are ignored.

This means External or Transport controls, once configured, are available from start-up with no
additional interaction. This allows external controllers to immediately load a show.
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Communication Timeout (set in the small DeltaServer dialog)

In some networks, the comms can be unreliable, leading to the situation where the network dies,
leaving the server still thinking it’s connected to DeltaGUI. A server application restart is required to fix
this. The same can be true of communication from external control systems over Telnet.

To fix this, enable the DeltaGUI Comms timeout or Telnet timeout in the server’s communication
dialog:

Set the timeout value in seconds, and if the Telnet is inactive (no characters received from the control
system) in 50s in the example above, the Telnet connection is dropped, allowing the control system
to reconnect.

DeltaGUI operates on a heartbeat system, so if the Server detects the heartbeat from DeltaGUI
missing for 50s (in the example above), the connection is reset, allowing DeltaGUI to reconnect if the
network has come back.

Ethernet Configuration

In this dialog, you can configure over which ports DeltaGUI talks to the server, and the external control
port for Telnet. The defaults for Delta are:

Command Port 7001

Search Port 7002
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Timing Port 7003

TCP External Control 23

UDP External Control 7780 (response from Delta on 7781)

These can be changed to any normal port if DeltaGUI is configured to have the same ports as the
server.

In systems with multiple active Ethernet ports, you can choose which one the server will use with the
drop-down box. Note that disabled Ethernet ports do not show up in this dialog, and that the IP
address shown for each port is that configured at the time; with DHCP enabled, this may change in
the future, though the server will use whatever the IP Address is at the time the server starts.

The Ethernet external control port defaults to 23 (TCP / Telnet) and 7780 (UDP), although this can be
any port that is not already used. A standard Telnet client can connect to the server, even if playing,
and be controlled through the external control protocol.
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Secure Communications

For secure communications, e.g. using PuTTY, SSH can be enabled, with a username and password.

OSC (Open Sound Control)

OSC (Open Sound Control) is a network messaging protocol originally designed for musical
performances or show control. Its non-standardised messages make it a dynamic, configurable and
low-latency interface for Delta External Control commands. Using a cross-platform control
applications such as Touch OSC or Medialon Manager allows Delta controls and Delta Sequences to
be run alongside other applications for show control.

Ø OSC was introduced with Delta 2.8, see Appendix K: OSC and External Controls . 

Enable OSC Rx
Check to enable receiving OSC messages. There is no acknowledgement response in OSC.

OSC Port
Use the default, or any free available alternative.

Blocked Groups

If the dialog is cleared, this instance of DeltaGUI will accept connections from all servers found on the
network. In some cases, you may want 2 or more instances of DeltaGUI to controlling different groups
of servers.

You can also choose between showing the standard 20 or the maximum 64 groups in the server drop-
down here.

489
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Server Information

The server information tab shows hardware configuration information gathered from the current
server.

DeltaGUI User Interface

This dialog allows you to tune DeltaGUI preferences.
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Graphics

GUI Update Frequency
In updates per second, the frequency with which the layers are redrawn. For a low performance
machine, you may need to lower this to 10 updates /second, for higher performance machines,
20 or 30 is preferable.

Snap
This enables and configures the layer snap grid. When showing Frames, the snap is set to 30
frames in the example above, when viewing SMPTE, the snap is set to 1 second in the example
above. You can also snap to the end or start point of other resources on the same layer by
turning on Snap > Grid and Resources. Note you can also access the snap menu from the status
bar at the bottom of DeltaGUI.

Layer Sizes
Choose from small, medium or large layer heights in the Timeline

These items are remembered locally on the DeltaGUI PC.
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Colours

These are the default colours for layer items when selected, disabled or when they have errors.
These can be tuned to your preferences; they are stored in the registry.
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Features

This dialog page allows the user interface to be customised:

Resource Window Columns
In the resource window (left side of DeltaGUI), you can have optional columns showing the
drive letter, extra information such as image size or audio format or which timeline a resource is
on for timeline resources.

Active timeline Indicators
The timeline play and autoplay indicators in the bottom status bar default to being simply LED
indicators – if you enable this checkbox, those LEDs become toggle switches to play/stop each
timeline or autoplay state.

AutoSave
Saves this server's current file at the specified interval (if not playing a show).

GUI password
Type in a password which will be requested any time DeltaGUI is started. Note that this
password is stored in plain text in the registry.

Intelligent resources
If enabled, a set of behaviours is added which help minimise time to create a show: These are
only used when you add a new resource to the timeline, they do not affect existing resources
on the timeline.
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Media Media Format (Mono Audio Files) Display Mode Automatic Parameter

Image or Movie Square and 1500 x1500 or larger

or Square and has ‘fisheye’ in filename

Dome (Frustum) Fisheye mapping

Image or Movie Aspect ratio > 2.5 and width >=1500

or Aspect ratio > 2.5 and has ‘panoramic’ in
filename

Dome (Frustum) Panoramic

Back Surface Projection If the projectors are on the outside of the dome and
the software is set to draw on the back surface, in
Dome mode, visual resources will be placed on
Mirrored horizontally

Dome (Frustum) Mirror

Image or Movie Filename has _L or _left on the end

Filename has _R or _right on the end

Stereo Left eye

Right eye

Audio Mono audio and filename is or ends in:

L or left or 1 or ch1

R or Right or 2 or ch2

C or Centre or Center or 3 or ch3

Ls or leftsurround or 4 or ch4

Rs or rightsurround or 5 or ch5

LFE or Sub or 6 or ch6

Lside or rearleft or rl or leftback or 7 or ch7

Rside or rearright or rr or rightback or8 or ch8

9 or ch9

10 or ch10

11 or ch11

12 or ch12

13 or ch13

14 or ch14

15 or ch15

16 or ch16

Any Speaker:

Left

Right

Centre

Left Surround

Right Surround

Sub

Left Side

Right Side

Output 9

Output 10

Output 11

Output 12

Output 13

Output 14

Output 15

Output 16

Fade Choose up or down to be opposite from previous up
or down fade / transparency

Any Direction

Warnings

File Modified
If the file has changed by editing the timeline, and you attempt to load a file or do File New, a
warning dialog will pop up.
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Preview Window / Record Preview setup

This dialog allows you to set the resolution of a hardware preview card (if fitted) or preview recording
output format. Note that larger resolutions create a larger load on the server and DeltaGUI.

Delta 2.8 offers video Preview via 3 routes: Delta WebRTC, NDI® and ST 2110.

Server (Hardware) Preview Format
If preview output hardware is fitted to the server (can be HDMI, SDI etc.), this drop-down allows
configuration of the available output video format.

GUI (Network and Recording) Preview Format
Select one of the standard output formats or Custom, and type in the custom Width × Height in
pixels. This format will be used when Real-time (Preview) Recording is activated either from the
Recording dialog  or external control. This also affects the fit of show preview in the web
Preview browser page.

Note: Real-time (Preview) Recording is controlled from external control or a sequence using the
REAL-TIME_RECORD, REAL-TIME_RECORDSETTINGS, REFRESHMOVIE and DELETE_DISKMEDIA
commands.

430
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WebRTC Preview

Enable WebRTC Preview
The streaming preview to web browsers can be enabled here, and the Peer Name and Port set
– this requires a Delta Web Service / Signalling Server to be running.

Ø Viewing and Previewing Shows  

NDI® Preview

Enable NDI Preview
Delta 2.8 supports NDI 5.5. Check this box to create a Network Device Interface (NDI) 4:2:2
preview stream generated by Delta.

Stream resolution is selectable from standard sizes, or a custom size may be added. This will
be shown in an NDI Monitor title bar, along with the stream name, e.g.: ‘NDI - DELTA3456
(Preview) (1080/30p)’.

Playback stats will similarly show this information, together with that of the NDI Output
Configuration .

ST 2110 Preview

Enable ST 2110 Preview
Check this is you are using ST 2110. Initially only 1920 × 1080 10-bit 4:2:2 is supported.

425

140



119

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Misc Settings

This dialog allows configuration of some miscellaneous features:

Maintain Video Capture rate when paused
If cleared, any video capture windows shown on the timeline when not playing will drop to 1
frame per second to free up CPU.

To keep the video capture at full rate when not playing, tick this box.

Reserve Timeline Fade Time
Sets the time in seconds to fade from Reserve to normal operation.

Autoplay Movies
Start from frame 0: When enabled, whenever the playhead moves into a movie set to autoplay,
it will always restart the movie at frame 0. When this is not selected, the movie will restart from
the previous frame it stopped on.

Sync Mesh Files to GUI PC
When enabled, on any load, save or startup of DeltaGUI or DeltaServer, DeltaGUI will check if
the mesh files locally on the DeltaGUI PC match the server’s list and upload missing or modified
meshes to DeltaGUI.

Enable NatNet Streaming
Used for Optical Trackinig Mesh Mode  Mesh Mode with OptiTrack Motive systems.277
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Missing Frames
Choose to repeat the previous frame if a frame is missing, or choose the colour (default black)
for a blank frame.

Interactivity

This dialog allows the global configuration of direct interactivity with the Delta playback window.
When enabled and the resources are also configured to be Selectable or Movable, a user can directly
move or trigger sequences by clicking on the resource on the playback window, or with Windows 7 or
10 Gestures enabled (see below), drag resources around the playback window.

This is used in for example museum kiosks where the only user interface is the output of the server
itself – the playback window can have image or movie resources which act as buttons which alter the
show, such as play/stop or select different media.

Enabled
Enable or disable interaction on the playback window.

Input Mode
None, Mouse or Gestures

Disable Resource Movement
Select this so that even if resources are set to Movable, do not allow any movement of
resources.
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Auto Change Z Order
If enabled, when you click on a resource, it will be placed at the top of the Z Order so you can
see it.

Enable Selection
If enabled, trigger on a click or tap – this triggers the OnSystem_ResourceSelect system
sequence, sending in the resourcename, external control name and X and Y location of the
click. You can then write a sequence to do anything in the server.

Highlight Selected Resource
Draw a moving marquee around the selected resource

Maintain highlight
Keep the moving marquee on the previous resource.

Note: this is configured on each resource independently, so you have to enable Selection or
Movement on the resource for it to move or trigger the OnSystem_ResourceSelect sequence.

Resource Defaults

This dialog allows configuration of the defaults applied to a resource when you add a new one to the
timeline:
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In Flat plane or Stereo, the left-hand column defines the position and size of the new resource, in
Dome mode, the right hand column defines the position, size and mapping mode of the new
resource.

If Force W & H is checked, the width and height of the new resource is forced to the values in the W
and H edit boxes. If not checked, the width and height are left as the resource defaults from the
image or movie.

You can turn off these defaults by un-checking the Use Defaults checkbox.

You can also copy these defaults to the group by clicking Copy To Group.

Audio – Guess Mapping Preset
If enabled, the speaker mapping logic will attempt to guess the Audio Mapping if any which
matches the resource name. You can edit those mappings in the Audio mapping section below.

Configuration Defaults

This dialog allows the server to be set in Show Mode (or partially in Show Mode) where certain
parameters from a show XML are ignored.
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This allows, for example, a server to always override the XML settings for grid, beams, geometry to
ensure that these are always turned to the most suitable setting for a show, so that the audience
never sees the grid and the beams are always forced on.

Pressing the Apply Show Mode defaults turns on all of the options, Standard Defaults turns them off.

In addition, if the Automatic Framerate is not checked, you can force the default framerate when File
New is chosen instead of having the server guess the framerate from the refresh rate.

Load SMPTE from File – the state of SMPTE slaving when the file is saved is ignored unless this box
is checked.

Global Audio Offset (frames)
offset all audio files on the timeline by this amount of frames (positive or negative) in order to
easily fix lipsync problems if all audio is mismatched by the same amount. This could also be
achieved by moving each audio file on the timeline.

Global Stream Video Offset (frames)
offset all streaming video by this number of frames.

Global Stream Buffer Size (frames)
increase the streaming video buffer size.

Use Dynamic Image Loading
With this option off, Delta will load all still image files into RAM when a show is loaded for
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instant access when scrubbing on the timeline or during playback. If the total amount of RAM
used by the show exceeds physical RAM in the server, this option will fail to load all images.

With this option on, all images are not loaded into RAM, but streamed as they come into scope
on the timeline, so that they appear on the correct frame as normal. When scrubbing around on
the timeline (not playback), there may be a short delay before they appear due to this option.

Fix Odd Movie Size Playback
For legacy graphics drivers, tick this to improve performance when the movie width is not
evenly divisible by 4. Odd sizes may not run or run badly. Bad dimensions will generate an alert
in the Resource Pool. See Media Management for Delta Servers.

Extra Resource Paths

The standard resource paths (e.g. E:\Movies for movies, C:\Images for images) can be extended to
your own paths, so that you could add a path for each resource type, for example in these path trees:

C:\MyProjects\Projects2009 \Movies
\Images
\Audio

C:\MyProjects\Projects2010 \Movies
\Images
\Audio

https://portal.7thsense.one/user-guides/MC256-managing-media/mm_basic_requirements_for_media_s.html
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Note that movies are usually held on a different, faster disk.

You can cycle between the standard paths and extra resource paths by pressing this button:

After clicking on one of the paths in the resource folder area, you see only those resources in the main
resource window below.

Audio Type

You can choose to use a Windows (DirectShow) based audio device or ASIO device in this page. If
there are any ASIO devices present, you can select ASIO and then the particular ASIO device if there
are multiple present.

You can also choose to autodetect the number of audio channels or force the number (some audio
devices need this, as they do not report the correct number of channels).

Forcing channels

· If you force a number of channels that the device does not support, it will fail, so the number
reported in the Stats will be 0 and there will be no audio.

· If you have a device that supports more channels than you are only using, do not force the lower
number. There is no need, and some devices will not function properly as a result.

Note: After changing any settings in this page, you will need to restart the server application.
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Maximum Parallel Audio Voices
Default of 32, this sets the maximum number of simultaneous audio tracks which will be heard.
Note that audio resources which are butted together on the timeline will both count for a period
of time, so if you have 8 tracks followed by 8 immediately, this counts as 16 for the period near
both sets of tracks.

LTC Output Enabled
With this option enabled, a channel from the default audio device (see Use Default Audio
Playback Device) is reserved for LTC output, making it unavailable for normal audio playback.
You can now edit an audio track’s properties and choose LTC Track on the Audio Levels page
so that this audio track is sent out via the previously-configured LTC audio output only.

Select LTC Output Channel
Choose which of the available audio channels is selected as the LTC output channel as
described above, making it unavailable to normal audio output.

If Use Default Audio Playback Device is deselected, you can select another audio device (if
present in the system) to output LTC audio using the dropdowns at the bottom of the page.
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Example audio resource editor showing it set as an LTC track

Audio Mapping

Audio mappings are a way of pre-configuring a quantity of audio channels, which output audio
channels and channel volumes so that instead of having to edit each audio resource, you configure
the mapping once, and apply it to the resource.
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In the above example, ‘Top Middle Low’ is a user-created audio mapping which has been created with
3 channels, numbered 1, 2 and 3 with pre-set volume levels. In the audio resource editor shown below
for an audio file, you can choose to have Not Used for audio mapping (to edit the channels and
volumes as normal), or select the ‘Top Middle Low’ audio mapping from the audio mapping
dropdown.
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Note that some audio mappings (named CH1 – CHX) are built in and cannot be deleted, but you
can add your own audio mappings as well with specific channel counts.

AudioMapper

Custom audio mapping files can be generated in JSON format using the AudioMapper utility, installed
with Delta 2.6.69 and later. For users of Delta 2.5.33, custom audio mapping has been available. If
you want the utility, contact support@7thsense.one. For users of Delta 2.8.7, the introduction of
channel offsetting renders the AudioMapper unnecessary.

Ø AudioMapper User Guide 

Art-Net and DMX Config

Delta has the ability to send out an Art-Net stream from the timeline and listen to Art-Net in order to
activate any command from the external control command set. Art-Net can be converted to DMX
using inexpensive Ethernet (RJ45 – Art-Net) to DMX (5 pin DIN) devices.

The configuration page sets up the output parameters for Art-Net and whether this is enabled for
input and output separately:

mailto:support@7thsense.one
https://portal.7thsense.one/user-guides/M545-audiomapper/
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Output

Output Art-Net Data Enable
Select this to enable the continuous Art-Net data stream output

Art-Net NIC
Choose which network adapter to broadcast Art-Net data from

Broadcast Address
Choose 255.255.255.255 for the whole network or a more limited address as required.

Art-Net Universe
Value 0 – 15, these behave as separate sets of data on the network

Art-Net SubNet
Value 0 – 15, these behave as separate sets of data on the network

Max Channels (Output)
Art-Net has 512 maximum channels, but you can select to output only a subset of this if
required. Note that some DMX devices do not work properly unless they receive all 512
channels.

Broadcast Port
Select which port on which you wish to send Art-Net data. Default is 6454.

Input

Input Art-Net Data Enabled
Select this to enable Art-Net listeners (see Art-Net resource section).

Art-Net NIC
Specify the NIC to receive the Art-Net data.*

Receive Port
Select which port on which you wish to receive Art-Net data. Default is 6455.

Enable TestMode
Selecting this increments all output channels continuously in a ramp for testing.

Note that only one server should be set to broadcast out to a specific Universe / SubNet, as
multiple servers broadcasting on the same settings will conflict.

* You cannot send Art-Net back into the same server that DeltaServer is running on if you have
input and output NICs set to the same interface. DeltaServer will assume exclusive control over
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the input Art-Net port for the NIC chosen. The input signal will therefore not reach any other
application on the same machine listening to the same port on the same NIC. 

User Information / Stats

By pressing ‘i’ on the playback window, or using the ‘i’ button on the DeltaGUI toolbar, you can toggle
User Stats on or off which provides real-time information on the playback window, which can be
selected in this config page.

Timelines
All active timelines are shown with the timecode, whether t

he timeline is playing or cued

Movies
All in-scope and enabled movies are shown with the time from the start of the movie, time
remaining in the movie, percentage complete, timeline and name.

Last External Control Message
The last message and when it was sent are shown here.
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Sequence Variables
All sequence variables which have Watch enabled are shown with their values – configure
Watched status in the View > Sequence Editor > Global Variables page.

Example playback window shown:

For interpretation of graphs and stats, see:

Ø Playback Window  37
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Display Configuration Features

Definitions for Visual Media

Dimensions are described in pixels (flat plane screens) or degrees (spherical or ellipsoid domes).

Canvas
The total surface that displays the projected show. This may be a matrix of LED screens, a
projected flat screen, a spherical surface (dome), or a complex 3D surface for which media is
specifically mapped to a mesh.

Channel
One, or many, projection devices each of which throws all or part of a show onto the canvas.

Show
A compilation of one of many media resources, including applied warps, blends, effects,
transitions and display control sequences, arranged on one or more timelines.

Media resource
A projected media item, which can be dedicated to, or divided between channels. It can be
positioned, resized or reproportioned, forced to fill a channel, or occupy a small portion of a
channel. It may be designed for the canvas, channel mapped, or be a live capture, for example.
Compiled on layers in a show timeline, they have individual properties.

Display Modes

Delta display modes are licensed options. There are three display modes available, for different kinds
of canvas or display surface. In each, the surface is divided into projection channels, according to
screen size and media requirements.

Flat or curved plane

This mode defines only width and height for a single rectangular canvas, and applies
warping and blending to fit each channel perfectly together. See: Display
Configuration: Flat Plane Mode .169
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Dome or frustum

Advanced geometry automatically takes care of spherical or ellipsoid surfaces in this
mode, distributing media between channels, applying blending, and using
autoalignment options. See: Display Configuration: Dome Mode .

Mesh

Mesh mode (projection mapping) is for projection onto irregular objects or surfaces,
requiring a 3D model or ‘mesh’ to provide calibration points for the media. For viewing
from a single, or specific eye-points, flatplane media is mapped onto the model. See:
Display Configuration: Mesh Mode .

Configuration features

Warp
Changing the shape of individual channels to match the screen surface

Blends
Blending overlapping areas between channels for seamless projection.

Colour
Adjusting colour between adjacent channels.

Splines
Geometric paths along which visual media move, to a set timing pattern, when in scope.

Display
Setting up channels for different projection modes: flatscreen, composition, dome, or mesh.

Output Setup

Output setup allows configuration of channel locations in the playback window,
overall gamma, and which physical outputs are active. Note that the setup here
should match that set in any graphics card setup on the server.

201

229

150

158

161

163
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Press the Output Setup button to show the output mode dialog:

Depending on the output mode selected, further options will be displayed.

Output Channel Modes

If Normal, channels are arranged in a horizontal line on the desktop.

If Composition Mode, output channels are directly editable in XYWH on the output framebuffer.

If Matrix Mode, channels can be arranged in a X by Y grid on the playback window.
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Output Colour Space

RGB is the normal colour space, but some projectors, typically in Digital Cinema, take an XYZ colour
space. The dropdown list contains various RGB-XYZ mappings:

· DCI and CIE are fixed, internal mappings.

· Same is a 1:1 RGB-XYZ (no change) mapping for testing.

· DCI_File is stored in System / ColourSpaceConvert.xml file and can be changed.

Render Modes

This choice relates to the way colour data is packed and how particular projectors interpret that data.
It does not enable bit-depth colour and does not apply to SDI output mode. In most cases this should
be left at 8-bit.

High bit-depth colour is an optional licence. For working with 10-bit colour depth, please see this
section in our Display Configuration guide.

Current high bit depth capabilities for Delta are:

Connector type High bit depth

SDI Up to 12-bit

HDMI 1.4 Up to 10-bit

HDMI 2.0 Up to 12-bit

DisplayPort Up to 12-bit

Rivermax™ ST 2110 Any

Note: Wobulation techniques for JVC are also natively supported.

Norxe Wobulator Projectors

When using a Norxe Wobulation projector, the user may want to duplicate the output from Delta, but
shift this duplicate by 0.5 pixels in height and width.

From Delta 2.7, a Pixel shift render mode was added in Display > Output Setup.

This shift of half a pixel can also have an interleave value set meaning that the first output from Delta
is providing all the ‘even’ vertical pixels and the second (duplicate) is providing all the ‘odd’ pixels.
These feeds both go into the projector and are overlaid on top of each other to create the image. You

http://portal.7thsense.one/user-guides/MC264-display-configuration/gdc_working_in_10-bit_colour_depth.html
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can then enable wobulation on the projector, which takes advantage of the half-pixel shift in the x/y
axis. The pixel shift values can also be minus values if the wobulation is in a negative axis. This will
require adjustment to some registry settings.

Default Pixel shift properties in the Windows registry can be found in
\HKEY_LOCAL_MACHINE\SOFTWARE\7thSense\Delta\Graphics:

Key Default Function

PixelShiftHorizontal 0.5 If pixel shift is being used, sets the shifting amount of pixels horizontally

PixelShiftHorizontalInterleaveOn 1 If pixel shift is being used, sets the flag to interleave pixels horizontally

PixelShiftVertical 0.5 If pixel shift is being used, sets the shifting amount of pixels vertically

PixelShiftVerticalInterleaveOn 0 If pixel shift is being used, sets the flag to interleave pixels vertically
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Registry Edits

7thSense software uses the Windows Registry extensively, and on occasion we make
recommendations for changes.

· Before making any changes, close DeltaGUI and DeltaServer.

· DeltaServer can take up to 10 seconds to fully close in the background, even if it appears that
all the Windows have closed. Ensure that Delta has fully closed before opening and/or
refreshing, and finally editing. The best way to ensure this, is to watch Windows Task Manager
> Details list. You will see ‘DeltaServer.exe’ in this list if DeltaServer is still running. If it won’t
close for any reason, you can right click on it in the list and choose ‘End Process Tree’.

· Make a note of any setting before you change it, in case you want to change it back.

· Only make the changes as recommended and only to those registry keys.

Projector / Screen Location (Dome Mode required)

For Dome (Frustum) and Mesh Modes, the standard configuration is to have projectors inside a dome
screen.

For those systems where the projectors are projecting onto the outside of the dome screen, choose
the ‘Projectors are Outside the Screen’ option. You must then place the channels (virtual projectors)
outside and pointing at the screen. Intelligent resources in this mode will also automatically
horizontally mirror visual resources so that text still reads correctly.

IntelligentSource™

Check ‘Output Enable’ if you are require a pixel row of frame data in your output. Select the format for
the IntelligentSource data row to match that of the receiving decoder. By default Delta will sacrifice
pixels of the first row of each frame. Alternatively you can choose to append a row at the top of each
frame to contain the IS data and employ an EDID adjusted for this.

Ø See also IntelligentSource™  

Ø Composition Mode and IntelligentSource

Display Gamma

This slider controls the overall display gamma on the server PC – this value is saved in the file.

Canvas Colour

This is the background colour which shows when there are no visual resources on the timeline.

337

199
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Output Mode (Optional Licences)

Select from DisplayPort (default), SDI, VR, NDI or ST 2110 modes to match the server configuration

· DisplayPort mode outputs on the server’s graphics card.

· SDI mode outputs on SDI output cards (BlueFish, Matrox, if present).

· VR Headset (unavailable in Flatplane Mode) outputs on HDMI to the VR headset, with optional
DisplayPort preview (extra load) of the VR view. This requires mesh mode and stereo licences.

· Output on NDI: an NDI stream via a NIC; DisplayPort preview is still available. (see Preview
Window / Record Preview setup  and NDI Output Configuration ).

· ST 2110 enabled by licence for servers with Mellanox Rivermax™ network adapters.

Note: The optional DisplayPort preview adds extra load to the canvas for modes other than
DisplayPort.

Ø See Appendix C  for more SDI details. 

Server Group Mode (Optional Licence)

This mode is for when multiple servers drive a single 4K projector (if required) and allows the user to
designate which half or quadrant this server is responsible for – when adjusting warp and blending,
the same information is used in all servers to maintain coherent geometry across all servers. Since a
single Delta server can drive multiple 4K projectors, this option is for high-end testing only.

Scaling Mode

From Delta 2.7, this additional control allows for choice of scaling mode, bilinear, Lanczos or bicubic.
Scaling mode is accessible via external control.

117 140

459
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NDI Output Configuration

For NDI output to operate correctly, the licence option of SDI2K is required.

NDI can be a better choice than SDI for many reasons, it does not require dedicated output cards, and
has a far greater capacity. Using NDI 5.5, Delta 2.8 adds configurability that was previously
unavailable. The NDI devices listed in the output setup are derived from a supplied list of .xml files.

In the Output setup menu the Output Mode should be set to NDI, then the Output preset selected to
match the Output Channel size(s).
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Check Enable ‘DisplayPort Preview’ if you want to review the NDI feed in the preview window.

· Delta 2.8 is installed with default supported formats and resolutions from which to select.

· 8-bit RGB and RGBA, plus the proprietary NDI UYVY and UYVA formats are supported.

If you need specific other resolutions, please contact support@7thsense.one.

· Up to 32 synchronised HD feeds are available.

Note that NDI provides the output stream on a separate NIC to the front panel of R-Series media
servers.

For technical users only

Delta 2.8 installs with an NDI configuration file (C:\ProgramData\NDI\ndi-config.v1.json), which can
be edited using NDI tools such as NDI Access Manager. In this way, Send/receive groups, discovery
servers and preferred NICs can be assigned.

If the necessary preset is not available to you these can be created by editing the NDI.xml in C:
\Program Files\7thSense\Delta\System.

<?xml version="1.0" encoding="ISO-8859-1"?>
<NDI_FORMATS>
<DATE>25.03.2022  09:00:0</DATE>
<DeviceName>NDI</DeviceName>
<Count>8</Count>

<FMT1>
<Name>1920x1080 8Bit rgb</Name>
<Pixels>1920</Pixels>
<Lines>1080</Lines>
<FrameMode>p</FrameMode>
<BitDepth>8</BitDepth>
<ColourSpace>rgbx</ColourSpace>
<EmbeddedAudio>y</EmbeddedAudio>
</FMT1>
<FMT2>
<Name>1920x1080 8Bit rgba</Name>
<Pixels>1920</Pixels>
<Lines>1080</Lines>
<FrameMode>p</FrameMode>
<BitDepth>8</BitDepth>

mailto:support@7thsense.one
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<ColourSpace>rgba</ColourSpace>
<EmbeddedAudio>y</EmbeddedAudio>
</FMT2>
<FMT3> …
…
</FMT8>
</NDI_FORMATS>

To add a new preset, first increase the Count at the top of the list accordingly, then copy and paste a
new present, ensuring you preserve the formatting and update the numbers.

It is not necessary to define framerate here, as this is dictated by the timeline framerate. Check that
timeline rate has not reverted to 30 on applying the preset. If necessary, manually override this by
reselecting the desired rate.

The colour space options available for NDI presets are:

rgbx = RGB
rgba = RGB + alpha
uyvy = 4:2:2
uyva = 4:2:2 + alpha

Test Patterns

In addition to the Pixel Grid (main toolbar button) or warping grids, test patterns are
available to make alignment and adjustment easier when configuring any display
mode.

Test Pattern Type Description

Timeline Resource display Shows the resource(s) that are applied to the timeline at the set time
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Test Pattern Type Description

Chequerboard 3D test pattern A set of 15 degree black and white boxes in a sphere

Resolution 2D test pattern This is a vertical or horizontal grill of one pixel off / one
pixel on which fills the screen

Black Field Full black output

White Field Peak white output

Auto Align — —

Uniformity 50% drive level field

Spherical Dots 3D test pattern A spherical grid of dots, in which the size of the box and
dot size is configurable

Crosshatch 3D test pattern A spherical grid of lines, in which the size of the box and
dot size is configurable

Greyscale 3D test pattern A spherical set of grey bars. You can choose the orientation

from 4 settings

Genlock Black / White pattern When playing, alternately flashes white / black to allow
genlock checking across channels

Photo-epilepsy Warning

This test pattern displays rapidly flashing black and
white screens (frequency: 10% of the frame rate), and
may cause seizures in the very small minority of people
who are susceptible to photo-epilepsy. Do not display
in an auditorium without issuing this warning.

Colour Bars 2D test pattern SMPTE standard colours

3D: Passive Stereo Mode

As an option, Delta can enable Stereo mode, which can be Passive or Active.

In Passive mode, Delta’s layers are treated as stereo depth which, when viewed on a passive or
active stereo display system, create the illusion of distance which can bring another dimension to
presentations.
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Layer 1 is treated as the nearest layer; the Background layer is farthest away. All layers between 1
and background are scaled in distance according to the layer number. Using this system, you can
have layered objects float in front or behind other media according to the show requirements.

Configuration

In passive stereo, the canvas is divided into pairs of channels, one each for left and right eyes. The
number of channels will therefore be forced into an even number. The number of pairs is set using
the 3D Outputs dropdown (2 × 3D outputs = 4 channels active). Each channel is output through a
separate video output to a projector, exactly overlaid on the screen, each projector having a different
polarisation. Using inexpensive passive stereo glasses, each eye receives only the polarised image
for the relevant eye, and in this way, each eye sees a slightly different view, creating the stereo depth.

Requirements

· Pairs of projectors overlaid, each one polarised with a non-depolarising screen

· Pairs of channels output from Delta

· Inexpensive polarised or Infitec glasses
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Blue Line mode
places a quarter-channel width blue line on the last line of video for the left eye and three-
quarters-width line for the right channel. Some projectors support this mode instead of a
separate sync signal from the PC.

Link Eyes
links the geometry, colour and blending from channel 1 onto channel 2, channel 3 to 4 and so
on. In this way, if the two projected images are already aligned, only add warp and blend to odd
numbered channels and adjust as normal – even numbered channel warp will be identical to its
odd numbered partner.

Anaglyph mode
creates a realtime anaglyph (red/blue stereo) from non-anaglyph content. Suitable red/blue
glasses are required.

Show All
for anaglyph shows the composite Red/Blue channel in addition to the 2 channels which create
this mode. This is useful to have anaglyph and passive stereo of the same source.

Interleave mode
interleaves the left and right eye images in a 1 pixel chequerboard pattern, suitable for certain
3D LED walls.

You must press [Apply] for passive stereo to be enabled.

Force Channels
if this is checked, pairs of channels are made active and the second channel is copied over the
first so they are overlapped. If the checkbox is not checked, your existing channels are left
untouched, so you can configure passive stereo as required.

Stereo Wizard

Ø The Wizard can help you create simple passive 3D shows. See: 3D Stereo Show Wizard  

3D: Active Stereo Mode

In this mode, pairs of Delta channels are interleaved in time, and a single output is sent to a single
projector. Since we want to maintain sufficient update rate for each eye, this single output from Delta
has to run twice as fast as the passive stereo solution, as does the projector. Shutter glasses, synced
to the stereo output of Delta, are synchronised to only show each eye the relevant image, creating the
stereo depth.

148
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The Eye Separation (IOD) is set here to use Delta’s layers as additional planar shift to create artificial
depth. This defaults to 0, which means not using layers to create depth, relying on the depth within
the content.

Configuration

Choose 1 to 8 × 3D Outputs and press apply – pairs of channels are made active, and the second
channel is copied over the first so they are superimposed. If the checkbox is not checked, your
existing channels are left untouched, so you can configure passive stereo as required. Note that odd
channels (1,3,5,7) are always left eye and even channels (2,4,6,8) are always right eye. You can
configure content to be on left or right eye by editing the resource and change the Eye parameter.

Blue Line mode
places a quarter-channel width blue line on the last line of video for the left eye and three-
quarters-width line for the right channel. Some active stereo projectors support this mode in
addition to the traditional stereo sync input.

Link Eyes
links the geometry, colour and blending from channel 1 onto channel 2, channel 3 onto channel
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4 and so on. In this way, both channels fed to a single active stereo projector are adjusted at the
same time if the control is placed on an odd-numbered channel.

Note: You must press [Apply] in order for stereo to be enabled.

Force Channels
if this is checked, pairs of channels are made active and the second channel is copied over the
first so they are overlapped. If the checkbox is not checked, your existing channels are left
untouched, so you can configure passive stereo as required.

To use Delta’s layers as additional depth, for both Passive and Active Stereo, simply enter the screen
and Eye-point locations and size, and choose the Eye Separation to match your system – these
values affect only the additional stereo separation activated per layer (layer 1 has most separation,
background layer has 0 separation).

A typical Eye Separation is 65 mm, though this value can be experimented with to achieve the right
amount of stereo. Beware of using too much separation, as this can make objects appear behind the
observer’s head, causing discomfort.

The Canvas and Screen location can be entered so that one PC can play the left half of a stereo
screen, another the right half – enter appropriate Channel values to cover the left and right half of the
canvas in this case.

Typical Requirements

· One projector per output, fast enough for the higher video rate

· One channel output per projector from Delta using stereo-capable graphics card (requires optional
stereo licence)

· Shutter glasses or Z Screen

Pre-Rendered Anaglyph Stereo Content

If an anaglyph movie has been rendered into left eye / right eye already, the Eye separation should be
set to 0.

Alternatively, place this on the background layer, which has no additional eye-offset applied by Delta.

Left Eye or Right Eye Separate Movies

After placing left and right eye movies on the timeline, you can edit each resource to move it to the
left eye or right only (pre-rendered for that eye).
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Left/Right or Top/Bottom Configuration

Some movies come with both eyes as left/right side by side, or top/bottom, this can be selected in
the resource dialog.

Stereo Wizard

Ø The Wizard can help you create simple active 3D shows. See: 3D Stereo Show Wizard  

3D Stereo Show Wizard

Choose DeltaGUI menu Wizards > Create Stereo Show.

On the first page, select the Left and Right eye movies:

On the second page, choose which audio files to include and the FPS of the audio files:

148



149

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

When adding, select speaker destinations for each track:

On the last page, choose mode – Active or Passive – whether to add a loop, and if there is any time
offset between audio files and movies:
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Click [Create], and the timeline is populated, ready to play.

Display Configuration: Warp

Geometry on the background is typically used to align the Delta image onto the display system,
perhaps to correct slight errors in the display, or to make the image geometry correct for a curved
screen display system. Geometry / warp resources on non-background layers affect resources on
that layer across the whole canvas, not per channel.

Background geometry can also have ‘Fixed’ enabled (in Properties) – this will auto-reset the start
frame of this geometry to frame 0. If Fixed is disabled, you can set the start frame as normal.

There are four warp modes available:

Ø Timeline

Ø Colour Convergence
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Ø Surface Warp

Ø Point Distortion Warp

Timeline

Timeline warp uses common projector terms such as H-Size, Left-
Keystone or Top-Right Bow. This method is most precise and usually
follows the technique of start in the centre with whole size picture
controls, working out to the corners using half-size picture controls,

then corner controls. In this way, the alignment is achieved with the minimum of interaction between
areas. Note you can drag the slider, or click the arrow buttons either side for fine control.

To use this method, you need to place a warp resource on the background layer for each active
channel you want to warp. (In FlatPlane mode, the Defaults Wizard will create these for you.)

You can also save this resource to the resource pool for use in other shows, using the ‘Copy to
Resource Pool’ button in the resource pool area.

Global controls treat the whole canvas

Half-controls warp only half of the canvas, from a mid-line

Cubic bows treat corners by warping one quarter of the canvas

Quadratic corners warp one quarter of the canvas with a slightly more acute reach into the corner.
The alternative when making finer adjustments is point distortion.

Each warp is described above the slider control that controls its extent. Numeric values can also be
typed in:
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Colour Convergence

Some projectors require red and blue to be warped onto the green image, by setting the background
warp resource to Converge Red or Converge Blue, you can have this warp resource alter red or blue
only. Placing a second warp on this channel in normal Warp Mode allows all 3 colours to be warped at
the same time while preserving the red and blue offsets.

Surface Warp

Surface warp is an additional geometric distortion which is built into a
geometry resource.

· Both surface and point distortion modes can be used at the same time.

· A surface-warped geometric resource can be placed on any layer, and affects the media in that
layer.

· On the background layer, surface warp becomes Channel-based. (Point Distortion is still available
on each channel and can be used together with any resource-based mode.)
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Surface mode is useful for quickly pulling the shape around with a mouse – you can choose the
number of nodes, from only 4 in total, up to a 13 ´ 13 grid of points by pressing the H+, H-, V+ and V-
buttons followed by the Apply button (or Enter). Note that the new grid density will follow
approximately the shape of the original node count.

Warp Controls

Zoom in/out of grid blue buttons, or 
Ctrl+mouse wheel

Reposition the grid in DeltaGUI blue arrow buttons, or 
left mouse button to drag, or 
Shift+arrow keys

Select a node or nodes arrow keys (first to be selected is bottom left), or 
left mouse click; 
add additional nodes with Ctrl+left mouse button
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Move a node or nodes Ctrl+arrow keys (fine control), or
Ctrl+left mouse button to drag

Add or Remove a grid line (row or column) H+, H-, V+, V- buttons

Add a custom grid line (row or column) ‘Custom’ button menu > Add Custom Line / Column

Move a grid line (row or column) ‘Custom’ button menu > Edit :Line / Column
Reference

Remove a grid line (row or column) ‘Custom’ button menu > Remove Custom Line /
Column

Under the Surface button, you can reset a selected point or points, or the whole grid, and also change
from Linear Interpolation (straight lines between nodes), or Spline Interpolation (smooth curves). You
can also change the dot size onscreen and reset points or the grid.

To find the active dot’s location, even if off screen, press the Find button – this highlights the X and Y
lines leading to the selected node on the actual canvas. This will disappear automatically after 10s.

Point Distortion Warp

Point distortion is an additional channel-based geometric distortion
which is typically used in curved screen displays to finely tune
geometry.

· Add a flat geometry resource to the timeline, and set its properties to background layer and to the
required distortion channel.

· Each channel has an independent distortion map and these are stored in the XML file.
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On the Warp page, select Distortion from the Timeline / Distortion tab control. DeltaGUI now shows a
21 × 21 or 11 × 11 grid of points (configurable in the Grid menu), and the display shows a grid of dots.
Both dot size and grid density can be adjusted.

Single or selected points are moved in DeltaGUI, whilst viewing the display; moving a single point
smoothly affects those around it to a certain degree so that sharp changes in direction are minimised.
Use the Affects selection for how far spread the distortion needs to be, before starting the
adjustment. Medium is recommended for the range of influence for 11 × 11 grid density, small for
21 × 21.

Point Selection

· Single node: move from node to node with the arrow keys; the selected node is yellow. You can
clicking to select, but this is likely to nudge the point.

· Multiple nodes: rubberband over a number of points and move them as a group. To add groups,
press Shift, then rubberband over further points.

In this example below, you can see the distorted part of the image around the yellow (selected) point:
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· For large movements, use the mouse to select the point or points, and drag to the new location.

· For small and precise adjustments, use the arrow keys to select the point, then press Ctrl and use
the arrow keys to move the distortion of that point.

Once finished aligning the geometry, return to the Timeline image source.
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Grid Menu: Reset Distortion

To reset a group of points, rubber band over them to select them, click the Grid button then choose
Reset Selected Points from the menu.

Reset This Channel’s Points or All Channels’ Points

Grid Menu: Export this Geometry

Export this Geometry to use in other applications which use the warp:
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Grid Menu: Grid Density

You can swap from the default 21 × 21 grid to an 11 × 11 grid using the Reset menu > Grid Density
item.

Note that this will reset all point distortion on all channels on this server.

Grid Menu: Dot Size

You can choose larger than the standard dot size if the dots are hard to see.

Copy Distortion

To copy the current channel’s distortion to another channel, press the COPY button in the lower left
corner and type in the destination channel.

Display Configuration: Blending

Delta implements simple edge blending, to allow overlapped display systems to be blended together,
forming a single continuous display surface. By combining edge blending with warping, Delta can be
aligned to any display system with no additional external hardware.
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The Edge Blending page allows you to tune each blend (Left, Right, Top and Bottom) for position,
softness, bow and keystone, as well as gamma and smoothness (s-correction). Blend Limits allow
you to stop the blend at a hard edge part way through the image (used on some complex blends).

To edge blend a system, ensure softness on overlapping blends is the same, make the edges parallel,
then tune the position and gamma to make a seamless blend.

A good blend is highly dependent on the fundamental display matching, so ensure the luminance and
colour match between the adjacent display channels is as good as it can be.

A blend can be inverted (edit the resource on the timeline, Timeline tab), so the black part is in the
middle of the channel, soft edges are outside this. This is used when blending insert channels which
are blended to surrounding channels

· The Enabled button allows you to temporarily disable this group’s blending.

· The Softness button toggles between a hard edge or correct softness for this group so you can
match up the two adjacent blends with a hard edge, then enable the softness to see the result.
This is a temporary condition which is not saved to the file.

· If you put two blends (same channel) on the same frame, they will multiply together, so you can
create complex blends using multiple blends.
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· On the Mesh page of the resource editor (only available whilst in Mesh Mode), choose between
normal Channel blending or apply the blend to the Source Texture from the Blend Target drop-
down menu.

This is used to apply blending on the 3D model between different media and can be used in
conjunction with other blends set to Channel mode for standard projector edge blending.
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In the example below, blending has been applied to a cube mesh with 2 channels. The first image
shows what happens when the blends are applied to the whole Channel, whilst the second image
shows how blends are applied to the Source Texture 3D mesh.

For more information on Mesh Mode, including Mesh Editing functionality, see Display
Configuration: Mesh Mode .

· Blend resources can also have Fixed enabled – this will auto-reset the start frame of this
geometry to frame 0. If Fixed is disabled, you can set the start frame as normal.

Display Configuration: Colour Balancing and Convergence

Adjacent channels may not be accurately colour matched. To change the colour of a channel, you
must first add a flat colour resource to the timeline (background layer), assign it to a channel, and
then adjust it here whilst observing it on the screen. Note that if the projector supports higher bit-
depth colour adjustment, it should be carried out in the projector in preference.

In the Display Configuration menu > Colour, tune the overall (flat) colour of the image using the
Black/White contrast button.

229
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Then adjust the brightness and gain (contrast) for each RGB colour (or overall) and gamma can be
also adjusted. The central image in this page is a static reference only.

If colour or luminance drop-off to the image edges is not good enough, select the RGB square buttons:
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Then pick which side to increase or decrease in luminance for that colour. The centre of the picture is
unaltered, with increasing adjustment to the side you picked. Here, left edge, red colour adjustment is
selected:

Colour Balancing Sequence

The normal sequence of operation in matching a multi-channel display system is:

· Choose a rich, full-screen image with all colours present.

· Observe the centre of each channel, and use the White colour controls to match the centre
luminance and colour.

· Observe the edge between channels, and use the relevant edge colour shading control to match
the colour and luminance at that point.

This is typically used to match colour and luminance across multi-channel display systems.

Display Configuration: Splines

Spline resources can be applied to any layer, including the background. They comprise a series of
Bezier curves along which the top-left (optionally the centre) coordinates of a media resource travels.
The motion can be A to B, or ‘Ping-Pong’ A to B to A, and can be set to repeat any number of times.
Default splines are supplied, which can be edited and saved back as resources to the pool.

To alter Ping-Pong, repeat count, and advanced timing of each node, edit the resource on the
timeline.
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Ping Pong
When this is enabled with a repeat count greater than 1, instead of simply repeating the move,
starting at the first node again, it will reverse course along the spline until the start, then reverse
again, ping-ponging direction.

Repeat Count
By default, this is 1, where the whole length of the spline is travelled over the length of the
spline resource on the timeline. With a count of (for example) 4, it will travel 4 times over the
spline path in the same length of the spline resource on the timeline.

Spline Properties

In Equal Timed mode, each node is given the same fraction of time allocation as set by the length of
the spline resource on the timeline. For example, with 5 nodes, the 5th node will be reached at 100%
of the length, the other nodes at 0, 25, 50, and 75%.

In Node Timed mode, you can edit the fraction of time for each node, as long as they all add up to
100%. For example, you can set the 5-node example to 0, 12, 13, 75, 100% so that the 2nd node will be
reached after 12% of the resource length, the 3rd node after a further 1% (a quick move), then the 4th
takes 75-13 = 62% (a slow move) of the length.
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Spline Controls

You can select the spline in the Timeline tab of the resource window, then using the controls in the
right panel, add nodes, remove them, move nodes and node controls around, until the shape is as
required.

Move a node or node control
(Press the Control key to restrict movement in X or Y)

Add a node to the end or insert a node in the middle of a spline

Delete a node

Move the entire spline

Resize the entire spline
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Rotate the entire spline

Toggle a node from symmetric control nodes to separated control nodes

Rubber band selection of a number of nodes
(Press the shift key to add to the selection)

Note you can also zoom in and out using the mouse wheel:

Zoom into the canvas

Zoom out from the canvas

In certain modes (Move, Delete, Toggle Node Type), dragging on an empty part of the canvas allows
you to drag the canvas around to navigate more easily.

Draw Onscreen

With this checkbox selected, the spline path will be shown as a tracking line in the playback window
when the spline resource is in scope. In addition, parts of the spline to the left of the playhead are
shown in yellow, future parts in red so you can see how far through the spline the resource is.

Spline [Configure] Menu

Click the [Configure] button on the splines page for the following menu options:

Reset Spline Location
This will move the spline so that the first node is at 0,0 in order to put it back on the canvas – it
does not change the shape of the spline

Limit Spline to Canvas
This will move any node which is off the canvas onto the canvas – note that this will change the
spline shape.

Show Node Coordinates
Enables the drawing of the pixel coordinates of all nodes

Show Node Order
Enables the drawing of the node order
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Mirror Spline Horizontally / Vertically
Mirror the spline horizontally or vertically

Rotate Spline
Rotate 90 Clockwise, 90 Counter Clockwise or 180 degrees.

Undo / Redo
Pressing Ctrl+Z will Undo and Ctrl-Y will Redo up to the last 20 changes to each spline.

Show VCR Controls
Show the playback controls and timeline, to enable moving the play head.

Snap
Enable or disable snapping points to the grid at preset grid sizes.

[RESET] Button
Resets the view position so that the canvas is shown full screen

Save to Resource Pool
This button in the resource window allows you to alter a spline, then save it to the \Splines
folder as a template for future use.

Note that Splines only work in Flat or Mesh mode (not Dome Mode).

Display Configuration Files (XDL files)

When choosing ‘File > Save As’ you have the option of saving a Display Configuration file (choose this
in the ‘Files of Type’ dropdown box). This file contains a subset of the current server’s settings, which
relate to the display configuration.

You can load an XDL file at any time onto an existing show. This merges the display configuration in
the XDL file with the current timeline contents, which allows you to keep display configuration
separate from the show.

An XDL file contains:

Display Settings
Canvas size, active channels, channel sizes, timeline length and framerate, geometric mode,
display gamma, beams, geometry and softness enable flags.

Background Geometry
Only those geometries on the background layer are saved in an XDL file.
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Blends
If present, any blends are saved to the XDL file.

Colour
If present, any colour corrections are saved to the XDL file.

Note: an XDL file is merged with the current file. Any existing background resources (warp, blend,
colour) present in the first 10 frames of the timeline are deleted, before any of those resources are
merged from the XDL. Any of those resource types present after the first 10 frames will not be
altered.

Permanent Geometry

You can specify an XDL file which is loaded after any file load so that the display configuration, point
distortion and background geometry, blending and colour is maintained across show files even
though this is not saved in each show file.

In DeltaGUI menu: Configure > Preferences > System, browse to the XDL file which is to be loaded each
time. This is stored in the registry.

With a permanent XDL file defined, the behaviour of this process is on any file load:

· Load the Show XML file as normal

· Delete any geometry, blends and colour found in frames 0-9 on the background layer

· Merge the XDL file

You can also set the XDL file from external control if you want to swap between different permanent
geometry setups:

SETDISPLAYCONFIG "C:\program files\7thsense\delta\setup1.xdl"

or

SETDISPLAYCONFIGALL "C:\program files\7thsense\delta\setup1.xdl"

to set all in that group to the same XDL file.

Note that a popup shows in DeltaGUI to highlight when an XDL is loaded.
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Display Configuration: Flat Plane Mode

In this mode, projected images are co-planar: i.e. they are on the same flat (or
curved) screen surface.

In Flat plane mode you can have up to 64 channels (dependent upon licence options),
which show any part of the canvas (the full display area including all Delta output channels), up to the
full canvas (or over-scanned) and down to very small areas of the canvas. Click the C button to select
active channels:

You can think of a channel as a window onto anywhere in the entire canvas, for instance a small
channel will only fill a small part of the entire canvas.
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In the example above, the canvas is set to a nominal 4608 ´ 1440 pixels (it can be any units to suit
your need), and two channels are defined: Channel 1 is shown as a blue rectangle covering half the
canvas, Channel 2 covers the other half, with an overlap for blending of 512 pixels.

These channels can be independently sized or rotated by any angle to match the display orientation.

Each channel can be dragged and resized onto the canvas here. These illustrations show the effects
in a 3-channel panoramic display in DeltaGUI and the playback window.
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p Channel 1 has been oversized to the canvas
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p Channel 1 has been undersized to the canvas

Dynamically Resizing Channels using Sequences

External control commands can be used to trigger channel resizing, using sequences  on the
timeline.

Example:

$startblock
SETCANVASSIZE w=32 h=32
CHANNELMOVE num=1 x=0 y=0 w=32 h=32
$endblock

$startblock
SETCANVASSIZE w=1920 h=1080
CHANNELMOVE num=1 x=0 y=0 w=1920 h=1080
$endblock

365
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Flat Plane Channel Arrangements

Edge-Butted Display

In this configuration, each picture is lined up to its neighbour exactly along a common edge. In Delta,
Set Channel 1 and 2 to exactly half of the canvas size, and set Channel 2 to have an X Offset of half
the canvas size. No blending is required for this system.

You can either type in the figures manually, or use the Defaults drop-down list and choose
Horizontally Edge Butted to automatically calculate the figures.

In the example below, Channel 2 is shown with an X offset of half the canvas width.

Overlapped Display
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In this display, the projected images are physically overlapped (usually by a minimum 10%), then a
blend is applied to the left and right edges to provide a seamless display.

You can either type in the figures manually, or use the Defaults drop-down list and choose Horizontal
10% Overlap to automatically calculate the figures.

In the example below, the canvas is set to 2304 pixels wide, with Channel 2 shown with an X offset of
1024, leaving a 256 pixel overlap between Channels 1 and 2.

Underlapped (Bezel) Display

In this display, the projected images have a physical gap, so the Delta imagery must also have a gap
otherwise things will not ‘disappear’ properly in the gap.

A typical example of this arrangement is two or more display-wall panels butted together, rather than
projectors as illustrated. Due to the bezel around the panel edge, there is always a significant gap
between adjacent channels, so the underlapped configuration can be tuned to provide the correct
imagery.
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Flat Plane Output Channels

The Output Channels button shows the channel layout, with a representation of all active channels.
This is a flat plane mode array of 6 channels. If a channel is made inactive, the display will adjust to
best fill the canvas.

Display Mode
This replicates the settings in the Defaults Wizard (see Flat Plane Mode Defaults ).

Flat Plane Preview Window Setup

Set the area you wish to see in the Preview window. You can do this while viewing
the actual Preview window.

Click the Preview Setup button and then type in or drag the preview location XY
(top left corner coordinates), width and height values (and/or rotation). This location is independent of
any output channel.

176
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Flat Plane Mode Defaults

Press the Defaults Wizard button to view the configuration dialog:
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From this dialog, you can arrange channels in a horizontal line, vertical line, or X by Y grid of channels.
You can also choose to edge butt the channels (no overlap) or set the overlap in pixels or percentage
of channel width.

Canvas

Rescale Canvas
will resize the canvas when overlap is introduced, for example reducing from 2560 ´ 1024 to
2432 ´ 1024 for 2 channels 10% overlapped. You can choose to leave the canvas size fixed
instead – in this case, channels will be resized to fit.

Channels Used

Assign the number of channels required (or if editing an existing display configuration, use existing).

Channel Arrangement

In most cases, match the channel matrix applied to your desktop display arrangement as set in the
graphics card configuration on the server.

Overlap

Edge Butted
is typically used for displays which have no overlap.

All Overlapped
creates multiple channels which all look at the same canvas, but can have different distortion /
blending – ideal for stacked projection.

Overlapped
is used for overlapped projection.

Underlapped
is used to remove the gap created by bezels between fixed-matrix panels.

Channel Size

Channel size can be Forced to a user value or in ‘Use existing size’, will be taken from the graphic
card’s information.
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Add Warps and Blends

For Overlapped channels, you can choose Create Warp and Create Blends options. Create Warp will
add a flat (non-distorted) warp resource for each channel and Create Blends will insert nominal
blends in the right place as a starting point. Note that existing warp and blends will be removed from
the timeline on the selected server.

Process: Flat Plane Align, Warp and Blend

Any non-perpendicular projection requires a degree of warping in order to correct for perspective. This
procedural guide covers flat plane screens – which includes curved screens, but not spherical
surfaces – and uneven surfaces, but not polygonally-mesh-mapped ones. Once set up, the display
configuration for the theatre can be saved and loaded separately, to be merged with any show.

Three Adjustments per Channel: Shape, Overlap Brightness, and Colour

The basic principle is that since the canvas as a whole is divided into areas covered by several
channels, each channel will require its own correction by warping to maintain both aspect ratio and
perspective. The channels will need to overlap for smoothest continuity, corrected for luminance by
blending, and differences in characteristics between projectors may finally require correction for
colour.

· The alignment task is about mapping a seamless, evenly-proportioned grid, across all channels,
onto the physical canvas, without distortion, duplication or cropping, using the various warping
tools.

· The blending task is about making the joins between channels invisible through luminance
blending and colour correction.

In the example used here, projectors are in line, but other configurations are possible.

Physical Setup and Tools

We assume here that the theatre setup has provided you with enough information to know media
size, physical canvas properties and degree of overlap between channels, and that best efforts have
been made already in aligning projectors correctly. The procedures outlined here will apply every time
readjustment is necessary, for example following regular maintenance.

Since one of your key tasks will be to ensure that the size and aspect ratio of every grid square is the
same, some basic tools will be useful, including, for example, a laser line (to find true horizontal and
vertical) and a tape measure.
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Autoalignment, such as Scalable Display Manager™, is a practical though more expensive solution,
but for more complex surfaces may be worthwhile (enable this in Config > Startup & File Load ).
Please note: AutoAlignment is a licensed option.

Sequence in DeltaGUI

· Know your canvas size, your overall media size, the approximate channel overlap, and how your
channels are distributed.

· Use the information in the Defaults Wizard to distribute active channels, positions, and overlap for
Delta, and to generate default background warps and blends.

· Turn on the pixel grid display, and adjust channel X and Y locations, and overlap to bring the
defaults approximately into line with reality.

· Adjust each channel for proportion and linearity, and align each channel to the next, using surface,
timeline and point distortion warp.

· Display test patterns or flat colour media in order to apply blends and adjust overlap luminance.

· Save the .xdl display configuration file to use for any show in this configuration.

Process: Setting Up Channels

In DeltaGUI, start a new show (File > New), clear of all resources and configurations. Check in Display
> Output Setup that the Output Channel Mode is Off (All In Line).

100



180

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

In this example, we have three 1920 × 1080 channels, and have an approximate 20% overlap
between channels. The wizard will rescale the canvas and provide initial warps and blends.
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Click Apply, and Done, and you will see the three channels positioned:



182

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

These canvas dimensions (in this example, 4992 × 1080) provide the aspect ratio for media content
design.

Look at the DeltaGUI Layers view, and you will now find a default warp and blend for each channel, in
the background layer, and these resources are available for selection and adjustment in Warp and
Blends view.

At this point, DeltaGUI has distributed three channels to a flat, ideal canvas, but it does not know
anything about the actual physical setup, such as screen curvature or projector angles and settings.
We shall now project the default Delta grid onto the screen and warp it into correct position.



183

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Process: Warping to the Physical Surface

Disable any media on your timeline, go to Blends and uncheck ‘Enabled’ so that all edges will be
visible, and switch on the pixel grid:

Your canvas will now show this grid, revealing not just imperfect positioning, but angular distortion
and rotation, and the grid squares may be of uneven size. In this example, we are using a laser line to
indicate true vertical and horizontal wherever it is useful.

Alignment is an iterative process, in which you will make minor adjustments using different tools in
turn, because positioning will affect proportioning and vice versa.

Correcting the Overlaps

Along the left and top axes of each channel you should see grid numbers. Here is a channel overlap
portion with the red laser line to guide our warping. Note that the numbers should roughly coincide:

How well the numbers coincide depends on the accuracy of the overlap entered in the Defaults
Wizard. You can adjust the overlap and rerun the wizard, but with multiple channels and slightly
variable overlaps, you may need to adjust individual channel X and Y locations.
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Note here too that the RGB beams can be switched out, to colour each channel differently and
distinguish them. (Alternatively, use the Beams menu in the status bar.) A channel’s pixel grid can be
hidden by switching all beams off.

Rotational Alignment

If a channel appears slightly rotated (off axis), Delta can correct for this. Rotation in the display setting
(above) rotates the media but not the pixel grid: it is not a warp. Use this typically for 90 degree
increment channel rotation. 

Rotation in the Timeline warp tool rotates the grid, but within the aspect ratio of the channel. Other
warps may therefore be more useful for minor realignment.

Grid Warping

Surface Warp

If you know the physical canvas frame positions (corners or edges) for correct aspect projection, it
can help to mark these. You can then work inwards to align each channel. If the physical canvas
cannot be marked, then it may be better to work outwards from the middle of each channel to
straighten the grid, and to adjust for equal grid square sizing.



185

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Focus on worst-case misalignment first, and aim for progressive improvement rather than perfection
with each move.

Familiarise yourself with the warp tools and how they manipulate the grid. Learn the effects of
single and multiple point selection, the difference between linear and spline (surface mode) grid
deformation, and the geometric advantages of timeline warping. The sequence in which you apply
warp tools can make a difference. There is no fixed way, because a faceted canvas, a single flat
plane and a curve, will all require different treatments.

Ø See Display Configuration: Warp . 

Now go to the Warp view and select Surface geometry. There are two approaches.

Outside-In Approach

If you know where the corners of a channel should be, reduce the grid to its outer points only (use the
H- and V- buttons). Here the top left corner is selected for the channel 1 warp geometry, to be
dragged visually into position on the physical canvas. Move a point with Ctrl+arrows, and
Ctrl+Shift+arrows for fine movement.

150
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Once the corners are positioned, add grid points (H+ and V+) (adds vertical and horizontal grid lines).
This enables smooth shaping of the channel to the canvas. Adjust outer borders first, and then
linearity across and down the canvas (again, a laser line will help if you have true verticals and/or
horizontals). Where the canvas is accessible, simple physical references, such as a measuring tape or
marked card, can be used to compare actual pixel grid dimensions across the physical canvas.

Inside-Out Approach

If the projected area border is simply relative to the centre of the media, working from the middle
outwards may be more practicable. Using laser lines, more points on the surface warp grid can be
used, and groups of points moved together, in order to achieve true verticals and horizontals in the
grid, and linearity.

Timeline Warp

For surfaces that are evenly flat or curved, applying Timeline geometry is quicker (these are
mathematical approaches to the whole channel that include sizing, skewing, bowing and proportional
linearity for all, half, and quadrants of a channel).
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Point Distortion

For surfaces with irregularities, the Point Distortion option provides a useful addition. Media with finer
detail, including writing or subtitles, can become blurred, especially in overlaps, where the surface is
not smooth or flat. These point, or point group, distortions are added to the other warps and are used
last.

Repeat with each channel across the canvas, and adjust the channels so their grids exactly overlap
those of their neighbours.

Process: Blending Flat Plane Channels

Where channels overlap, the FlatPlane Defaults Wizard will have placed blends in the background
layer for you. For overlapped in-line channels, the top and bottom, and canvas left and right edges will
not have been proportioned, but they will need moving out of scope.

If you have not used the Defaults Wizard, and placed your own blends in the background layer, you
will just have a little more to do.

Enable or disable all blends (all channels), or just the softness, using the two upper checkboxes.

Ø For full details on blending tools, see Display Configuration: Blending . 158
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Add (or enable) timeline media resource(s) and switch off the pixel grid. If you have correctly aligned
your channels, the overall display will not be torn or duplicated, but where channels overlap, the
default blends may be creating shadows. Edit the position or shape, softness and gamma of adjacent
blends until luminance is even. For this you can use the ‘Uniformity’ or ‘Flat White’ test pattern. It can
also help to use flat red, green and blue images in turn. Finally, view your show media.

If necessary, apply a flat colour to your background layer for any channel that requires colour
correction. This will complete your alignment and blending.

Ø See Display Configuration: Colour Balancing and Convergence . 

Process: Display Configuration Files

Now you have achieved your flat plane alignment, it can be saved and applied to (merged with) any
media show:

1. File > Save As > Display Files (*.XDL) (do not use the Default File option) 

2. Config > Startup & File Load, Merge Permanent Display Config (on any file load) and browse to the
.XDL file you saved.

161
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3. As and when the display configuration needs adjusting, File > Open and select the .XDL file to edit.

Ø See Display Configuration Files (XDL files)  for more detail. 

Using AutoAlign with Pre-warped Media

Delta geometry (warp) and autoalignment functionality is normally used to fit media to a given flat or
curved screen. The media is produced in a flat, rectangular format as standard, and Delta applies the
required warp to any media sent to the projector(s).

If content creators and AV integrators know the display size and geometry, and the projection
configuration, they may calculate the theoretical shape required and create pre-warped media to fit.
The method, however, relies on projectors and lenses being setup and positioned perfectly, as well as
the ‘theoretical shape’ of the media accurately matching the actual display, so there will always be
some minor adjustment necessary, and autoalignment may be the best answer.

Since autoalignment software generally assumes flat and unwarped media, it is necessary to apply
an inverse of the pre-warp to the warp calculated by the auto alignment system.

Media u Delta warp u Autoalign warp u Display

(rectangular)

(prewarped) (EXR file unwarps the prewarp)

7thSense therefore requires pre-warped media to be delivered alongside the following configuration
details and media files:

1. An inverse warp map for each projector in the system. To be delivered as .EXR files due to the
requirement for uncompressed floating point pixel positioning of the date inside the files. The EXR
files act as an ST Map (UV per pixel map) that define where every 2D output pixel location is taken
from, in 2D input pixel space – in the plane of the projector’s imaging device.

Red X position 0 being left, 1.0 being right of input image

Green Y position 0 being top, 1.0 being bottom of input Image

167
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2. The Frustum definition and location of each projector (tan theta lens assumed)

· X,Y,Z position

· Orientation as XAxis (Heading), YAxis (Pitch) and ZAxis (Roll) rotation 

· Left, Right, Top, Bottom angular width of projection cone in degrees from projectors
orientation angle. This can also be supplied as a H & V FOV. 

Once created, the EXR files should be stored in the C:\Geometry folder of the Delta server (refresh GUI
to see in the Resources panel). Each can then be dropped onto the timeline and allocated to its
channel.

Once each channel has its EXR file attached, camera calibration (auto alignment software) can then
be used for perfect alignment to the display object.

Note: The Projector location and Frustum positions must be fixed in the autoalignment software to
match those used when generating the pre-warped media.

To ensure the highest image quality, the Delta media server warp result that is applied is only the
difference between the pre-warp definition and the calculated warp of the auto-alignment system.
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Display Configuration: Composition Mode

Composition Mode is a Delta Licence option for managing multiple flat screens that do not form a
contiguous geometric shape. This may be a complex video wall, or large-scale LED modular panels,
distributed on a building or buildings, or LED backdrops to entertainment.  Essentially, it is a means of
placing separate output channels independently within an overall canvas.

The principle: placing parts of a media frame into distributed channels

Media is usually designed for the shape and dimensions of the display canvas: a fisheye for a dome,
panoramic for wide screen, rectangular and so on. Each channel (projector or display panel)
addresses one part of the total canvas with just that part of the total media frame. This situation can
be optimised for bandwidth or processing capacity by carving the media down to only the part of each
media frame required for each channel, but the parts remain channel-mapped and the channels all fit
together with overlap and blend.

However, in the case of distributed LED panels that do not form a contiguous geometric canvas, the
media design can itself be pre-optimised, and the separate rectangles packed far more economically
into a frame that minimises empty pixels. Take this simple example where an arrangement of display
panels is used to display a single piece of media:

The media could be rectangular:

Even though the LED display array is not:
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But that is far from optimal. So taking only the media area (viewport) required by each display panel
channel, the elements can be packed tightly:

Using mapped co-ordinates, Delta composition mode extracts each element of the media, rotates
and/or positions it to address each channel (LED panel) appropriately:

Multiple Distributed Displays

In other cases, different media might be addressed to the various channels in a more complex or
really big array. Compare the real array (left) with its logical layout (right):
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Again, there is a lot of unused area, when treated as a whole, which wastes a lot of bandwidth. The
media can be sliced and packed more efficiently in the frame; we then unpack it on the Delta canvas.
Note how a single LED display (the long thin one) can itself be sliced. Pieces can also be rotated in the
packed file, and rotated back on the Delta canvas. Here is the packed frame:
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Output Blocks

The size of the media frame is dramatically reduced, but an LED processor is still limited to what it
can process (often up to HD 1920 × 1080 pixels) and so this format may still be too big for an
individual processor.

To break the media up further, the unpacked media can be planned on a Delta canvas of 4 × 1920 ×
1080 HD blocks:
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All we need to do now is to find the coordinates and dimensions of each LED panel in the packed
artwork, make each a channel, and then place the viewport for each channel in the output, according
to this plan.

Delta will place the elements in the output, and the LED processor will be programmed to map the
outputs onto the displays.

Important Note:

Prior to creating your show in Delta, you must prepare your media (as above) and ensure that you
calculate the size and position of each LED output screen in relation to a rectangular canvas:

· Note your canvas size in terms of required outputs (total height × total width in pixels).

· Establish the coordinates of the LED display elements within the media.

· Draw up a diagram to show position and size of each viewport within the canvas.
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Composition Mode in DeltaGUI

In DeltaGUI, set the Output Setup  to Composition Mode.134
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Set up Channels and Canvas Size

It is recommended to set one channel per viewport (LED screen). Click the C button to activate a
channel for each LED display:

Enter the Width and Height of the total canvas (to match the total media pixels, here 4 × HD outputs),
then selecting each channel (LED display) in turn, enter its width and height, and XY location. Whilst
channels can be dragged to position in this view, you must know the numbers and will have to enter
these anyway. You may find it easier to activate, locate and place each channel in turn. These
illustrations show the finished result.
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Note here how all the channels have been located, and now look the same as the packed artwork.
Channel 7 is selected, showing its position in the media frame, and dimensions. If a display has been
rotated in the media to better fit, correct the rotation here.

Next position this channel (area of the packed media) on the output.
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Click ‘Output Channels’. Width and height will be the same as for the channel, the Viewport Location
will be as shown in the HD output blocks (see above).

This completes the composition; the rest is up to the LED processor to render the outputs to the
display panels. (The Delta Playback window will not make much sense in this mode.)

Composition Mode and IntelligentSource

To enable all outputs in Composition Mode to carry the IntelligentSource data row, a small
adjustment must be made.

With IntelligentSource data stream enabled, you will see the data row visible as the top pixel row in
the Playback Window. In Composition Mode, you will initially only see this in the first (top left) output,
so you must restore it to every output.

In Display > Output Setup, make sure that you remain in Composition Mode and that using the drop-
down boxes beneath ‘Matrix Mode’, you represent the same output arrangement as your graphics
driver (e.g. NVIDIA Mosaic).
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You will now see the IntelligentSource data row flickering in the top of each output in the Playback
Window.
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Display Configuration: Dome Mode

Dome or frustum mode is a Delta licence option, for projection onto spherical or
ellipsoid surfaces.

For projection purposes, measurements are relative to the eye-point. For a
hemisphere, this will be the geometric focal point; for a partial hemisphere (illustrated here), it will be
at the centre of the intersecting plane. Elevation is taken from the eye-point, with 90° being vertical to
the dome centre, 0° being from the eye-point to the dome edge. Azimuth, or horizontal sweep from
the eye-point reaches from -180° left to +180° right. Linear measurements are in mm.

In Dome Mode, media can be placed on the canvas as flat, fisheye, panoramic or channel-mapped, as
required. The projection area of each channel is outlined in a different colour in the DeltaGUI
representation.

Defining the Canvas

Screen shapes can be spherical or ellipsoid and are assumed to be geometrically accurate:
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Alignment, Warping and Blending

In the real world, projectors cannot be fixed accurately or ideally, and any movement will result in
misalignment. Autoalignment software (7thSense recommends Scalable Display Manager) can be
used on a regular basis to keep the display correct. Between the Delta defaults Wizard, manual
adjustments and autoalignment data, you can very easily achieve optimal channel overlap, to which
you can add warping (if necessary) and edge blending. By the nature of domes, you must ensure
sufficient overlap at the dome edge, where this is smallest (8 degrees is advisable).

Ø See: Configuring Delta to use Autoalignment Data  216
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Dome Mode Views

Channel View

Channel View shows the segment of dome surface covered by (as ‘seen’ by) a single channel:

Note that the channel dimensions are reflected in the bottom status bar of the view. The RESET
button restores channel dimension defaults.

Interactive view

It’s best to view the dome in Interactive mode, moving the interactive view to be from beneath the
dome, looking up to see the whole dome surface. Use the mouse controls shown, to drag the model
(or click on the mouse arrows) and manipulate the view.

Mouse controls:

· Left-click + drag : pan and tilt the whole mesh



204

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

· Right-click + drag : shift the whole mesh

· Centre-click + drag : zoom

· Shift+left + drag : spin the mesh around a set point in 3D space

Note that the current interactive viewpoint is reflected in the bottom status bar. The Edit button
allows you to save and name viewpoints and return to them:
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X, Y, Z, Azimuth and Elevation are from the current view, and can be further adjusted here. Field of
view is saved from the current view.

If you want to see the origin of the frustum (which is the projection point location), press the *Draw
button, select Frustum > Lines, or select ‘projectors visible’, if that is helpful.

Preview Setup and View

To view a spherical dome projection correctly requires a square format. Set this as a custom format
in Configure > Preferences > Preview Window.

The Preview Setup button enables you to manipulate the viewpoint of the Preview window:
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A reference grid can be overlaid on the preview and (below) playback window, selectable in degrees
of separation (the number you enter is degrees between the lines) and visual intensity in percent.
Enter settings where circled in red above, and toggle the grid on and off with the toolbar icon.

Playback Window

In Channel Mode in DeltaGUI, the playback window will display the channels arranged according to
how the graphics cards are configured. This will normally be each channel side by side (see Output
Setup), unless the graphics card has been set up in a x × y matrix.

In Interactive mode, the playback window will display the dome from the DeltaGUI viewpoint, and as
you drag or move this in the DeltaGUI window, it will follow in the playback window. Alternatively, the
playback window image itself can be dragged around with the mouse directly.
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The composite illustrations below show the how the grid appears, when superimposed on the image,
in each mode (left: channel mode, right: interactive). Blends and warps between channels are not
shown in the playback window.

Fisheye image credit: NSC Creative: from ‘We Are Stars’
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Defining and Sizing Channels

Set the number of active channels (projectors). Using either or both the default wizard and the
channel dimensions settings, you will define the rectangular area of the dome covered by each
channel. The centre of this area is given a (horizontal) heading, (vertical) pitch, and (rotational) roll. Its
width is defined by left and right angles, and height by top and bottom angles.

Click the C button to define active channels. This example will be for 5 surrounding channels and a
cap channel.
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Channel Sizing (Default Wizard)

Delta will distribute channels automatically, from where all channels can be adjusted manually. Press
the Defaults Wizard button to view the configuration dialog:

The Dome Mode Defaults dialog can place projectors around the dome interactively, so you can
design the projector coverage to allow sufficient overlap for blending, or note where projectors have
to be placed due to lens restrictions etc.

Force Size
choose Force Size to force the dialog’s channel values into the server, or Use Existing Size to
leave them unchanged.

Aspect
Alter this to the aspect ratio of the projector’s output video format, so for example, 1920/ 1080
= 1.777, or 1920 / 1200 = 1.6

HShift / VShift
Alter these values to match the known projector lens shift, so for example if the projector has
no lens shift (image is dead center in the lens), leave these at 0, but if the projector has an
inherent 100% lens offset vertically, enter 100 to VShift, 0 for HShift.
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Zoom
This value should match the projector’s lens zoom value (0.8 = wide angle, 1.2 - 1.6 = standard
type zoom, 2-4 = long lens).

Pitch
Alter this value to pitch the projectors up to fill the dome. A typical projector arrangement is to
have projectors located on the dome springline (horizon), so they need to pitch up to fill the
dome.

Roll
Alter this value to match the projector roll angle if any, or for example set to 90 if the projector is
in portrait mode.

Channel Arrangement

Projectors at dome centre
choose this if they are all at dome centre, facing out to the dome surface (unusual).

Projectors at screen edge
choose this if they are all at the screen edge, crossfiring to the dome surface (typical).

Projectors inside screen
choose this if they are all within the dome, crossfiring to the dome surface, you can set a
separate radius from dome centre where the projectors are located.

Projectors outside screen
choose this if they are all outside the dome, firing on the outside of the dome surface, you can
set a separate radius from dome centre where the projectors are located. Note in interactive
mode on the server, content is only shown on the outside of the dome surface.

Channels Used

Force n channels
or leave as-is

Include Cap
will make the last channel point up at the dome pole, from near to where channel 1 is located,
and also choose a wider Zoom for that one channel so it covers more of the cap.

Screen
Set Screen Radius

Force a radius in mm or leave as-is
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Spacing
Set the spacing angle in degrees, or set to Calculate (default) to allow DeltaGUI to move
projectors to equally spaced around the dome.

Channel Size (manual adjustment)

It may be necessary to make adjustments, or direct settings for a partial dome (see the example of a
panoramic dome  section, below).

Set or adjust the dimensions for each channel or use the L button to use lens characteristics instead
of angular dimensions:

213
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Media Resources and Layers

Resources are layered on a dome as on any screen, including any animation, fading or transparency
effects, and transform animators . Note that rotating a flat resource is about its design centre and
within its channel area, not about the dome centre.

Configure > Preferences > User Interface > Features > Features includes the option to enable Intelligent
Resources  to detect fisheye, panoramic, flat or channel-mapped. 

Note: Dome Mode resource defaults are set in Configure > Preferences > Resource Defaults > Dome
Mode Defaults.

Layering resources on a dome is exactly the same as a flat screen, but different original mapping
modes require different treatment. For example, here a flat image has been layered over a fisheye
movie. The square image has required a geometric warp to be applied in the timeline, to re-align with
the dome grid. Its position on the dome has been adjusted in the timeline Resource Editor. A channel-
mapped piece of media would not require such geometric warping.

Fisheye image credit: NSC Creative: from ‘We Are Stars’

361

114



213

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Panoramic resources

Panoramic media can be stretched around a dome or partial dome (spherical segment). Here a
spherical canvas segment with three channels has been used, rather than a full dome. The canvas
size and channel coverage have been entered into DeltaGUI here, and the angular height and width
properties of the image entered in the timeline resource properties editor. The DeltaGUI interactive
view shows the projectors and lines, and the grid is displayed for clarity. The Delta (web) Preview is
shown top right, and playback window, bottom right.

For comparison, the same panoramic image is shown here projected onto a hemispherical dome:
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Autoalignment Process: Preparation

Autoalignment Calibration Data

7thSense recommends Display Manager™ from Scalable Display Technologies for automatic
geometric alignment of displays with Delta Media Server. This is a camera feedback system,
whereby light and patterns projected by the alignment software are ‘read’ by a DSLR camera to
produce alignment calibration data. This is fed back to the Delta software to project a perfectly
calibrated display.

Each Delta server loads the autoalignment data in its directory for Scalable Display autoalignment
systems. The default output folder used by the Scalable Display Client is C:\Program Files\Scalable
Display\DEI\LocalCalibration.

Ø see Scalable Display Manager  

Systems that can export MPCDI standard exchange files can also be used (for example VIOSO), and
these files are copied directly into C:\AutoAlignment\MPCDI on the server. See:

Ø Using MPCDI Data  

Ø Using VIOSO with Delta

217

225

https://portal.7thsense.one/user-guides/M365-using-vioso-with-delta/
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Media

Full dome displays usually use fisheye media (square or dome-master format) and typically involve 6
or more projectors. It is important to have sufficient overlap to achieve good blends, and to position
projectors for good overall focus and avoiding large incident angles.

System Setup for Scalable Display Manager

It is assumed that:

· the graphics card setup has been done (AMD: Grouping; NVIDIA: Mosaic)

· Scalable Display Manager, as client, has been already installed by 7thSense on each Delta server
being used for the display

· Scalable Display Manager (licensed installation) is installed on a separate laptop PC, on the same
network as the server(s).

· DeltaServer has a current Auto Align licence, and Dome Mode licence. Check the ‘About’ dialog on
DeltaServer. You should see Auto Align in the dropdown list of options:

· DeltaGUI Configure > Preferences > Startup & File Load has AutoAlignment, Use Auto Warp, and
Use Auto Blend enabled.
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· In the diagram below, a Scalable Displays-recommended camera has been set up, with a fisheye
lens, facing normal to the pole of the dome, close to the dome spring line, and can see the whole
display – but as little more as possible. Unwanted light should be minimised to achieve best
contrast for the Scalable software, and kept constant. This camera is connected to the laptop PC
using Display Manager.

Configuring Delta to use Autoalignment Data

To enable use of autoalignment data within Delta go to DeltaGUI: View > Preferences > Startup_File
Load:
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In the Merge Permanent AutoAlignment section:

· Select Enable

· Select the autoalignment system being used (e.g. Scalable Display Manager  or MPCDI ).

· Select whether you want to use Auto Warp, Auto Blends and Black Level options (as available to
your autoalignment system type: Black Level is currently only available with Dome Projection and
MPCDI systems).

· Click OK to accept changes: Delta will import and use the data.

· Delta automatically applies warp, blend and black (as available) when autoalignment is enabled.

Manual Geometry and Blend can be added as normal on top of any autoalignment data.

Scalable Display Manager

Please consult the Scalable Display Manager User Manual for full details. This is our summary
procedure for use with Dome display in Delta.

Scalable Technologies has a range of YouTube video introductions, beginning here: How to align
multiple projectors with Scalable Display Manager 8.0 - Quick Setup Guide.

Follow these steps in sequence to create the autoalignment calibration data that Delta requires from
Scalable Display Manager.

217 225

https://www.youtube.com/watch?v=N1Q-GIxv7uU
https://www.youtube.com/watch?v=N1Q-GIxv7uU
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First check (bottom left of the Display Manager screen) that the camera is
connected.

1. Display Clients Tab

Select Use Remote Display Clients, then find and connect to every display client server.

Assign the IP address of the Delta server to the right-hand column. If it does not appear, try restarting
the SDT Display Client on the host PC. This can be found in the Start Menu.

2. Projectors Tab

This may take a few seconds to load, and shows what is connected to the Display Client. Make sure
the correct number of projectors appear and at the correct resolution. If you set a specific Matrix
Mode array in Delta, you should have the same configuration here.

· It is important to disable any unused displays here.

· It is best to make this configuration match your DeltaServer desktop configuration. If it is not
automatically correct, use the custom resolution option and number of rows and columns to
make sure the layout matches Delta.
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Click ‘Next’.

3. Cameras Tab

· You are probably using a single camera, so make sure the number of cameras is set to 1, and set
the type to ‘Automatic’.

· Position the camera normal to the pole of the dome (see Preparation  ), and make sure the
entire screen image is in view and is not over-saturated. 

o The orientation of the base of the camera will determine where North (0 degrees) is.

o The centre axis of the lens will determine where the pole is.

· Use the ‘Show Pattern’ button to put up sample grids to help ensure all the spots are visible.

· ‘Auto-Tune’ can be used for correct exposure, and is often necessary for large displays. It’s worth
trying without first, as the process is quite robust. If you can get away with the default short
exposure time, the alignment can be a lot quicker.

· If setting the camera manually, you could use a 2 s exposure with an aperture of f/7.1 and ISO of
100.

· Project a pattern or static image that has contrasting edges to facilitate focusing, and take a
picture with the camera in auto shot and auto focus mode.

· Clear the image and switch the camera to manual shot and manual focus mode.

214



220

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

4. Collect Data

Check the camera has not gone into sleep mode and press Begin
Data Collection.

The Scalable software will project a series of calibration images:

White

Used to see the area of a channel, and to auto detect the image
boundary.

5 square dots

Used to determine orientation and location of a channel.
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Grid pattern

Used to measure the screen geometry of the channel.

No more images will be taken by the camera unless a new data collection process is required.

When data collection is complete, click ‘Next’.

5. Screens Tab

Dome
The Dome screen type. There is no need to change any of the settings so leave them at their
defaults of 10 and 90.

All other types
Select the screen shape you have and enter the appropriate metrics for the screen:
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If you make changes, click ‘Update Calibration’.

Click ‘Next’.

6. Image Boundary Tab

Dome
It is not necessary to set boundary points here, although you have the option to if necessary.
Otherwise use auto detection, and check that the displayed image covers the desired area.

All other modes
Set boundary points of the screen here.

Click ‘Next’.

7. Update Calibration

Modify the previously collected data with the new parameters by
pressing Update Calibration. You will now need to make an adjustment
to perspective that will not affect the calibration.
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8. Perspective Tab

In the Frusta Settings > Advanced Setting area, towards the bottom of the panel:

· select ‘Make Frusta per’ Projector.

In Eye-Point Settings:

· set the up/down eye-point number. This is a representational number for the depth of the dome
(= radius, for a full hemisphere) with a default of 10. This should match the screen radius setting
in Delta, dome display configuration.

· set the Pitch value. The Scalable default views the dome as in front. For an overhead dome,
rotate the pitch up by -90 degrees.
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The pitch rotation could be set within Delta rather than Scalable but to avoid confusion, it is
better to have the display represented correctly within DeltaGUI.

Click ‘Complete Perspective Calibration’, and then ‘Finish’.

Once the final calibrated image is shown, clear the dome of images. Either
click ‘Hide Display Clients’ in the Management tab, or close the Scalable
Display Manager.

Note: The image shown as the final image onscreen by Scalable Display Manager may look as
though it does not fill the entire screen. This is normal—it can still be fine within Delta.

8. Calibration or Recalibration?

The Scalable Display Manager alignment data apply to the relationship between the projectors and
the dome. If the projectors have not moved and the camera position is unchanged, then changing
input parameters only requires an update. If any projector has been moved, a full recalibration based
on new camera images will be required.

Recalibration can also be run from the Scalable Display desktop icon.

Import Autoalignment Data into Delta

The ‘Refresh AutoAlign’ button is available in either Flatplane or Dome Mode when autoalignment is
enabled in the configuration startup preferences. Click it at any time to re-import the Scalable Display
autoalignment calibration data. 
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The Scalable autoalignment data can be copied from C:\Program Files\Scalable
Display\DEI\LocalCalibration into the C:\AutoAlignment\Scalable Display folder to be used on startup:
click ‘AutoAlign Use as Primary’. Whenever there is alignment data in this folder, it will be used in
preference to new Display Manager calibration data.

In Dome Mode, small changes to the Delta Radius number will allow you to finely adjust the position
of the dome spring line.

Using MPCDI Data

One of the methods Delta can incorporate is MPCDI (Multiple Projection Common Data Interchange
v.2, 2013). It is a common standard for exchange of channel blends and warps and projector
positional data as defined by VESA (see VESA Standards) and can be used to import autoalignment
data from VIOSO systems.

MPCDI files are stored in the standard folder for Delta: C:\AutoAlignment\MPCDI.

https://vesa.org/vesa-standards/
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If you are receiving data from a third party source, check if the folder is zipped, and extract, or copy to
this folder. The size of these files and the corresponding load that they add is a function of their
resolution.

Note the file-naming standard, using the prefixes AlphaMap~ for the blend images, and
GeometryWarpFile~ for the warps. The matching suffixes after a hyphen (in this example, g-1 to g-4)
is what you will see in DeltaGUI. These are the MPCDI regions (Delta: channels). You need to know
how these regions correspond to your Delta channel numbers so that you can match them up.

Configure Delta to Use MPCDI

Enable MPCDI and check the required/available data, in DeltaGUI > Preferences > Startup & File Load:
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In DeltaGUI > Display >Dome Mode, you may need to click the Refresh Autoalign button. If at the top of
the main window you see ‘Autoalign Active - Error reading files’, make sure you have enabled the right
selections and that all MPCDI files are present. You should then see the MPCDI Region Names listed
in the dropdown menu:

Assign your output channels to MPCDI regions by selecting in turn the Delta output channel (top left),
then the MPCDI region (bottom right). You should see the channels come live in Channel View in the
colour of the channel:
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Display Configuration: Mesh Mode

Mesh Mode is a Delta Licence option intended for projection onto complex objects or
surfaces. This practice is commonly referred to as ‘Projection Mapping’. Really, Mesh
Mode could be utilized for even the simplest of traditional applications (e.g. a single
projector pointed straight on to a flat projection screen), but most users would feel it

introduces unnecessary complexity in applications where our Flat Plane mode plus 2D warp and
blend tools can handle the job more simply.

DeltaServer uses a ‘model-first’ approach to projection mapping, meaning a 3D model (or ‘mesh’)
representing the projection surface is prepared in advance, and then imported into DeltaServer for
media texturing and projector alignment. This is opposed to a ‘projection-first’ or drawn-on-site
workflow used by some other tools (generally more VJ-type ‘rock up and do something neat’ tools).
The 3D model is generally instrumental to the media creation phase of a project as well, which often
happens months in advance of going to the site. So, depending on whether the physical surface
already exists yet in the world (e.g. a historical building) or not (e.g. some new sculpture that isn’t built
yet), the initial model may be software-originated or produced by laser-scanning. Often with a
software-originated model, a laser scan is performed once the physical object does exist, and the
planning model is then corrected against the laser scan ‘point cloud’ result by overlaying it in the
modelling software.

This guide will take you through the process of matching your mesh model and media to the real life
environment. The two major stages of projection mapping in DeltaServer are:

1. texturing content onto your 3D model in the virtual world

2. resolving alignment of the real world projectors relative to the model.

Projection and Textured Modes Explained

Projection Mode

Projection Mapping is the art of using projectors to paint media onto complex surfaces. Most
projector lenses are designed for tangential mapping, meaning that when a projector’s light source
produces an array of pixels and passes that through, the lens is designed to produce a uniformly lit,
uniformly focused rectangle of light on a flat plane surface. Success depends on the projector being
pointed square at the surface, and the surface reflecting the light uniformly back to the viewer’s eyes.
The key challenges of projection mapping are therefore dealing with geometry and luminance (the
intensity of light reflected/emitted from a surface), compensation or compromise, when projecting
onto non-planar objects with varied surface properties, generally from multiple blended projectors
shooting from disparate angles, and often in environments where viewer position varies greatly.

All these factors should be considered in planning a projection mapping. Simple, right? Tools like
DeltaServer hide much of the challenge by predicting geometry and light behaviour in a 3D space.
The resulting image relies on a sensitive static relationship between projectors and surface, so care
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should be taken in installing the projectors in relation to the target, in a stable manner that will change
as little as possible in the future. Any changes will result in the need for alignment adjustment.

The 3D Object/Surface

Geometry and light predictions are accomplished by
placing a virtual camera representing each real
world projector in the software’s 3D space, whose X,
Y, Z, heading, pitch, roll and lens characteristics
closely match that of the real world projector lens.
So long as the geometry of the 3D model accurately
matches that of the real world object, you will
accomplish an accurate reflection of that camera’s
view of the textured software model back onto the
real world object.

Texturing the model means defining how 2D
content will be applied to a 3D mesh of faces. 
DeltaServer supports both explicit UV maps (a list
embedded in the .obj model file, defining
relationships between 2D canvas x,y percent
positions to 3D points on the model), as well as
eyepoint-based virtual projection.

The 3D Model

A 3D model is a system of co-ordinates (‘nodes’ or
‘vertices’) joined in a mesh. The co-ordinates take
as their reference a zero-point (or origin) within (or
outside) the model of the reference object. The
model can be rotated and viewed from any angle,
but when used for projection mapping, the designer
will take a chosen viewpoint (or eyepoint) that
‘projects’ an orientation from which the object will
be viewed.
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The 2D Media

Because the designer’s reference point is the origin
of the model, the media effectively represents what
the origin of the model would see in a mirror. For
better and sharper results, the media can be
displayed over several projectors, and it may be
better to split a complex mesh model into more
manageable pieces for those projectors, but
projection mode still assumes that the designer and
viewer are both looking at the media-painted object
from the same view of the model. 

Textured Mode

The 3D Object/Surface

Just as the 3D model can be rotated and viewed
from any angle, so the viewer can either move
around the model, or the object can be rotated, and
the media will ‘stick to’ and move precisely with the
object.

Here is a demonstration model of a totem head with
easy-to-identify surfaces.

The 3D Model

The 3D model is constructed in the same way, but
its entire external surface is notionally ‘peeled off’ or
unfolded onto a flat surface. This surface is
‘painted’ by the designer to create specially
rendered 2D media. Whilst the object and model are
described in X × Y × Z axes, the surface is described
in the 2D U × V axes, hence UV-rendered or mapped
media.
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In this illustration a simple cube demonstrates the
theory of what can be actually a more complex
mapping, as in the ‘totem head’ example used here.

The 2D UV-Mapped Media

For the designer, all viewpoints now are
perpendicular to the model/object surface, rather
than, say an oblique view of the side of a cube. In
textured mode, the characteristics of the mesh
model surface are ‘baked’ into the flat media, which
is then folded back onto the model in the projection.

Compare this UV-mapped media frame with the one
used above for projection mode. The top row of
faces are projected on the other side of the object,
either by rotating the object into projector view, or
by providing all-round channel coverage.

The reason this media does not look simply
unfolded as in the cube above, is that this would
create a lot of empty space in every frame. Instead,
the elements are packed into the 2D space, with
mapped coordinates that are used to place them on
the target object or canvas.

This is how the UV media looks in the Playback
Window when ‘folded’ or positioned back onto the
model, as seen from a single channel. The yellow
lines show the model origin (X,Y,Z = 0,0,0); red,
green and blue are the X, Y, Z axes.
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Mesh Mode Setup

How Mesh Mode works

In mesh mode generally, there are a number of key elements:

· Representing a real-world object as a 3D mesh of points (saved in a .obj file).

· For projection mode situations, designing flat media with a defined eyepoint.

· For texture mode situations,‘ unwrapping’ the 3D mesh model onto a 2D UV surface, and mapping
the media onto it.

· Calibrating the virtual positioning of projectors in Delta, to their precise real-world positions.

· Using DeltaGUI to relate the software mesh model in the server, back to the real world object and
projector positions.

· Using DeltaGUI to apply warping and blending for seamless joins and perfect fit.

Flat Projection Mode

Here is an example of a theatre for display in mesh mode, with a 3D canvas and two offset projectors:
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This test model features flat and curved surfaces, detail in the 7thSense logo, and a face with a highly
detailed mesh, in front. Whilst the projectors are pitched down, the design eyepoint (red and green
axis planes) is horizontal. Here is how each virtual projector in DeltaGUI will see the canvas (in this
case a 3D object), and note that they may see surfaces the viewer is not designed to see, or even for
which there is no media coverage (Playback window, media disabled, grid displayed at 100%):

· In Delta, we must set up the render camera eyepoint of non-UV media, as defined in the media.
This we do know exactly.

· We also need to know the projector locations for pitch, heading and field of view – but we can’t
know these exactly.

· By giving Delta enough reference points from the .obj file, placed in real space, Delta can work out
how to warp the flat media from any angle, into exact position.

Already we can see that projecting non-UV-mapped media onto very oblique faces may reduce
sharpness, and in this model it may even be better to have a separate mesh for the face on the front,
with a separate head-on projector to avoid shadows. Delta can handle up to 16 meshes per show, and
32 channels.

Textured (UV-mapped) Mode

The theatre setup may be the same as above, but the UV-mapped media will be wrapped to the
surface exactly the same way as the .obj model grid shown. Alignment is much easier, though the
media construction is more complex.

Mesh Setup Basic Sequence

Assumptions

· You have a theatre set up with projectors and display canvas / objects.
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· You have .obj mesh files that cover every part of your display.

· You have media that is either for flat projection, or is UV-mapped to the mesh, for textured mode.

Sequence in DeltaGUI

1. Check your canvas size and render settings :  Display > Mesh Mode > Mesh Canvas 

2. Set your active channels : Display > Mesh Mode > Channel, and

3. use the Defaults Wizard to distribute your virtual projectors.

4. Add your mesh files : Display > Mesh Mode > Mesh > Mesh Files 

5. Set your parameters for each required eyepoint (not required for UV-mapped media in textured
mode) : Display > Mesh Mode > Mesh > Eyepoint Files > Eyepoint Details + Parameters (see
Setting an Eyepoint in Delta ), and

6. assign eyepoints to the meshes where they are to be used.

7. Set your eyepoint mode to ‘Use Texture Coordinates’ (not required for flat media in projected
mode) : Display > Mesh Mode > Mesh > Eyepoint Files > Eyepoint Details 

8. Use 3D Projector Calibration  with any timeline media disabled and full grid display on, for
each channel to select and align each required mesh, with the projectors and real-life canvas.
For this stage, keep all channels active, but turn beams off except for the channel being aligned.

9. Apply (or enable) timeline media and view for where correction and adjustment is needed.

10. Edit the mesh , apply channel distortion, or media warps to correct for real-life canvas, and
minor .obj or media errors.

Setting an Eyepoint in Delta

Eyepoints are always associated with meshes. UV-mapped media for textured mode effectively has
an infinite number of eyepoints, but for projected mode, there will always be one precise eyepoint in
the media. If you are not using UV-mapped media in textured mode, then you must obtain the
eyepoint data from the content creator, or from within the media (e.g. Cinema 4D).
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In Channel or Interactive view, click Eyepoint to view the Eyepoint
parameters. Using the small L button, make sure the field of view (FOV)
parameters are displayed as Left / Right / Top / Bottom (rather than lens
aspect and zoom). Each set of parameters is just a translation of the other,
but for translating render camera data from Cinema 4D, we need this view.

Enter the eyepoint data, as translated from C4D render camera details:

DeltaGUI eyepoint Cinema 4D FOV

Left (negative) of horizontal FOV × 0.5

Right (positive) of horizontal FOV × 0.5

Top (positive) of vertical FOV × 0.5

Bottom (negative) of vertical FOV × 0.5

Heading (negative) of C4D value

Pitch (positive) of C4D value

Roll (positive) of C4D value (most likely 0)

X (positive) of C4D

Y (positive) of C4D

Z (negative) ofC4D focal length

DeltaGUI Mesh Mode Controls

With DeltaServer running and the Playback Window in full screen, select Mesh mode in DeltaGUI.
Choose your required 2D or 3D media mode from the Mesh Mode drop-down:
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There are three control panels here:

Channel Panel: Setting up your Projectors

Here you set the projector positions as in any mode. The process of calibration will automatically
make fine adjustment to these.

As for any mode, select the active channels you will be using, with the small ‘C’ button.

Note the two places where channel beams can be switched on and off: in the foot of the channels
panel (click the colours), and bottom right in the DeltaGUI status bar. You will need to switch beams
off for calibrating individual channels. Do not deactivate channels for this operation.

The defaults wizard dialog behaves the same as Dome Mode, but be aware you are typically
arranging channels around an object at a centre, so use Projectors Outside Screen. Note that ‘Include
Cap’ is not relevant to this mode.
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Channel Size
Select from the two options. Use Existing Size (if the display model is the same as previous
show) or Force Size and type in the settings according to the design guidelines.

Channels Used
Select the number of channels (projectors) in ‘Force n Channels’, or ‘Use Existing Channels’ if
active channels already set up.

Screen
Set screen radius here if using ‘Projectors at Screen Edge’ in channel arrangement, or Use
Existing Screen if using ‘Projectors outside Screen’.

Spacing
If set to Calculate, projectors will be assumed to be all-round, in equal divisions of 360°.
Changes to each projection can then be adjusted accordingly at a later stage.

Channel Arrangement
For Projectors at Screen Edge set a screen radius above; for Projectors outside Screen set a
radius here.

At Radius
This is the visualised distance from the object origin.
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Mesh Canvas Panel

Canvas Size
Your dimensions here for projected (not textured) mode will be defined by the media.

Render Size
This is for tuning performance by reducing resolution to decrease the load on the graphics card.
(Preserve the aspect ratio.)

Active Render
This is the location of the render on the overall canvas.

Mesh Panel

Here, you have five different views:

· Channel: shows the view of the mesh surface covered by (as ‘seen’ by) a single channel i the GUI.
It is here (or Interactive view) that you set a fixed eyepoint.

· Interactive: allows the whole model, axes and projector frustums (yellow lines) to be rotated and
viewed in the playback window:

· 3D Projector Calibration : place the mesh vertices on the actual canvas points

· Mesh Editor : alter the mesh by overlaying adjustments

· Movement Nodes : synchronise media movements between eyepoints and between meshes.
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For projection mode (not textured) you must know the design eyepoint for the media, for each
channel.

Mesh Dimensions

3D models are ‘ideal’, and even if used as the basis for constructing the actual real-world object (our
canvas) there will be differences. DeltaGUI provides for all reasonable adjustments, but the mesh
model must be accurate and to scale. Beyond this, the mesh itself may require editing.

· First of all, the eyepoint of the designer/viewer must be related to the origin (X, Y, Z = 0, 0, 0) of
the mesh model.

Typically left as 0, 0, 0, you can reposition the object away from its inherent origin if necessary.

· If there is a difference in the scale of the model and the actual object, this must be adjusted.

Set to 1.0 by default. You can adjust the size of the model if the object dimensions are not fully to
scale, but of course the projector locations may then have to be altered to account for the new
object size.

· If there is any difference in heading, pitch or roll of the actual object from that expected by the
projected media, these too can be adjusted.

Heading, Pitch and Roll values are in degrees. The 3D object may come in rotated about the
wrong axis, so you can correct this here.

Mesh (.obj file) Selection

For DeltaGUI and DeltaServer to work together, each mesh .obj file must be on both the DeltaGUI
PC and the server, in C:\meshes. When you assign a mesh in DeltaGUI, a copy of the server mesh
will be synced to the DeltaGUI PC. Their filenames must stay the same in both locations.

In Channel view, select both mesh and eyepoint for each channel:
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Double-click an ID line to add or to remove a mesh from a channel. You can apply multiple meshes
per channel, up to 16 per show.

Note in this illustration that meshes synched from other servers have been acquired in folders with
those servers’ IP addresses.

Visible
A mesh can be assigned but only be visible in the GUI, not playback, by selecting No.

Project on Mesh
If you do not want media to appear, but you still want to be able to see and illuminate the object
with the grid off, a mesh can be rendered in greyscale.
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Eyepoint Selection

In this example (not a textured mode example), it is assumed that this eyepoint will apply to all
meshes in all channels. Each mesh can have a different viewpoint or more than one viewpoint.
Different meshes can share the same viewpoint. Eyepoints are available to all, or selected channels
only.

Using texture coordinates with UV-mapped media means that the model, grid, media and object can
all be aligned in one calibration operation.

Eyepoints can also be assigned to media by right-clicking the resource on the timeline:
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Enabled:
Enable or disable this eyepoint. Disabling will hide related meshes.

Use Texture Coordinates:
Enable this if the .obj file contains texture coordinates, if you enable this and the model has no
texture coordinates, nothing will show on this mesh. Disable this, and the flat plane canvas will
be projected from an eyepoint configured in the GUI. 

Use Depth:
Enable (default) to have occlusion between meshes, disable and the meshes will not occlude
against each other (determined by the order shown in the mesh files dialog).

Orthographic:
Choose this to have an orthographic (non-lens based) eyepoint, note this only applies to a
Projected (non-textured) eyepoint.

Enabled Meshes:
Choose the meshes related to this eyepoint.

Enabled Output channels:
Choose which output display channels will render this eyepoint.

3D Projector Calibration

Now that the physical projectors are set up correctly for the media and model eyepoint, the model
can be calibrated to the real-life object or canvas. This is done by projecting the mesh using the grid,
with its edges and vertices, rather than the media, onto the object. Each channel is calibrated
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separately. The media is the same, the mesh is the same, and Delta does all the maths required to
adjust for each projector position.

Per Channel Setup

With the Playback Window in full-screen mode, and DeltaGUI in Display > Mesh, with the mesh files
set up as above, turn the grid on to 100%. (Grid size: the spacing of the .obj mesh depends on the file
itself.) The grid will not show until a channel is calibrated.

If any warps or blends are on the timeline, you will see a red warning, and a checkbox to disable them.
This is because the undistorted mesh should normally be added to the real-world canvas, and any
warps and blends applied to the media once calibration is complete.

However, since the 3D Calibration process can interpret radial lens distortion from the resulting
calibration points, this can now be automatically retrospectively applied to a timeline background flat
geometry, for that channel. This can be further warped manually.

· Turn the beams off all but the channel you are calibrating.

· In the Mesh panel, select 3D Projector Calibration view, click the left triangle button (changes
from grey to blue) to select ‘Use 3D Calibration’, and select or ensure your reference mesh (.obj
file) for this channel is correctly showing.

· Enter an estimated projector distance for this channel.

· Select Lens Mode.

Lens Mode

Current is the preferred setting for Delta 2.6 users, and further improves reliability. For users
upgrading from Delta 2.5 to 2.6, calibrations previously made in Manual lens mode will appear as
‘Legacy_1’, and those made in Default lens mode, as ‘Legacy_2’. These two modes can continue to
be used to modify the calibrations. For Legacy_1 and Legacy_2, see the Delta 2.5 User Guide.

http://portal.7thsense.one/user-guides/M114-delta2_5-user-guide/mesh_3d_projector_calibration.html
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2D/3D View

This is the button you will use to toggle between selecting a vertex from the model and placing it
precisely on the object. 2D view is looking at the model from the projector position, 3D shows the
reference mesh object.

In this playback window view, channel 1 (left) has ‘Show all 2D points’ applied. Channel 2 (right) is the
playback view when selecting an object node in DeltaGUI in ‘3D View’.
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Calibration Points

Calibration requires at least 6 distinctive and distributed reference points (mesh vertices) to be
accurately positioned, using DeltaGUI, on the object. Delta will infer the relative position of all other
vertices, which is why a good 3-dimensional spread of calibration points is needed. Delta will then
automatically calculate the mapping of the whole .obj mesh onto the object. This initial calibration
may be sufficient, but further reference points can be selected and adjusted thereafter.

In 2D view, position the mesh model (this may be out of view, but the RESET button will recentre it).
Manipulation of the model using the mouse buttons is the same as shown in Interactive view (shown
right). This takes practice, but will be useful in being able to quickly rotate the model for a clear view
of the vertices you want to use (rather than a node right behind it).

Mouse controls:

· Left-click + drag : pan and tilt the whole mesh

· Right-click + drag : shift the whole mesh

· Centre-click + drag : zoom

· Shift+left + drag : spin the mesh around a set point in 3D space

Hint: in Mesh Editor view , you can change the size of the dots marking vertices with Node Size .
The movement of the mouse can also be adjusted, to control the responsiveness of the mesh
image.

267



247

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

When a node point is found, the dot is grey. When a vertex is selected, it is red. When it has been set,
it shows green. 
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Select a vertex, and switch to 3D view. Now look at the object/canvas and just move the mouse (no
buttons) to drag the white cross-hairs in a red box, over the same point in the object:

Press Ctrl + left-click to register this point, and the lines will turn green. This point will now be listed in
DeltaGUI with its 3D XYZ model coordinates and 2D channel-frustum location. The mouse position
need only be approximate: after registering the point, you can nudge it into more exact position with
Ctrl + arrows or Ctrl+Shift+arrows (fine control). You can choose later not to use it, if for some reason
it is not being useful, or you can readjust it by selecting from the list in 3D mode (it will be shown on
the object) and nudging it again.
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When you have 6 registered points, DeltaGUI will calculate the whole mesh, and the whole grid will be
displayed on the object. It should be a reasonably good fit. There are two obvious points here that can
be selected to improve the result:
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Now look around the other side, which will be covered by the second projector, and we see that it
might be better not to include part of the mesh here at all:

We can calibrate the second projector now, and return to the mesh editor  later to tidy up, and to
hide or fade these faces per channel. 

267
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Here is one completed channel in DeltaGUI:

Editing Calibration Points

To adjust any point, select it in the list (make sure you don’t deselect it in the checkbox) in 3D mode,
and it will show a red box around the vertex on the object. Nudge it into a better position with
Ctrl+arrows or Ctrl+Shift+arrows (fine control).

Clear: If you want to start over, click ‘Clear’.

: Delete a selected point only.
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Add Manually: If you have precise calibration points available from tracking software such as
BlackTrax, these can be added manually:

Viewing the Result

Now take the grid display off, and go back to DeltaGUI > Layers and add or enable your media in the
Timeline, and your media should fit the object. UV-mapped media is baked into the .obj model, but
flat-projected media may take additional adjustment for a perfect fit.
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Warping a Mesh

It may be useful to warp the mesh as a whole, rather than manipulating the mesh .obj or the canvas,
especially if it just involves regular or geometric deformation. Timeline media warps are normally
disabled during calibration, but can be added and adjusted afterwards.

From Delta 2.6.48

The warp must be applied to the background layer, and can be applied to a channel or to a mesh.
Multiple background warps can be applied to separate meshes and channels. (Selecting the type
changes the number selector descriptor.)
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Earlier versions: Delta 2.6.1 to 2.6.47

The warp must be applied to the background layer, and not the media channel but the respective
mesh. Delta will allow one or two meshes to have background warps applied:

· to apply a warp to the first mesh (ID=1), assign it to channel 17

· to apply a warp to the second mesh (ID=2), assign it to channel 18

Note: these are not ‘active’ channels.
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Blending in Mesh Mode

In mesh mode, flat blends offer an additional choice. The Resource Editor for flat blends placed on the
timeline (background layer) have this additional tab of settings:

Blend Target

In projected mode, the blend can be restricted to not only channel (also in the Timeline tab) but
particular eyepoints, and with the choice of where it applies. ‘Channel’ will apply it as normal to the
periphery of the projector frustum, ‘Source Texture’ will apply it to the periphery of the media frame.

In textured mode the blend target should be ‘Channel’.

Enable target mesh(es) and Eyepoint(s) as required.

This is similar to being able to warp the canvas, or to apply warps to media.

Troubleshooting Projection Mode

Fitting the Mesh

If, having positioned six calibration points, the whole projected grid is very wrong, this could be either
due to poor distribution of points or a mistaken vertex between the mesh and real life (perhaps
behind the one you think it is). 

· Try switching off individual calibration points in case one in particular is bad.
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· Try adding one further point, perhaps where the projected grid is most out of position.

· Check the Lens Modes in the 3D Projector Calibration panel. Are you using the recommended
defaults? Try unchecking and checking Fixed Aspect, Zero Tangential, and K6, K5, K4 for best
improvement.

· Discrepancies between the mesh and the real life surface can also be corrected for by editing
points on the mesh .

Fitting the Media

Delta works out how the projectors fit the model to reality. If the media designer has worked from the
same model and scale, and rendered it correctly, and you have compensated for irregularities in the
real-life canvas, then the single crucial error may be setting the eyepoint position in Delta, so check
this carefully first.

· If the eyepoint is correct, some warping of the canvas may be appropriate. Add a flat geometry to
the background layer, assign the channel in the Resource Editor, and use channel point distortion
warp (see this section under Display Configuration, in the Delta User Guide).

· If the overall correction required seems geometric, try warping the mesh as a whole (see Warping
in Mesh Mode ).

· If the mesh and media correspond and the required adjustment is small, then the media can also
be surface warped into a better fit. Place a flat geometry on the timeline in the same layer as your
media. Go to Warp and ease the media into place. Remember that Surface Warp has two
different interpolation methods. Spline method moves points in smooth arcs, warping a greater
area than the linear method, which moves the point(s) in straight lines, within its own area,
without affecting the rest of the image. The H+, H-, V+ and V- buttons increase the grid density
(click then ‘Apply’ or Enter), which affects the area of warping.

267
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For more guidance on surface warp, see this section under Display Configuration, in the Delta
User Guide.

Mesh is Clipped or not Showing on Playback

If on playback (projected, displayed or in the Playback window) you either cannot see all your mesh,
or cannot see it at all, it could be out of range of the DeltaServer clipping plane settings. This could
occur for very large or distant meshes, which you would not notice in DeltaGUI whose clipping planes
are separate.

The DeltaServer far clipping plane is held in a Registry key and can be adjusted.
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Registry Edits

7thSense software uses the Windows Registry extensively, and on occasion we make
recommendations for changes.

· Before making any changes, close DeltaGUI and DeltaServer.

· DeltaServer can take up to 10 seconds to fully close in the background, even if it appears that
all the Windows have closed. Ensure that Delta has fully closed before opening and/or
refreshing, and finally editing. The best way to ensure this, is to watch Windows Task Manager
> Details list. You will see ‘DeltaServer.exe’ in this list if DeltaServer is still running. If it won’t
close for any reason, you can right click on it in the list and choose ‘End Process Tree’.

· Make a note of any setting before you change it, in case you want to change it back.

· Only make the changes as recommended and only to those registry keys.

Go to Windows search > regedit >
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\7thSense\Delta\Graphics and find FarClip. The
default is 10000 and can be increased as required.

Note that the far clip should be set to just beyond the model limits to preserve rendering precision in
the 0 – FarClip range.
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Working in Textured Mode

Working in textured mode is little different, but since there is no single eyepoint, parameters need not
be added. When assigning an eyepoint for each channel in Display > Mesh Mode > Mesh > Eyepoint
Files > Eyepoint Details, make sure you are using texture coordinates:
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Multiple Meshes and Media

Delta can manage up to 32 meshes (16 prior to version 2.6.48). Since in mesh mode, media can be
associated with specific eyepoints, and eyepoints can be associated with specific meshes, we can
have simultaneous media on a timeline, to be projected onto separate objects using their own
meshes. Here we have two images, and have assigned them to different eyepoints by disabling all
others:

Here we have two meshes, for a tube and a cube, set up in DeltaGUI, with different eyepoints
assigned to them:
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Here in Playback we have media 1, associated with eyepoint 1,which is associated with mesh 1 (the
cube), and media 2, associated with eyepoint 2, which is associated with mesh 2 (the tube):
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Note that the media eyepoints are using textured coordinates.

Active 3D Mesh Mode

In Active 3D for mesh mode, two copies of a mesh, each with respective left or right eyepoint, are
required.

Paired left- and right-eye media are played to separate channels (e.g. 1, 3, 5 and 7 for the left eye, and
2, 4, 6 and 8 for the right eye). By linking eyes, the same warp and blend is applied to both left eye
(odd number) and right eye (even number) channels. Mesh files and their eyepoints are assigned to
the respective left and right eye media running on the timeline.

Here is the workflow to achieve this.

In DeltaGUI, Display workspace (1), select Mesh mode and 3D Active (2). Link Eyes (3) to link any
warp and blends applied to left-eye channels also to right-eye channels.

Mesh Files

Now add the left and right mesh files of your model or surface.
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Click on the Files button (4) and in the new dialog, double-click on the first ID row. Use the browse
button to locate the left-eye mesh file you want to use. Do the same for row 2 to add the right-eye
mesh file.

Click ‘OK’ to close the dialog.

Eyepoints

Select ‘Eyepoints’ below ‘Mesh’, and then the ‘Files’ button again (as marked (4) above).

Double-click the row for eyepoint 1 (left mesh), and in the new dialog (below), ‘Clear All’ meshes, and
enable just mesh 1. Then under ‘Enable Output Channels’, click ‘Clear All ’ and check just the odd
numbered channels n the required range (in the example, for an 8-channel, 4-pair setup):
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Click ‘OK’ to close, and this time select eyepoint row 2. Select only mesh 2 and apply only the even
numbered channels in the required range:

For the left eye media on the timeline, double click to open the resource editor, select the ‘Mesh’ tab,
clear all eyepoints and enable only eyepoint 1:
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For the right eye media, open the resource editor, clear all eyepoints and enable only eyepoint 2:
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Editing a Mesh

The Mesh Editor allows you to manipulate the mesh as a whole, per channel, by vertex or group of
vertices, with control over the editing view. The X, Y, Z axes throughout are those based on the .obj
model’s origin.

Even if you are not editing points, the mesh editor has settings for moving the mesh around in the
GUI, with slider controls for Node Size and Mouse movement size.
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Movement Plane

Select which 2D plane (axis pair) in which you want to move selected vertices, in the overall 3D
space.

Movement Size
The Vertex slider controls sensitivity of selected vertex movement, using Ctrl+arrows. The
Mouse slider controls the speed at which the mouse drags the mesh around in the GUI.
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Drawing Mode

These options enable you to see the entire mesh, or focus on the foreground only. The result
will depend in part on the way the mesh has been constructed.

Movement: World or Per Channel
Choose whether you want to manipulate the mesh for a particular channel only, or for all
channels (World view). Per channel is generally best for small adjustments, and World if there is
a significant error in the media across the whole object. These edits are overlaid on the .obj
mesh and will be saved as separate .vto files. The Disable buttons switch the adjustment
overlays off and on without resetting the model.

Selection Mode

Vertices can be selected either to reposition them, or to change their visibility (as in the oblique
faces of our object example above). Select a single vertex to move it, or a group of vertices, or
where a set of linked vertices has been constructed in the .obj file, select the group.

The group selection area finds all vertices within an XY window as seen from the current
viewpoint in the GUI, not relative to the size of the obj mesh. The size of this window can be
controlled by the size slider. Click the lock button for separate X and Y axis sizes. Selection
includes all vertices in this rectangle, in all planes. Add more vertices to the group selection with
Ctrl+left click. Near or far vertices can be excluded by working in a clipping plane (see below).
For multiple selection of individual vertices, use a very small group area.

In this example: red points are a selected group with equal XY selection. Green shows the
mouse hovering over another group with a limited X axis and mid-range Y (see settings on the
right).
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Moving points: Once selected, all red nodes can be moved around en bloc using Ctrl+arrows.
For finer movement, use Ctrl+Shift+arrows. Movement is along the X, Y, Z axes of the .obj file,
based on the object origin. Selected vertices or the whole model can be reset using the Reset
buttons (bottom right).

Moving nodes around

Whenever groups of connected nodes are moved, this inevitably distorts the surrounding mesh.
A mesh that is not an accurate representation of the real world can, to some degree, be pulled
into position, but there are limits beyond which making one part fit makes another worse.

Vertex Groups

In complex models it is helpful to construct the .obj file out of groups of vertices where the
groups are not connected directly to each other: for example, the detailed face illustrated above
is separable. In these circumstances, the separable section of linked vertices can be selected
by use of the third mesh selector in Delta (the one with the blue dot): the ‘vertex group
selection’. The separable part can now be manipulated, to move it, or rotate it on any axis about
a selected point, or its median point.

In the illustration below, the face element from the front of the building has been selected with
a single click because it forms a vertex group, unconnected to the main building. Lateral
movement is as elsewhere using Ctrl+arrows, or Ctrl+Shift+arrows (finer) according to the
movement size set in the editor panel, and the selected movement plane axes.

Please note that depending on the complexity of the vertex group being manipulated, this can
be very demanding of DeltaGUI.
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Rotation is available, again in the selected movement plane axis, either about the central
rotation point, or a selected point (click the green button to switch this).

The vertex group can also be scaled about the same point, increasing or decreasing all vertex
separations proportionately. Here we can see that by selecting the X-Y movement plane,
rotation will be about the Z-axis:

These adjustments can be seen in the editing screen above.

What moves?
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If the mesh and media are texture-mapped, the media will follow the moved element, so the
media can be adjusted to a real-world object that does not quite match.

If the media is not texture-mapped (i.e. projection mode), then it will continue to be projected
in situ. This is not the same as warping the mesh.

Hiding points: There are two ways to affect the projected display of selected parts of the
media: Show/Hide and Black/Paint. Hiding a group removes all edges joined to the selected
vertices, and enclosed faces. Single vertex selection is not useful for hiding, but a single vertex
in a small group may be. In the example below, per channel selection has been made on the
oblique sides in channel 1 (left), to be filled exclusively by channel 2 (right). In the first Playback
Window illustration below, Hide removes faces from display, in the second, Black fades it out,
similar to blending.

Note how vertex selection has not included the vertical edges required by channel 1.

Compare this with adding a blend , and the need to preserve display on edges; a blend may
fade out more than you want. Blends are more suitable for textured mode.

256
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When mesh editing, Playback will show in blue-green colour, indicating that it is in low-
performance mode. Restore this by going back to channel mode.

Clipping Planes
These contain your view for selection, between Near and Far planes. Use the Fit button to set
the range to the size of your mesh, otherwise the mesh can be too small a part of the maximum
available range, and disappear from view. In this example, clipping planes have been used to
limit selection to points on the facing wall in the above illustration:

Save Meshes
You can save changes to the mesh simply by using File > Save As (and then Save to save
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further changes). This saves the original .obj file, together with .vto files containing adjustment
instructions. Every time the mesh is used for a show, these instructions will be applied. ‘World’
and ‘Per Channel’ change files are created separately.

To remove the changes, returning to the original mesh alone, simply reset in the GUI or delete
the .vto files here. If you have ‘Sync Mesh Files from Server’ ticked in the Mesh selection
screen, the files will also be copied over automatically to the GUI.

The mesh editor, however, also allows you to ‘bake’ the changes into either a new single
revised ‘world’ .obj file, or a new .obj per channel. Changes cannot be reset in a ‘baked’ file.

Reset Meshes
Note that resetting the whole model sets all vertices back to their original positions in their .obj
file. If you have loaded an .obj file that has associated .vto files, resetting the model removes
the .vto amendments from view, and if then saved, the .vto files are removed from the C:
\Meshes directory. If in doubt, and you want to compare before and after adjustments, use the
Disable button instead.
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Movement Nodes

Movement nodes add the capability to synchronise movement between meshes, media and
eyepoints using their names in Sequences (see Delta User Guide). By manipulating a parent node,
linked nodes will follow without separate programming. Examples include rotating images on car
wheels, growing and moving two eyes together, or bringing several meshes into view simultaneously.

The three controls are: create or delete nodes (third button), assign nodes to
eyepoints (first button), and assign nodes to meshes (middle button).

Creating a Movement Node

Node translations for each parameter can be set by the setnodeparams external control command,
or use the Node Parameter editor in Display Config > Mesh Mode > Movement Nodes and double click
on a node. There are six sequences of Translate (change XYZ coordinates), Rotate (HPR angles) and
Scale (XYZ relative dimensions), though not all three aspects may be needed.

· To synchronise multiple movement nodes, one must be a parent and the others assigned to it.

· Movement nodes are assigned to eyepoints and/or meshes.
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· Movement nodes can also be addressed by External Controls (see the Delta User Guide for how
to use these). For available commands in DeltaGUI, Click Help > External Controls and find
Movement Node Commands:

· Each parameter of the node (XYZ, HPR, XYZScale) can be set to act as any of the others – or be
ignored, so for example the X value used for a node can be taken from Z or even -Z, or the XScale
value can be set to be ignored:

· The values shown in the dialog are always the untranslated values, the translation happens
internally in the render stage.
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· This translation can be used to take care of axis differences between systems or to ignore certain
values from a datastream that are not interesting.

· Node values can be set by external control (using setnodeparams), ArtNet (via setnodeparams)
or NatNet tracking input.

Mesh Optical Tracking

For users of OptiTrack Motive systems for optical tracking, Delta can use Motive’s NatNet streaming
data over IP, linked to DeltaGUI’s Movement Nodes .

In OptiTrack Motive

Enable ‘Broadcast Frame Data’ in the OptiTrak Streaming Engine and connect the Motive source Data
Port with the Delta server as client over NatNet. For details on the streaming engine, see
https://v22.wiki.optitrack.com/index.php?title=Data_Streaming.

Output node 1 will be identified in Delta as movement node name: natnet_1
Output node 2 will be identified in Delta as movement node name: natnet_2 and so on.

In DeltaGUI

First, NatNet must be enabled in DeltaGUI > Preferences > Misc Settings:
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Connections can now be made to meshes and/or eyepoints, by creating and naming a movement
node for each:

The node(s) can then be synchronised with a mesh or an eyepoint, by making the NatNet node a
parent.

Example: take the mesh you want to connect the NatNet node to as parent, and double-click to edit it:
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Assign the NatNet node name as parent.

The XYZ-HPR and scale values of the NatNet node can now be taken by the mesh (or eyepoint).

Transformation Example

Node values be used directly, or in more complex scenarios, can be transformed, for example to
reverse orientation, invert, or convert roll to pitch. For example, here we want to take the orientation
of an active puck and transform its roll movement to change the heading of a car:
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Switches

This view provides control over beams, geometry and blending for all channels in all servers and an
overall summary of all the server’s display configurations.

By switching individual beams off, attention may better be given to a particular channel.

Switching geometry off affects not just display geometry (warp) but geometry applied to specific
resources on timelines.

Select from ‘Image’ to apply a test pattern to all channels in the server group.
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In the Information page, you can see each channel’s location and size for all servers in the group:
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Populating the Timeline

The first thing to appreciate before you begin, is that a ‘Resource on a timeline’ is not moving any
files anywhere. A Resource on a server’s timeline is merely a reference to a file or sequence of files
on the server’s disks, with a set of instructions or parameters to say how the media will be played
and displayed (how much, how fast, how long, when to start and stop, where, what colour etc.).

Start DeltaServer and DeltaGUI. At this point, there are no resources on the timeline (assuming there
was no default file set to load), and any resources found in the relevant folders are presented in the
Resources Area on the left.

Select the media type (in the example below, Images), and double click the image you want to add to
the timeline. The Add Resource dialog is displayed, so choose a name for this resource, which layer
and where along the timeline you want it to be placed.

After pressing OK on the Add Resource dialog, Layer 1 is shown, and the Resource Area shows you
the newly created resource on the Timeline.
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Warnings

There are various warnings if there is a problem with a resource. A movie file may be encrypted and
not match the playback licence (see Delta Content Protection System):

https://portal.7thsense.one/user-guides/MC256-managing-media/mm_delta_content_protection_syste.html
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Errors can be seen in three places, in the timeline, by examining the timeline resource, or by hovering
over the resource in the pool area.

Similarly, if there are missing frames in a movie (i.e. not in codec formats), this will be highlighted in
the timeline resource properties, and in the resource pool the resource will have a red frame (or in list
mode, the name will be in red type):

Interact with Resources on the Timeline

Media on the timeline can be moved along the timeline simply by left-clicking on it and dragging it
while the left mouse button is down. When moving your mouse over the media resource on the

timeline, the pointer changes to  to indicate that the resource can be moved left or right.

While moving, the resource is shown in yellow, and the start / stop positions on the timeline are
shown as you move.
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To change the length of the resource on the timeline, simply move the cursor over either end of the
resource on the timeline; the cursor changes to  to indicate that you can pull that end of the
resource. If the resource is very short on the timeline, you may not get the sizing cursor – simply
zoom in until the resource is large enough, or edit the resource properties (right click on the resource >
Properties ) and type in the start and stop frames / times.

To change which part of the timeline you are viewing, use the controls below:

If you can’t see enough of the resource, use the timeline controls to zoom in or out, and centre the
resource in the visible part of the timeline.
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Drag and Drop onto the Timeline

You can drag media from the resources area directly onto a layer, or drag it onto the blank canvas to
create a new layer. If a media resource is not immediately available, you can use a Placeholder
(Controls media type) to occupy the space and position, and replace it later when the media resource
is available. Alternatively, you can use a Movie or Image Placeholder resource, which is a dummy
resource rendered as a rectangle onscreen. Using the Replace Resource method (Ctrl+drag a
resource over the placeholder), you can then replace this placeholder at any time, maintaining
previously set parameters.
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Group Selection of Media (Rubber Banding)

In addition to dragging resources from the resource area to a layer, you can select or lasso multiple
resources with a rubber band (drag a marquee). See also: Copy Timeline .

If you wish to move several resources along the timeline, left click somewhere away from a resource
in the white area the rubber band to cover the resources (they turn green to indicate selected). Then
drag this group left or right along the timeline.

61
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Notes

· Hold Shift down while rubber-banding to add to or remove from the current selection group.

· You can rubber-band over the timeline controls area as well

· You can rubber-band over closed layers (selects all within the closed layer)

Once two or more resources are selected, you can use cut, copy, paste or delete on them:

Cut CTRL+X Cuts the selected resources from timeline, and stores in the Clipboard

Copy CTRL+C Copies the selected resources from timeline, and stores in the Clipboard

Paste CTRL+V Pastes the clipboard resources (if any) to the current cursor location on
the timeline. Note that resources are only ever pasted back onto the
layer they were copied from.

Paste At CTRL+B Pastes the clipboard resources (if any) to a frame or time that you
specify.
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Delete Del Delete the selected resources (or drag them to the wastebasket).

Select All CTRL+A Select All resources in this timeline

Deselect All CTRL+D Deselect any selected resources

These items are also available on the menu under Edit.

In addition to dragging a resource from one layer to another, if you press CTRL while dragging, you
will create a of copy that resource to the same or other layer.

Media Placeholders

In the Images and Movie resource pools are placeholders marked with a green ‘PH’:

Designed to be filled by real media when available, these can be dragged onto a timeline layer and be
configured as if a regular image or movie file. An image will show on playback as a green area (size
and position as defined), and a movie as pink. (These default colours can be changed.)

To replace a placeholder with final media, drag the media file from the pool, on top of the placeholder
whilst holding the Ctrl key:

When you see the double arrows and REPLACE message, release the media into the placeholder.

To clone a placeholder’s properties for a new piece of media, drag the media from the pool, on top of
the placeholder whilst holding Ctrl+Shift:
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When you see the double arrows and CLONE message, release the media into the placeholder. The
placeholder will remain, and the new image will be placed with the properties of the placeholder.

Replacing / Cloning Resources

Dragging a resource from the resource pool over an existing resource on the timeline usually just
creates the new resource on the same layer, but pressing CTRL while dragging over an existing
resource will instead replace the timeline resource with the new one from the pool, keeping its
existing parameters (screen location, colour etc.).

This can be used as a template tool, where you create a timeline before the actual media is available,
by setting up a movie or image etc. on the timeline, then when the real media arrives, Ctrl drag it over
the existing media, keeping the previously setup parameters.

By holding CTRL+SHIFT down and dragging a resource from the pool over an existing resource, the
original will be left in place, but a new resource with the same parameters will be created (cloned).

Notes

· Replace / Clone is only available on Audio, Capture, Images and Movies.

· You can only replace like with like, for example, an image with another image.

Cutting, Splitting, Aligning, Looping Media

Right click on any media (or layer) for additional options besides the double-click properties dialog:
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Disable/Enable
Temporarily stop a resource or Layer from running on the timeline; shows greyed out until
enabled. This server’s Timeline, or all Layers of this index in a server Group, or all GUI-
connectable servers, may be selected.

Lock/Unlock
Prevent item being moved from its layer, duration or timeline position, but not its properties.

Outline/Clear
Draws a moving outline around a resource, for visibility.

Interactivity (movies) > selectable: movable
Enables touch-screen operability on selected items only.

Save Preset
Save the resource with its properties to a new name to be reused. This saves as a .CLP file in
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the Presets folder, with all resource parameters saved in the CLP file, and referring to actual
media on disk. Using presets, you can save commonly-used variants of existing media.

These show in the resource pool with a P in the top left corner.

Insert/Cut Space (layers)
Space can be inserted or cut from one or all layers. The effect is to move the start position of
resources to the right (insert) or left (cut), along the timeline. Space will be inserted or cut at the
playhead cursor. If a resource lies across the cursor, no space will be inserted or cut from that
resource. If more space is cut than is available between resources, they will overlap. If all layers
are selected, space will be inserted or cut from all layers.

Split at Cursor
Divides the media resource at the current playhead (cursor) position. Either part can be moved
separately on the layer or between layers. This does not affect the original resource, it merely
provides time-separable windows on the source media. Split parts cannot be rejoined. Either
replace the split parts by the original resource, or ensure they run consecutively to the frame.

Cut (left/right) from Cursor
Cuts the media resource at the current playhead (cursor) position and discards the part to left
or right. This does not affect the original resource, it merely provides a window on a selected
part of the source media. This can be saved as a Preset, but it remains volatile (e.g. looping will
restore the original media length first). To create a true clip of the media resource, set start and
stop frames in Properties [File(s)] and save that as a preset.

Loop (movies)
Switches on and off looping of the source media file so that dragging the resource out will
repeat it without break to a point in time. The Movie Resource Editor dialog also offers
extension with ‘Hold on Last Frame’ instead of repeating from the beginning. A count of loops
can be entered as a set number of times in the Properties page (see also: Seamless Looping
).

Loop (audio)
As for movies, but AudioSeamlessJoins must also be activated the registry to ensure no clock
cycles are missed (see: Seamless Looping ).

Autoplay (movies)
An autoplay media resource that is in scope will continue to play when the timeline is stopped,
and loop-repeat continuously until the playhead is moved off it.

Pitch Correction (audio)
If an audio track needs to be time-adjusted to match video (because the framerate of the movie
does not match the framerate of the timeline), then its sound pitch will change. This can be
compensated for by resampling, but will thereby add processing load to the server. It is better
to create time-matched media.

298

298
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Morph (Geometry)
Morphing enabled for a warp/geometry resource will transition the shape of it smoothly from
any previous geometry shape on the timeline into the selected geometry shape by the start
frame of the selected resource. With Morphing disabled for a specific geometry resource, the
shape will ‘ping’ in one frame from any previous shape to the specific geometry’s shape.

Copy Resource
copies the selected resource on this server to all in the current server Group, or to all connected
servers. Resource (a) on layer (b) of timeline (c) on server X, is copied to layer (b) and timeline
(c) of server Y. Remember that a Resource is a reference to a real item on a server, with
overlaid parameters dictating how, and how much, it will be played. Therefore the media item
referenced must also exist on the servers to which it is being copied.

Concatenate [Left or Right]
All selected resources will be laid end to end with no gaps on the timeline. Left will leave the
leftmost resource and move all others in line to its right. Right will leave the rightmost resource
and move all others to its left.

Goto
on the selected resource, go to its start, middle or end.

Align
Left: moves the start point of all selected resources to the start frame of the leftmost resource.
Right: moves the start point of all selected resources to the start frame of the rightmost
resource.
To Cursor: moves the start point of all selected resources to the current timecode (cursor
position)
To Next Marker: moves the start point of all selected resources to the start frame of the next
marker (if any) on the timeline
To Previous Marker: moves the start point of all selected resources to the start frame of the
previous marker (if any) on the timeline.

Markers

There are two kinds of control markers: those placed on the timeline layers, and those that go in the
timing area.

Timing markers: Load File; GUI Beep; Marker; GoTo; Loop and Stop.

Layers markers: Global Var; Section; Sequence; Placeholder and Comment.

Ø See Delta Supported Media and File Locations  for explanations of terms. 43
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Timing markers can be added to the timing area to mark key points of the timeline – you can add
them precisely by moving the cursor to the desired time, then pressing Ctrl+M. Otherwise, drag a
marker from the Controls selection of the resource pool onto the timing area at the bottom.

Ctrl+M will first open the editor dialog, otherwise, right-click a marker for properties and actions (or
double-click in Main menu > View > List Markers).

By editing the marker, you can change its behaviour, so for example a selected keypress sets the
current time to that marker, and optionally play when it is pressed:
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Resource editor: marker-specific selections

Key
which function key, if any, is assigned to that marker for quick positioning on the timeline.

Keypress Action
choose to play or stop after moving to the marker when the chosen function key is pressed

Playing Action
Choose to do nothing (default) or Stop as the playhead reaches the marker. This option means
you don’t need a Stop control at the same location as well as a marker to just play between
markers.

Control Lines are vertical lines shown beneath resources extending up from the marker at the bottom
– these can be turned off with the Layers Area [Layers] button menu Show > Control Lines.
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You can also align single or multiple resources to the control lines by right clicking on the resource as
shown below, choosing Align, then Next or Previous Marker (or the current time of Cursor).

If markers are already in place, then a new resource, when holding Shift as it is dragged onto the
timeline, will snap to a marker control line:
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List Markers

Markers can also be named, and listed from the Main menu > View > Marker List:

Check Enable to see Time from Cursor dynamically during play. When not enabled, double-click a
Marker row to open the Resource Editor. ‘Mode’ is ‘Keypress Action’ in the Resource Editor.

Seamless Looping a Timeline

Looping Media, Looping the Timeline

You can enable Loop on movie and audio resources, allowing you to drag the length of the resource
out beyond its natural length. This will provide seamless looping of that media resource. Images and
Web Capture resources are inherently loopable anyway.

If you loop a timeline rather than a resource (i.e. to return to the beginning of the timeline and play all
layers again) you may want this to appear seamless, with no black frames between, and with no
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audio hesitation or clicks. In addition to the settings described below, ensure that the loop control in
the timing area is the same as the last frame of the media playing, as follows.

You can drag a loop control into the timing area and right-click to send it to the end frame of the show
(Auto End):

This places the loop in the first frame after the last media frame, so now go to the loop control
properties > timeline and position it back by one frame, to avoid the black frame and/or audio click.

For seamless looping you also need to make a couple of system adjustments.
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Movie Seamless Loop Mode

This movie playback mode must be enabled in the registry (Delta/System/DisableSeamlessLoop
key = 0). It creates seamless playback of media as well as seamless, smooth transitions from one
part of the timeline to another if Goto or Loop controls are present. In addition, external control
commands for Gotomarker, Gototime etc., will also transition seamlessly without stopping the
timeline as in normal mode.

Note: You must set DisableSeamlessLoop key to the same value on every server in the group
(Leader and any Followers), or erratic behavior can result.

When seamless loop mode is enabled, you must place any Loop and Goto timeline commands on
each server’s timeline, not just the Leader server. These commands must be at the exact same
timecode, and with the same properties set.

Registry Edits

7thSense software uses the Windows Registry extensively, and on occasion we make
recommendations for changes.

· Before making any changes, close DeltaGUI and DeltaServer.

· DeltaServer can take up to 10 seconds to fully close in the background, even if it appears that
all the Windows have closed. Ensure that Delta has fully closed before opening and/or
refreshing, and finally editing. The best way to ensure this, is to watch Windows Task Manager
> Details list. You will see ‘DeltaServer.exe’ in this list if DeltaServer is still running. If it won’t
close for any reason, you can right click on it in the list and choose ‘End Process Tree’.

· Make a note of any setting before you change it, in case you want to change it back.

· Only make the changes as recommended and only to those registry keys.

The difference is shown in this example: Movie 1 is in scope playing, and a Goto control comes into
scope which jumps to the start of Movie 2.

Non Seamless Loop
The timeline stops for 1 frame, jumps to Movie 2 and Cues, then Plays (<0.5 s delay)

Seamless Loop
The timeline jumps to Movie 2 and plays immediately (no delay).

In Seamless loop mode, there are some things to be aware of. Any timeline control jump (Goto, Loop
etc.) is pre-planned during playing the show, but for external control versions (GOTOMARKER, GOTO
TIME etc.), there is some delay from an external control command to GOTO a timeline location, while
the new seamless transition is initiated. In non-seamless loop mode, these external commands
happen immediately, but without a seamless transition.
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· With seamless looping enabled, the server pre-caches clips that we will be jumping into via a
GOTO, a loop or or via an external control command GOTOFRAME.

· The amount of time that the server is given to cache ahead is set with the Preroll Frames setting
in the Config > Preferences > Timing section.

· The minimum duration for video only is 5 frames – for codec or audio we would recommend 100-
200 frames, depending on the power of the server.

· You cannot loop seamlessly back into the same audio track that is currently playing.

Audio Seamless Joins

When audio media are butted together, for truly seamless joins the following audio clip needs to start
on the next clock cycle after the preceding clip ends. This is achieved by cueing the following clip.

This also has to be set in the registry (Delta/Hardware/AudioSeamlessJoins key = 1).

Timing Controls Distribution

When Seamless Looping  is being used, any timing controls between Leader and Followers must
be synchronised precisely. Whilst this could be done manually, it is best done using Delta’s timing
controls distribution (TCD).

Registry Keys required to Implement TCD (for every server in the group)

First you need to set the ports that TCD will use to communicate by TCP and UDP. 

Ensure DeltaServer is closed. In the registry, find \SOFTWARE\7thSense\Delta\System:

DisableSeamlessLoop: this should already be 0.

TimingControlsDistributionBasePort: This must be the number which, when added to the server
group, gives the required port.

example:

required port no. = 2078
Delta server group = 16
TCD base port = 2062

The UDP port will automatically be set as TCP port + 1 (in this example, 2079)

TimingControlsDistributionEnabled: 1

298

https://portal.7thsense.one/user-guides/MC255-managing-servers/ports_ports-used.html
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Restart DeltaServer.

The Server Group in DeltaGUI

In this example, we have two servers in Group 63. On the Leader timeline a loop marker has been
added to the timing area, and when we look at the Follower, we see the same marker visible:

Only timing control Markers  can be added to the timing area:

· If a timing control is moved or deleted from the Follower timeline, it will not be reinstated unless
the Leader server control is touched.

· The Leader timeline show must be saved to retain the controls.

· The Follower timeline can be saved, but if both are closed and reopened, the Leader controls will
be reasserted on the Follower.

If any server is removed from or added to the group, there will be an alert to restart that server:

293
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Disable, Lock or Delete Media

To Disable a resource on the timeline, simply Right-click on the resource and select Disable (or
Enable if it is disabled).

You can also select its properties and choose Disable from the General tab.

Disabled resources act as if they are not present on the timeline, and are drawn in light grey.

To Disable an entire Layer, right-click on the Layer area outside a resource, and select Enable or
Disable.

From this menu, you can also Delete an entire layer, collapse or expand a layer, or insert padding
space or cut space at the current cursor position.

To delete a resource, Right-click on the resource and select either Delete this Resource or Delete all
Resources of this type on the layer. You can also drag the resource to the trashcan.

Locked resources behave as normal, except you cannot select them or move them in DeltaGUI until

unlocked. A lock icon  shows up when this is active.

To Lock a resource or layer, right click and choose lock / unlock.
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To Split a Movie, Video Capture, Text resource or Audio file, right click and press Split. This will create
two resources where the timeline cursor is located which are contiguous in time, so until you move
the second movie / audio file, it will still play with no gap. This function can be used to align separate
parts of movies or audio files to help in synchronising content.

To Cut a visual resource, choose Cut Left from Cursor to remove all parts of the resource to the left of
the cursor, or Cut Right from Cursor to remove parts to the right.

To Align resources, right click a single resource or rubberband around multiple resources, then right
click and choose align left, right, To Cursor, To Next Marker or To Previous Marker.

To Concatenate resources, rubberband around multiple resources, then right click and choose
Concatenate left or right.

Outline Media

Outlining is a temporary moving edge around a resource which can be used to locate a resource
onscreen in a complex show, or simply show the edge of (for example) an image used as a mask.

To Outline a resource on the timeline: right-click on the resource and select ‘Outlined’ or ‘No Outline’.

You can also use the right click context menu on a single or multiple selected resources to Outline or
Clear Outlining.
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Presets

You can save a resource from the timeline as a preset, with all its configuration saved so that later,
you can drag that preset back onto the timeline with all parameters intact.

Presets are available for Movies, Images, Audio, Effects, Splines, Serial Events, Text, Controls,
Containers, Video Capture and are stored in the C:\Presets folder as CLP files. These are shown in
the resource pool with a small blue P in the top left corner.

You can delete a preset from the resource pool by right clicking in the resource pool and selecting
Delete.

You can filter the resource pool to only show presets, only non-preset resources or all presets and
resources by pressing the Show button in the resource window and choosing that option.

Geometry, Blends, Colour, Splines all still save their presets (in the relevant Config page) to the
relevant folder on the C: drive (e.g. C:\Blends for blend resources).
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Using Media Resources

Some default resources will already be on your Delta server(s). You will import and create your own,
manipulate them and create shows. These can be complex, and you may have a great many
resources. The Resource Finder (Ctrl+F, or View > Resource Find) will help you. Here, you can search
all resources, filtering by timeline, type, and name.

The Resource Editor is displayed when you double-click any resource on the timeline, or right-click and
choose its ‘Properties’. Several tabs are fairly common to many resources, but each type has its own
tab. These links will take you to descriptions of the properties for the main assets:

Ø Movie Files  

Ø Audio Files

Ø Video Capture

Ø Spout capture

Ø Web Resource

Ø NDI Capture

Ø Stream Capture

Ø Text

Ø Keying (Chroma and Luma)

Ø Art-Net and DMX resources

Resource Finder

Menu > View > Resource Find or simply Ctrl+F. This dialog can be used to find resources on the
timeline by typing in the full or partial resource name, then pressing Go.
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Resources will be listed – double clicking any of them will set the timeline cursor to that resource and
layer in DeltaGUI.

You can optionally search one or any timeline, for only enabled resources, by resource name or
external control name or by resource type.

Timeline Summary

Choosing Timeline Summary from the View menu shows a dialog which has a text summary of all the
resources on the timeline. This can be sorted by start position or layer.

The summary can be copied to the clipboard for offline review using the Clipboard Copy button.
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Any problems with an individual resource will be highlighted beside the name and a list of resources
with errors will appear at the bottom of the page.

Ingesting (importing) Resources

Large media files are simply copied from a source drive to the required server, into the appropriate
destination folders as described under Delta Supported Media and File Locations .

Smaller resources such as shows, meshes or images, may be required on more than one server, or all
in a group, and can be copied and distributed using the Ingest Resource Wizard.

From the DeltaGUI PC, Wizards > Ingest Resource File, you can ingest files (save on remote servers).

Choose Resources

Press the Add File button to choose OBJ, XML, Audio and Images files to the list.

Press the Clear button to remove all files from the list.

43
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Choose Destination

In a similar set of choices to the Copy Timeline dialog above, choose a single server, multiple servers,
a group or all servers to receive the files.
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Click ‘Next’ to process.

Process Files

Click ‘Go’, to send the selected files to the selected servers. ‘Sent’ will show when complete.

Note that in this dialog, you can enter a subfolder for each resource type. Leaving these boxes blank
will place resources in the default root folders for their file type.

There is a size limit of 200 Mb per single file, and currently only images, audio files, OBJ mesh files
and XML / XDL files are supported.

Configuring Resource Properties: the Resource Editor

Media resources have configurable properties. You can access these by double-clicking on the
resource in the Layers Area, double-click on the resource name in the Resources Area (timeline
selected), or right-click the resource and select Properties.
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After selecting properties, the Resource Editor is displayed.

Resource Editor: General

On this tab, you can change the name of the resource, and whether it is enabled or disabled.

Disabled resources will not be visible in the show, and are drawn in light grey on the timeline to
indicate this.

Outlined resources will show a moving edge to highlight that resource.
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External Control name
use the default or edit this to a more memorable name for use by external control commands.

Interactivity – Selection
allow this resource to be used as a button on the playback window

Interactivity – Movement
allow this resource to be moved playback window

Note: interactivity is globally configured in Configure > Preferences > Interactivity

Resource Editor: Timeline

The timeline configuration page is the most used resource-editing page for any resource, where
you can set important parameters such as Layer, Position on the timeline etc.

Resource editor options for an image or movie (different options are presented according to the
media type):

Ø Audio  317
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Timeline Position
The timeline Position From / To values can be set using the dragging technique mentioned
above, or entered manually here.

Layer
You can change the layer of this resource, from 1-250, or place it on the background layer,
which is below all other layers (see Layers Area ).

Background
Checking this box puts the resource on the background layer, behind all others. Other options
(e.g. Channel) then become available.

Opacity
The static Opacity can be changed from 100% to 0%, for example, if Layer 1 has an image with
75% opacity, a layer below it will show through by 25%.

Timeline
Shows which timeline this resource is on.

Render Order
Available for movies, images, capture and text resources, changing from 0 will visibly place the
resource on a separate sublayer from other resources on that layer. Sublayers will be ordered 0,
1, 2 ... Render order is important for DeltaRealTime users with data formatting media

Cropping (% or Pixels)
For Images, Video Capture and Movies, you can specify a percentage amount or pixels of
cropping on each edge to remove unwanted edge areas. You can select to enter the values as
Percent (of resource width) or in Pixels directly. 

Cropping crops the media, which then stretches to refill its allocated screen location, either full-
screen, or the dimensions set (Screen Location tab).

Note that swapping between modes will reset values to 0:
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Channel
Background layer only, which channel the effect (e.g. geometry, colour or blend) will affect.
Note that if the channel is disabled, nothing will be seen in the playback window for this
resource.

Feather
Images only, a percentage amount of softening around the edge of the image to remove any
jaggy edge.

Data Format
For Movies, Images or Video Capture, these resources can be set to be a luminance, depth (or
combination) modifier instead of a normally drawn resource. This allows any visual resource,
such as movies, images, or capture sources, to be used as transition effects, or to define
mathematical operations between sources for composition.

Colour: standard resource, no luma or depth modifier.

LumaKey: use this resource as a luminance modifier. In this case, any resource on that layer will
be multiplied with the resource set to luma-key in one of these modes.

Depth and Stencil are resource features used in DeltaRealTime, the compositor for merging
real-time media assets and pre-rendered playback media. For a full explanation of how to use
DeltaRealTime, see the separate User Guide.

Depth (Red / Green / Blue /Alpha): use this resource as an 8-bit depth modifier for
DeltaRealTime applications. In this case, each pixel of any resource of that layer will be
checked against this depth buffer, and a depth buffer of a layer below to determine which
pixel should be shown. The pixel closest will be shown.
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Depth (RGB): Up to 24-bit depth (8-bit if B alone, 16-bit if G and B, 24-bit if R,G and B).

Stencil (R+) G(x): identify this resource as a DeltaRealTime stencil. 
Any Red pixel in the stencil resource indicates the current colour resource should be added to
the existing frame contents (e.g. for illumintation, or light blooming).
Any Green pixel in the stencil resource indicates the current colour resource should be
multiplied to the existing frame contents (e.g. for semi-transparency, or casting shadows).
Notes on stencil: the Red or Green stencil value will also be multiplied across all colours of the
colour resource to allow attenuation of the source prior to addition or multiplication.
Blue in a stencil is alpha.

Luma Invert
Invert the sense of the luminance modification.

Morph
Geometry only, whether to morph from the previous geometry or simply switch in this
geometry at the start position.

Direction
Fade / Transparency resource can be Up or Down.

Go to Frame
Goto timeline control only, which frame to go to, also the Mode of Stop or Play is shown here for
this resource.

Freeze Group
Yes / No. Selecting Yes for this video capture device will allow it to be frozen from the toolbar
freeze button. Note that all instances of this video capture device on the timeline are frozen
together.

IP Address and Port
Only for Serial Event files which have had the Telnet section added. Set any valid IP Address
and port here, the serial event string is sent out as normal in a UDP packet, instead of to a COM
Port.

Video Mode
For Video Capture devices, choose the video resolution, refresh rate and compression from this
list.

Repeat Frames
For Serial Events, turn on Repeat and this value sets the frame interval between repeated
instances of this serial event.
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Repeat Count
For Serial Events or Splines, turn on Repeat and this value sets the number of times this event
will be repeated (1 = repeat once more on timeline).

Eye
For stereo content, select the eye (left or right) or even left-right and top-bottom configured
content.

Ping-Pong
For Splines with a repeat count greater than 1, either restart from the start of the spline, or
change direction on each repeat.

Forced W and Forced H
For capture cards, force the Input resolution to these values (where the capture hardware
supports this feature).

Fixed (Yes/No)
For geometry or blends on the background, if Fixed, will auto-reset to frame 0, if not Fixed, you
can set the start frame as normal.

H Resolution
For Web Controls, the rendered width of the page.

V Resolution
For Web Controls, the rendered height of the page.

Warp Mode
For geometry on the background layer, choose Normal, Converge Red or Converge Blue.

Render Width and Render Height
For Notch input capture, set the rendered resolution to these values.
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Audio

Panning
Audio resources, pan the audio from -100 (full left), through 0 (equal left and right) to +100 (full
right).

Channel Offset
Channel Offset (new in 2.8.7) allows users to apply custom offset to mono and multichannel
audio files. This capability is useful for high channel count systems, which for efficiency should
avoid large numbers of individual concurrent files.

Individual mono files should only be used up to a maximum of 16. Beyond this, multichannel
files should be used, with the necessary channel offsets applied to achieve the required
channel count.

Check in Preferences > Audio for the maximum concurrent audio tracks, since the default is 32
(see Audio Type ).

Pitch Correction
For Audio Files, if you use Play Speed compensation to match an audio file at a different frame
rate to the timeline’s frame rate, the pitch will shift up or down accordingly. Enable Pitch
Correction to stop this change in pitch, but still change the length of the audio file.

Note: this requires some CPU processing, so check that frame drops are not caused by overloading
the CPU.
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Markers Only

Key
which function key, if any, is assigned to that marker for quick positioning on the timeline.

Keypress Action
choose to play or stop after moving to the marker when the chosen function key is pressed

Playing Action
Choose to do nothing (default) or Stop as the playhead reaches the marker. This option means
you don’t need a Stop control at the same location as well as a marker to just play between
markers.

Resource Editor: Movie Files

The Files configuration tab for Images simply shows the full path to the file. For Movies resources
there are configurable items as below:

The  button allows manual editing of the file details.

The Audio checkbox (appears with a codec resource) allows you to specify if audio contained in a
movie file should be played.
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Video Framerate Compensation

The Play Speed allows you to perform video framerate conversion, for example, playing a 24 fps
movie at 25 fps, but maintaining the right movie length in time.

Since Delta gets its timing from the graphics card refresh, ideally, this should always be set to a
multiple of the movie framerate, so for example a 24 fps movie would have the graphics refresh set
to 48 Hz or 72 Hz (the lower value is preferred).

If this is not possible, you could set the graphics refresh to 50 Hz, so now, playing a 24 fps movie at
25 fps makes it 25 / 24 too fast. To correct this, choose the Play Speed of 24->25 fps.

To perform this conversion, frames must be dropped or shown twice in order to maintain the correct
rate. This may lead to disturbing jumps in the movie, but this is dependent on the movie content and
the difference between movie actual and desired rates.

To minimise the size of frame drops, set the timeline rate to a higher rate, so in the example above,
choose a 50 fps timeline rate, and enter the custom conversion rate in the box provided:

Actual Movie rate = 24 fps

Graphics Refresh = 50 Hz

Timeline rate = 50 fps

Movie Custom Ratio = 24/50 = 0.48

Movie Interpolation

If you have to use video framerate conversion, for example a 24 fps movie on a 30 fps timeline, you
can turn on Interpolation, where extra inter-frame information is created in realtime based on the time
error at that point to improve the smoothness of motion.

AutoPlay

Enable this to make the movie autoplay – as long as the playhead is in scope with the movie, the
movie is playing, even if the timeline is stopped.

Movie Clip

The Start Frame is that frame number on disk that you want to start using, so for instance, if set to
the above example of 100, the first frame shown will be frame 100, wherever on the timeline you
placed this resource.
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The Stop Frame is that frame number on disk to stop at. Setting this allows you to loop the movie
from a start frame to a stop frame.

Example: The Start Frame on this dialog is separate from the Timeline Position value on the Timeline
tab, so for example:

· 300 frames found on disk for sphere.tga (sphere _0001.tga, sphere _0002.tga etc.)

· Position the movie at frame 5000 (Timeline Position = 5000 to 5299)

· Set the start frame to 100 (Timeline Position is now 5000 to 5199), starting at sphere_0100.tga
onwards

· Press Play

The timeline advances until it reaches frame 5000, then the 100th frame (sphere_0100.jpg) is shown
at 5000, 101st frame at 5001 and so on for 200 frames.

From Delta 2.6 build 84, movie files beginning other than frame numbered ~00 will show a thumbnail
of the first frame found, and display the number of the first frame, in the file Information shown on
timeline resource hover, and dialogs where a Start Frame is set.

Example: Movie starts with frame ‘name_0140.tga’. Thumbnail of frame 140 is shown and in dialogs,
this additional information:

Note: ‘Start Frame 00’ becomes relative, so to stop at stop frame of 50 would mean frame filename
ending ‘name_0190.tga’.
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Movie Loop

Select the ‘Enable’ checkbox if you want to drag the movie out on the timeline longer than the number
of frames – the movie will seamlessly repeat. Use the Calculator if you want to work out the length
for a set number of loops.

Select ‘Hold on Last Frame’ as well, if, instead of repeating the movie from the start, you want to
extend the length of play by continuously repeating the last frame until the next timeline play control.
Note that on codecs with audio, the last frame is held but that audio channels restart from the
beginning.

Resource Editor: Audio Files

Ø See also the Audio Timeline tab  

For Audio, Play Speed has a dropdown of various audio conversion rates (see below) as well as a
custom setting which allows you to type in a speedup factor.

Audio Framerate Compensation

These conversion rates can be used to compensate, for example, a 24 fps audio track playing on a
25 fps timeline. Without compensating, the audio will run ahead of the video in the example below:

Using the conversion below, the movie will play 25 / 24 too fast, but the audio will stay in sync with the
movie:
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Actual Movie rate = 24 fps

Movie Rate = 24 fps

Graphics Refresh = 50 Hz

Timeline rate = 25 fps

Audio Play Speed = 24 -> 25

Note that the pitch of the audio will be increased by this amount.

Start and Stop Time can be used to crop the start or end of the audio file.

The Loop checkbox allows you to drag the audio file out on the timeline for longer than the number of
frames – the audio will seamlessly repeat. ‘AudioSeamlessJoins’ must be set in the registry to avoid
missed clock cycles.

Autoplay: Enable playing of this audio independently of the play mode of the timeline.

Audio Mixing: 8 Channels

For mono files, you can choose which physical connector on the PC the sound comes out on. The
right-hand group of checkboxes becomes live, and you can choose to send this mono file out one or
more of the connectors. Panning is only for stereo files.
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Audio levels for each speaker (mono files only) can be set using the 8 sliders on the right side, Overall
volume of this track affects these individual speaker volume levels as well.

You can also choose an Audio Mapping Preset from the dropdown – see Config > Preferences >
Audio Mapping to create presets.

Audio Mixing: 32 Channels

Some sound cards have up to 32 channels, in this case, the following choices are available – note
that Panning is not available on these sound cards.

Resource Editor: Video Capture

Video Capture is an option within Delta that can use a variety of video capture hardware including
single-channel high-update rate cards, dual channel medium update cards and inexpensive web
cams: any video capture device that implements a proper DirectShow filter will work with Delta.

Video Capture windows shown in the resource pool can be placed anywhere on the timeline, and
shown multiple times simultaneously, allowing video-wall type effects to be created.

A Capture window can be manipulated in exactly the same way as other image-based resources, so
for example, geometry, morphing geometry and transparency can be applied or changed at any time.



324

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Notes

· Video capture can be an intensive task, so if you are playing a high-resolution movie at the same
time as showing a capture window, the load of the system has to be checked that it is still within
the capabilities of the server.

· Some video capture cards require a separate process to create a video definition file. This file is
then selected when you edit this resource.

· Direct Show compliant capture cards can be tuned using their own control applications, so to
choose PAL / NTSC, deinterlacing or setup colour etc., this must be done in the manufacturer
supplied application. Alternatively, use the Video Capture Tuner program to launch the devices
setup pages.

· Most video capture devices will choose a best fit format to match the incoming video. Some do
not, so you can select the video format from the resource’s drop down list when editing.

Note: for vertically inverted capture images from a Datapath capture card, select video format
‘RGB-8Bit-Flip’.

· MMS Video capture will show content from a Microsoft Media Stream. Add this device to the
timeline, then configure the IP Address of the source.



325

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

The capture device can be set to always play at full update, even when the timeline is paused.
Configure this in the Configure > Preferences > Timing page.

Video Capture Freeze Group

Capture devices can be assigned to a Freeze Group. For each capture device type, edit the resource
properties, and choose Yes or No to the Freeze Group item. When the Freeze Video Capture button in
the toolbar is pressed, only those devices that are set to be part of the freeze group are frozen.

This allows certain video capture inputs to be frozen while content is changed in the background,
before un-freezing.

Note that all instances of a particular video capture device freeze at the same time.

Video Capture Device IDs

Some capture devices such as USB webcams can dynamically change the Identifier number
assigned by Windows. In this case, fix the capture device Identifiers in the Server Dialog > Preferences
> Video Capture.

Deinterlace

For certain capture cards (such as Datapath), you can enable deinterlacing for interlaced inputs, the
options are Off, Weave, Bob, Field0, Field1.

IntelligentSource™

IntelligentSource data can be embedded in the feed to add this feature. When enabled, frame data in
the stream can be used as an event trigger for a sequence. See IntelligentSource™ .

Check ‘IS Single Line’ to continue monitoring the stream but not render the feed into Delta’s output.
This enables the user to hide and show the feed depending on the IntelligentSource data coming
through. This can all be handled via Delta’s system sequence which gives the user callbacks when
the IntelligentSource data changes.

Resource Editor: Spout capture

Spout is an industry open standard video sharing framework – a way of sharing whole frame buffer
imagery between applications. Delta can capture Spout as a capture device and show it anywhere on
the output canvas, and manipulate it as with any other capture resource type.
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Spout can be used to input live realtime graphics from another application (e.g. Unreal, or Unity)
resident on the server (or via network), with the realtime app running in the background behind the
server’s playback window. The realtime app can also render part normal imagery and part alpha
plane in order to key the Spout window into the normal playback content.

Care should be taken to ensure that normal playback performance is still maintained when the
realtime app is running so that smooth playback is achieved in all cases – this will be dependent on
the system performance (graphics card mostly) and the realtime app’s requirements.

Configuring Spout

Install Spout on the server. Configure Spout to have a known sender name. In this example, the Spout
Sender DEMO app is being used. The application can normally be found in C:\Program Files (x86)
\Spout2\DEMO. If you run SpoutSender.exe you’ll something similar to this:

The sender name can be set by going to File > Sender Name. Enter the name you want to use; here we
use ‘test1’ as an example sender name:

This name now shows in the sending window:
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Adding to the Delta Timeline

Open DeltaServer and DeltaGUI. From the Capture tab of the Resources window, drag the Spout
resource onto the timeline. Double-click the timeline resource, and select the Timeline tab, to add the
sender name you set above (test1) as the SpoutID:
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Shared Memory mode is not recommended because is it quite slow. If you are using Shared Memory
mode, you will want to enable that mode in the resource. If you’re using texture memory, then it
should be left disabled.

Once you click Apply, the capture resource will receive the video from your specified Spout instance,
and the Delta playback window will match the Spout output:

IntelligentSource

IntelligentSource data can be embedded in the feed to add this feature. When enabled, frame data in
the stream can be used as an event trigger for a sequence. See IntelligentSource™ .

Check ‘IS Single Line’ to continue monitoring the stream but not render the feed into Delta’s output.
This enables the user to hide and show the feed depending on the IntelligentSource data coming
through. This can all be handled via Delta’s system sequence which gives the user callbacks when
the IntelligentSource data changes.

Resource Editor: Web Resource

This is a special capture resource which is a built-in web control, where you can set the URL
(http://www.mydomain.com) to be rendered in the web control and you can also set the rendering
size of the web page using the H Resolution and V Resolution parameters.
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Web controls behave like all other visual media in that you can scale, position, chromakey, crop,
feather etc.

You can also set the web URL from a sequence or external control using the WEBSETURL
res="External Control Name" url="http://mynewdomain.com" or make the web control navigate
using the WEBNAVIGATE res=\"ExternalControlName\" navigate=[back/forward/reload/stop]
command.

The Web Resource is based on the Chromium renderer. It does not support WebGL, MP4 or audio
playback. However, it does support OGG/WEBM video formats in accordance with
https://developer.mozilla.org/en-US/docs/Web/HTML/Supported_media_formats.

JavaScript Events

When using Web Page resources on the timeline, it’s possible to trigger JavaScript events within the
web page from Delta. These are enabled in the Resource Editor (below, called JS Events).

https://developer.mozilla.org/en-US/docs/Web/HTML/Supported_media_formats
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JavaScript applications must register a callback to window.onDeltaServerReady which, when called,
indicates that the global object DeltaServer has been created and is ready to use. Callbacks can be
registered on the DeltaServer object by calling DeltaServer.on("[event]", callback).

It is important that this function is created at the global level, outside of any typical loading
callbacks/lambdas such as window.onready or jQuery $(function() {});.

On 'frame' event arguments

Name Type Description

relativeFrame Integer Frame number relative to the start of the Web View resource, that is the number of frames into the
current resource.

absoluteFrame Integer Frame number of the timeline of this Web View resource.

progress Float From 0 to 1, indicates the progress through the resource. Useful for synchronising animation and
events across multiple Web Views or Delta servers.

'enterscope', and 'leavescope' are called when the current Web Page resource enters/leaves scope.
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Sample Code
window.onDeltaServerReady = function () {
  DeltaServer.on('frame', function (relativeFrame, timelineFrame, progress) {
    // called on each frame
    document.getElementById("frameNum").innerHTML = relativeFrame;
    document.getElementById("timelineNum").innerHTML = timelineFrame;
    document.getElementById("percent").innerHTML = Math.round(100*progress);
  });
  DeltaServer.on('enterscope', function () {
    // called on resource entering scope
  });
  DeltaServer.on('leavescope', function () {
    // called on resource leaving scope
  });
}

Development and Debugging

A mock DeltaServer JS library is provided for testing events from a regular web browser. The library
can be downloaded with the following link and included in the webpage like a normal JS library.

Right-click this link to download: mock-deltaserver.js.

Transparency

For web resources created with transparency, this can be enabled here. Transparency will add 33 per
cent colour load on this resource.

IntelligentSource™

IntelligentSource data can be embedded in the feed to add this feature. When enabled, frame data in
the stream can be used as an event trigger for a sequence. See IntelligentSource™ .

Check ‘IS Single Line’ to continue monitoring the stream but not render the feed into Delta’s output.
This enables the user to hide and show the feed depending on the IntelligentSource data coming
through. This can all be handled via Delta’s system sequence which gives the user callbacks when
the IntelligentSource data changes.

Resource Editor: NDI Capture

NDI® (Network Device Interface) is a resource available in the capture resource pool. Delta 2.8
supports NDI 5.5 and offers enhanced NDI management. Delta accepts multiple streams of NDI from
a single server and offers them as a selectable list of stream names.

Note: Delta capture receives unencrypted NDI streams, but does not currently support audio.
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Install NDI 5 tools.exe before beginning NDI input setup. This is useful for preview purposes (Studio
Monitor), and for setting the optimised receive mode (UDP Reliable) and the preferred NIC mode
(both in Access Manager).

Ø Download NDI Tools 

NDI ports

NDI goes out of all NICs and uses port 5353 (the mDNS Bonjour port) to detect NDI sources. For any
NICs where you do not want NDI traffic to go, the quickest solution is to create a firewall rule to block
port 5353.

Network: NDI Access Manager

NDI® Access Manager in the NDI tools set allows you to specify whether your machine uses Unicast
or Multicast for sending (below, right). Multicast can be used when appropriate switches are available
in the network to control where the NDI traffic is routed to. It’s worth knowing this is available for
Delta NDI Preview, but also for anyone sending feeds to capture in Delta.

https://www.ndi.tv/tools/
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Optimise receive mode and preferred NIC in Access Manager:

For changes to take effect, you must reboot the server.

Ø For more about the NDI® Access Manager, Groups and Networks, please see the overview video
at https://www.ndi.tv/tools/. 

Ports

The channel count matters – you must ensure that, starting from port 5960 and counting up, enough
network ports are available for the maximum supplied by any one NDI source – plus one (for NDI
server messaging). So, adding an IP Address for a system supplying one NDI channel to the Receive
from IP list means ports 5960 and 5961 must be available. A second source serving eight NDI
channels would need ports 5960 – 5968 to be free, etc. (source: NewTek).

https://www.ndi.tv/tools/
https://support.newtek.com/hc/en-us/articles/115005633028-Access-Manager
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NDI Capture on the Delta timeline

Drag an NDI feed or feeds from the Resource Pool onto the timeline and select each NDI feed you
want to display. Double-click the resource to open the Editor dialog.

Delta NDI Capture resources are managed the same as other capture resources, and require the
stream name in the Resource Editor > Timeline : Address. 

Select from the available NDI feeds dropdown for available streams by name to gain the address:

The same name can be used to preview the NDI stream in NDI Studio Monitor from the selection
menu:
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Resource Editor: Stream Capture

Stream capture resources can receive unencrypted network-address video streams, including HLS,
HTTP, HTTPS, Pro-MPEG FEC, RTMP, RTMPE, RTMPS, RTMPT, RTMPTE, RTMPTS, RTP, SCTP, TCP,
TLS, UDP.

Broadcast capture can be received, for example by using Zixi software to handle the encryption
licence, and/or record the stream for subsequent replay or looping). This will re-stream to Delta as a
UDP stream using an address in the format: udp://127.0.0.1:#### (localhost and configured port), or
replay a recorded .ts (Transport Stream) movie file as a Stream resource with the address being the
full movie file path and name.

A guide to using Zixi Receiver software to display, record and replay broadcast sources can be found
online in our user portal.

IntelligentSource™

IntelligentSource data can be embedded in the feed to add this feature. When enabled, frame data in
the stream can be used as an event trigger for a sequence. See IntelligentSource™ .

Check ‘IS Single Line’ to continue monitoring the stream but not render the feed into Delta’s output.
This enables the user to hide and show the feed depending on the IntelligentSource data coming
through. This can all be handled via Delta’s system sequence which gives the user callbacks when
the IntelligentSource data changes.
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IntelligentSource™

When video capture resources are included in a Delta show of any kind, you may want to ensure that
frozen or broken input is detected and replacement media to be substituted, or even send a message
to alert the condition. 

Delta (from version 2.7) can be enabled to add (Display > Output Setup) and read IntelligentSource
data inserted into the top line of capture source frames, showing Delta that frames are updating. If
the incrementing data stops, a System sequence will be triggered in Delta and this can be used to
perform a required action.

In the resource editor (timeline tab) for all capture resources, there is a checkbox to enable
IntelligentSource listening. This will trigger the default IntelligentSource System sequence. You can
find this in Sequences > System:
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Add whatever sequence steps you require as a response.

An API is available from 7thSense to enable content developers to add IntelligentSource data. Ask
also for guide reference M450 IntelligentSource API User Guide.

IntelligentSource is also a feature for failover in Juggler systems.

https://portal.7thsense.one/user-guides/M512-compere-1-0-5/
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Video Capture Groups

Legacy: video capture groups only applies to older systems. This was superseded when Datapath
introduced ‘input ganging’ within their driver, which is better for being simpler. Datapath input
ganging  achieves the same goal, and is supported by Delta.

Multiple video captures can be grouped and treated as a single timeline resource. The main use case
for this is for domes, to enable a 4K × 4K fisheye image to be assembled from two 4K × 2K inputs in a
1 × 2 arrangement:

Copy this example .xml code for a capture group and amend it as required. It must be saved to 
C:\Program Files\7thSense\Delta\System\VidCapGroups.xml:

<?xml version="1.0" encoding="ISO-8859-1"?>
<VIDCAP_GROUPS>
<Count>3</Count>
<GROUP1>
<Name>Workstation4K</Name>
<NumDevices>2</NumDevices>
<GridSizeX>1</GridSizeX>
<GridSizeY>2</GridSizeY>
<DEVICEID1>4</DEVICEID1>
<DEVICEID2>5</DEVICEID2>
<CaptureWidth>4096</CaptureWidth>
<CaptureHeight>2048</CaptureHeight>
<CaptureFormat>422</CaptureFormat>
</GROUP1>
<GROUP2>
<Name>Uniview4K</Name>
<NumDevices>2</NumDevices>
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<GridSizeX>1</GridSizeX>
<GridSizeY>2</GridSizeY>
<DEVICEID1>2</DEVICEID1>
<DEVICEID2>3</DEVICEID2>
<CaptureWidth>4096</CaptureWidth>
<CaptureHeight>2048</CaptureHeight>
<CaptureFormat>422</CaptureFormat>
</GROUP2>
<GROUP3>
<Name>Uniview3K</Name>
<NumDevices>2</NumDevices>
<GridSizeX>1</GridSizeX>
<GridSizeY>2</GridSizeY>
<DEVICEID1>2</DEVICEID1>
<DEVICEID2>3</DEVICEID2>
<CaptureWidth>3200</CaptureWidth>
<CaptureHeight>1600</CaptureHeight>
<CaptureFormat>422</CaptureFormat>
</GROUP3>
</VIDCAP_GROUPS>

The xml tags are fairly self-explanatory:

<VIDCAP_GROUPS>

Identifies the xml file type.

<Count>n

The number of groups being used.

<GROUPn>

Identifies the group

<Name>

Names the group for video capture (see Resource Editor below). This Name only appears in
DeltaGUI as a Capture Resource.

<NumDevices>

Number of devices addressed in this group.

<DEVICEIDn>

Identifies the device by its DirectX ID.

<GridSizeX>, <GridSizeY>

Matrix dimensions of all devices in this group.

<CaptureWidth>, <CaptureHeight>, <CaptureFormat>

Capture dimensions of each device in this group. Format can be 422 or 420.
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Identify the Capture Devices (visible to DeltaServer)

Check here for device details to use in the xml.

Using Capture Resources in DeltaGUI

Find your video capture (or Capture Group) resource in the DeltaGUI Resources panel and apply it to
the timeline:
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Preferences > Miscellaneous (DeltaGUI)

Ticked by default, ‘Maintain Video Capture rate when paused’ will maintain frame capturing when a
show is stopped or paused.
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Resource Editor: Controls Placeholder

Controls Placeholders occupy space in a layer on a timeline. You can name them and describe them
in readiness for replacement by required media, but nothing is displayed on the playback window.

This placeholder is not the same as an image or movie placeholder from the Movie or Images
Resource panel.

Ø Media Placeholders  

Resource Editor: GoTo Control

From the Controls Resources, GoTo is a timeline control that is dragged onto the timeline and
configured. GoTo is also available as an External Control.

289
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GoTo is used to jump to a timeline position (frame or marker) and perform an action:

GoTo
Select a frame time or marker name. (For Marker, set Go to Type first.)



345

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Target
Enter the number of concurrent times the GoTo will activate, after which it will be ignored and
hit counts are reset. The timeline marker will show counts/target in red until the target is
reached and it goes green.

Current
This is just a counter of how many hits. It resets when the show is restarted. A number entered
here will be incremented but resets to zero.

Mode
Play or Stop when the playhead goes to the target position.

On Trigger
Play through or stop when the playhead hits the control.

Go to Type
Select Time or Marker. This feature was added in Delta 2.7.

Resource Editor: Text

Text (normal)

The text resource allows you to place simple titling onto the show. You can adjust the font used, size
and colour of the text, as well as previously mentioned items such as animation, screen location,
opacity etc.
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Special Text Resources

Timecode

This text resource shows the frame or timecode of the timeline (select which, from the display
option). Count options are relative to the timeline, or position of the text resource. In the Text tab,
format the Font face, size and colour. In the Screen Location tab, position the text on the screen.
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Countdown to resource end
Show number of frames (or time) remaining of text (does not apply to Disk Frames display
option).

Count from Text Start
Show number of frames (or time) of text played, from the start of text resource.

Display Option
Frames: for any movie format, the current frame number
TC: the Timecode for the current frame

Movie Timecode

By default, the movie timecode relates to a movie in the same layer as this text resource. This can
only be unambiguous for very simple timelines. It is better always to use the External Control name
for the required movie resource. The displayed text shows information for the current frame of the
referenced movie (name, number or time):
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Movie Ext Ctrl Name
Copy the External Control Name from the Required Movie’s Properties > General tab.

Display Option
Disk Frames: used for 7th or tga movies, displays the movie location and current frame title
Frames: for any movie format, the current frame number
TC: the Timecode for the current frame
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Resource Editor: Keying (Chroma and Luma)

Chroma and Luma keying is available on visual resources (Images, Video Capture and Movies) and is
typically used for masking out areas or green screen applications.

Chroma Key

This is available for, and sets which colour will become transparent to layers below, and is most
usable on multi-coloured media (not monochrome), since you pick a colour and tolerance / range
around that colour.

Colour
Choose which colour will be transparent.

Tolerance
0 means the exact colour only will be transparent, higher numbers will allow similar colours to
be transparent.
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Range
Range is a softening value about the tolerance

Notes

· For the Dynamic Keying resource, you can set the chroma values using the dialog above or with
the SETTRANSITIONPARAMS external control command.

· Due to compression artefacts, for example in jpg images, what may look like a single colour will
be surrounded by similar colours which interfere with this process. Increasing the tolerance can
help this problem. It is common when using chroma key images to design specific colours for
keying, and selecting an uncompressed format such as TIFF or TGA.

· Uncompressed images such as bmp preserve exact colour perfectly.

Luma Key

This is available for, and sets which monochrome luminance value will become transparent to layers
below, and is most usable on monochrome (not multi-coloured), since you pick a greyscale value and
tolerance / range around that value.

Luma Value
Choose the value to make transparent.

Tolerance
0 means the exact colour only will be transparent, higher numbers will allow similar colours to
be transparent.
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Range
Range is a softening value about the tolerance

Resource Editor: Colour Controls

All visual resources (Movies, Images, Video Capture and Text) can have the contrast, brightness and
gamma set on individual resources by choosing the colour tab:

Resource Editor: Art-Net and DMX resources

This resource can be an Input or Output, and you can edit a subset of the parameters compared to
the main Art-Net and DMX editor.

Ø See also Art-Net and DMX  390
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Output Device

Set the channel values, base address and Mode for this one resource:

Fade Mode
Fade to the preset values over the fade time

Instant Mode
Instantly change to the values (within this tween group)

Tween Mode
Tween to other Instant or Tween mode resources in this tween group

Input Device

Set the Control Message, SubNet, Universe. The values in the named channels will replace the
placeholders in the Control Message (e.g. in the example below, the ‘Y’ value will replace the ‘%Y’
string with the value in Art-Net channel 12.

Note that setting Slider Values is only here for testing, since the incoming Art-Net data will set
these values and trigger the message on any change in value.
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Building a Show by Combining Resources

Timeline resources are accepted onto layers with a hierarchy of order and effect, as follows.

Media Layers

Text: can be used multiple times.

Movies: Turn on looping to drag longer
than the native length
Live Capture: Can be any length and
placed multiple times on the timeline
Still Image: Can be any length and placed
multiple times on the timeline
Audio: Turn on looping to drag longer than
the native length
Transparency: Applies to the layer, not
individual media
Geometry: applies from the start point
onwards only stops when another
geometry resource hit.
Placeholder: Does not appear on screen,
simply a placeholder to be allocated to
media.
Serial Event: sends out any characters at
this frame
Spline: Motion path followed by all visual
media when in scope.
Playlist: Contains list of media which
plays non-stop when the play head is in
scope with it.
AV Assembly: Contains 1 visual + N audio
resources to keep grouped.

Art-Net and DMX Layer

Art-Net Output: Sets preset DMX
channels to these values over time
Art-Net Input: Listens to preset DMX
channels and triggers external control
command using them

Background and Display Layer

Background Geometry: Sets warp per
channel
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Blends: Enables edge blending per
channel
Colour: Enables colour adjustment per
channel

Screen Location (in Flat Plane or Mesh mode)

This tab allows you to specify that the Image, Movie or Video Capture occupies a section of screen
less than the full screen, and additionally, you can roll the image through 360 degrees.

This allows you to perform scaling on the image, so you can zoom up on a part of an image and
position it in the centre of the canvas.

See also ‘Resource Layout’ in the next section, using the Layout (rather than Layers) view, for
sizing and placing media.

Image Mapping Mode
can be Flat (coordinates relate to the whole canvas) or Channel Mapped (coordinates relate to
the selected channel only). If you choose Channel Mapped and untick Fullscreen, the top left
corner of the resource is the channel’s top left corner, rather than the overall canvas top left
corner. Channels are setup in Config > Display.

Maintain Aspect
when checked, the height is auto-calculated based on the original Image Size aspect.

Mirror H and Mirror V
can invert the visual resource at any time.
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Pressing alignment buttons will align the image with respect to the canvas.

The Canvas is discussed in the Display Configuration section, but briefly, this is how a display could
look with an image set to:

Coordinates relate to Centre
This defaults to off, where the X and Y values describe where the top left of the visual resource
is positioned. If checked, X and Y describe where the centre of the resource is located.

Screen Location: Dome mode
Dome (Frustum) mode is a special geometric mode in which resources are rendered onto a 3D
world, so they are placed and sized in terms of angles instead of pixels.

Ø Display Configuration: Dome Mode  

Resource Layout

Choose View > Resource Layout from the menu to access this window which shows a 2D basic
representation of the Flat canvas and resources, enabling you to add, move and resize visual
resources (Movies, Images, Text and Video capture) directly on the canvas.

201
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Note that this only works in Flat modes (including Mesh Mode), not Dome mode.

Drag resources from the resource pool on the left onto the canvas. Resources are initially full-screen
by default, so click the maximize / windowed button (top right of the resource) to allow resizing and
moving. This view is fully interactive with the playback window (inset below).
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Click the resource pool ‘Timeline’ to view only resources that are on the timeline, hover the name
there for properties, double-click to edit.

Right click a resource in the pool list (illustrated above) to go to that resource’s position on the
timeline (if not in scope), or to delete it.

Resources are added sequentially on top of each other in Layer1. To change layering, double-click the
title bar of a resource to access the Resource Editor.

Click the Enable tick-mark in each window’s top right corner to enable or disable that resource in the
timeline.

Filters

Choose Enabled to only show enabled resources.

Choose In Scope to only show those resources which are visible at the current timeline time.
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Choose Selected to only show one resource at a time in the layout window so that you can work with
overlapping resources – simply choose the resource from the left resource window, then you can
move that single resource. The resource will also be Outlined automatically once selected, and all
others deselected for outlining.

Configure (Menu)

Draw resources as Solid
If disabled, the resource windows become see-through, allowing you to move a resource which
is on a lower layer.

Draw resource details
Show the resource layer, coordinates within the resource window

Draw resource controls
Show the enable / maximize control in each resource window.

Show VCR Controls
Show the playback controls to enable moving the play head.

Snap
Enable or disable snapping points to the grid.

RESET Button
Resets the view so that the canvas is shown full screen.
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Sizing and Zoom Control

Aspect ratio
When resizing, hold the Shift key down to lock the resource to its original aspect ratio.

Grid snap
When moving or resizing with the grid on, press the Ctrl key to temporarily ignore the snap
function.

Zoom
The mouse wheel will zoom in / out about the cursor within the layout window.

Notes

· Enabling a movie while playing may not work, depending on the disk system.

· The position on the canvas as shown may not represent the true position as seen in the server
playback window, since other resources (geometry, spline, transform animator) can override the
position set within the resource.

· Once a resource is selected, also move it with the arrow keys, and press Control while using the
arrow keys to move by 10 pixels a time.

Animation

Basic animation is available for Movies, video capture, text and Images, and sets the rate and angle
at which the image moves and rotates. Double-click the Timeline Resource for the editor:
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Note that the animation is frame-based, so the timeline has to be playing in order to see the
animation. This also means that the animation is dependent on the actual frame number, so that on
multiple racks, the look of the image is consistent at a particular frame.

Movies and Video Capture only have rotational animation.

Transform Animation

Adding a Transform Animator (TA) to a layer affects all resources on that layer while it is in
scope. This resource effect provides Flat Plane transformation of X, Y, Width, Height or Roll so
that users can quickly create motion effects for a whole layer without creating complex

geometry resources.

Note that you can have multiple TAs on the same layer, doing different things as required, so for
example, one TA in speed mode, animating the position of X and Y, with a second TA on the same
layer in Absolute Mode, animating W and H over a different time.

Transform Animator: Absolute Mode

The three blocks represent start values, iterations (repeats of the action during the length of the
transform animator), and end values.

In absolute mode, the values entered will alter all resources directly, so for example, forced start X,Y
values of 100,200 and End values of 200,200 in absolute mode will snap the top left corner of all
resources on the same layer to those coordinates as the transform animator comes into scope on the
timeline, then animate the resource to X=200 over the length of the TA.

· Enable which parameter (X, Y, Roll, Width, or Height) you want to animate.
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· Enable ‘Force Start’ to set start values that override the current position(s) of the resource(s)
affected, otherwise resources will be transformed from their original positions to the end position
set.

· The range of iterations is 0 to 100: an iteration is a transformation between start and end values,
and the time duration of the transformation is divided by the number of iterations. Note that a
value of 0 means no movement will be carried out, select at least 1.

· ‘Ping Pong’ means that iterations alternately reverse direction.

· Start and End values are ‘between’ points. If ‘Ping Pong’ is checked for multiple iterations, then an
even number of iterations will not end at the end value of that parameter, but the start value.

‘Persistent After Animation Ends’
leaves the resource(s) affected in their final position.

Transform Animator: Relative Mode

In Relative mode shown below, values entered here will be added to any resources on that layer.

The transform animator’s values can be altered from external control, simply call the
TRANSFORMPARAMS transformer_name X Y W H R control to set the values.
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Transform Animator: Speed Mode

In Speed Mode, you can set the speed of motion in both X and Y over the length of the transform
animator. This allows you to animate resources onscreen at a known speed and ‘Ease’ in and out of a
set speed from another speed or to/from stopped.

In the example above, the start speed is 0, the speed will increase to 1 pixel/frame (set in the centre
section) over 5 frames, maintain that speed for 90 frames, then slow down to 0 over 5 frames. The
profile sets the contour of acceleration and deceleration.
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Geometry/Warp

After adding a Geometry resource to the timeline media layer, select Warp from the Workspace Menu
to access the geometry configuration panel. Geometry can be applied to a specific channel for display
alignment (place it on the background layer), or it can be applied to a piece of media across the whole
canvas by placing it on the same non-background layer as the media.

Timeline (i.e. used and edited) Geometry resources can be renamed, saved to the Resource Pool, or
deleted.

· To manipulate a geometry on the timeline, select Timeline on the left resource area, then the
relevant geometry, and manipulate it using the controls on the right side of DeltaGUI.

· If you select Resources from the resource area and adjust the warp using the right-side controls,
you are adjusting a pool resource (temporarily for this session only). You may do this in order to
create a specific shape, then Save to Resource Pool in order to store it permanently on disk. It is
then available for later use by dragging it onto the timeline.

There are three kinds of geometric warping:

· Timeline  (bowing, skewing, stretching the image or channel)151
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· Surface  (smooth overall distortion of the image or channel around midlines and corners)

· Distortion  (distorting the channel as a interpolated grid, point by point, or by groups of points)

Multiple geometry resources can be applied to a timeline, and come into scope when the playhead
passes the start position. 

If you select a Geometry resource to Morph, the geometry of that layer (or the channel if it is on the
background) will smoothly change shape from whatever previous geometry shape is there to be
completely changed to the new shape by the start position.

Using Morphing, you can create nice fly-in / out effects, or shrink content down to size once
something more interesting has appeared.

· The Enabled checkbox is used to temporarily disable geometry so you can see the undistorted
image in preview mode. Note that there is a separate Enable checkbox for Point Distortion which
is shown when you select that mode.

Using Sequences

The sequence editor has a built-in language interpreter that allows you to write complex sequences
using commands, variables and conditions.

Sequences are user-editable macros which can be called at any time from DeltaGUI or via external
control. They are useful for assembling a list of commonly-used playback controls, for example:

Sequence: ‘Announce’

Stop
Rewind
Reserve On
AudioLevel 0
Play
Delay 5s
Reserve Off
AudioLevel 10
Delay 10s
GlobalAudioFade up 5s

This sequence stops playback, rewinds, puts reserve mode on (an automatic fade), so the reserve
timeline shows, then plays the main show again, waits 5 seconds before turning reserve mode off (an
automatic fade back to the show) and restoring the audio volume setting. 10 seconds after that, the
audio level is faded up to this level over 5 seconds. The reserve timeline could be playing a movie
loop, or a static image or announcement, for example.

152

154
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Later will shall see that we can be explicit about timelines, using their names, stating which timeline is
stopped or played, and set our own transition effects between any timelines.

Sequences can be simple series of events that are used many times, or more complex routines using
global variables and conditional statements. They can address most parameters of timeline
resources by resource name, with user-defined variables, and one sequence can run another,
enabling an object-oriented approach to avoid duplicating common segments. Sequences are held as
individual .xml files (objects) and can be grouped in C:\sequences in branching folders.

Sequences are normally executed at 1 line per frame, to ensure smooth playback. However, a lengthy
sequence may then take too many frames to execute fully. To shorten this duration, groups of lines
can be executed as a single line in a single frame, by using the $startblock and $endblock keywords
before and after the lines to be run together.

Note the other special keyword here: $persistsequence, which ensures the sequence will not be
dropped when a new show file is opened.

Ways of Using Sequences via External Controls

Sequences can be run or triggered in a timed, triggered or manual manner, using:

· DeltaGUI Sequence Editor > Run  dialog

· the Delta web interface controls (Controller or Scheduler)

· DeltaShowControl with ADAM modules

· or by any other TCP or UDP connection, including Phidget controls via 7thConnect.

Using Sequences on Timelines

Sequences can also be dragged onto Timeline layers from Resources [Controls] in the normal way.
Therefore the sequence must first be created for selection, and named clearly for ease of use. To add
a required sequence, you can double click the icon or name in the Resource Pool and add details
there.

374
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Select the required sequence from the drop-down box at the bottom:

Alternatively, when a sequence icon is dragged onto the timeline, a dialog opens to select the
required sequence:
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Once on the timeline, the Resource Editor can be opened and the sequence resource addressed for all
its properties, and/or to select a different sequence from the drop-down list:

Non-sequence-specific timeline options are the same as available to any resource.

The General tab shows: that this resource name is a sequence type (uneditable), a reference for
external control (editable), and the name of the sequence (shows the sequence selected in the
Timeline tab, or if you type the correct name here, this will show in the Timeline tab).
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Sequences can also be used dynamically, assigning them to buttons . They can also be triggered
with external controls (e.g. using Designer widgets), or Phidget sensors and controls (using
7thConnect).

Sequences are created in the Sequence Editor (Add and Edit Sequences ).

Add and Edit Sequences

Open the Sequence Editor by clicking Sequences on the DeltaGUI control menu panel (above), or from
the Main menu, View > Sequence Editor.

382
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· Click ‘Add’ to start a new sequence. The new name will be added to the bottom of the list. To
reorder alphabetically, click ‘Reload’.

· Highlight an existing sequence to delete or rename it.

· If known sequences on the server do not appear, click Reload.

To group your sequences by function (for example) add a new or existing subfolder to the sequence
name when you create it:

From here, you can control the timeline, change resource parameters, the video and audio levels,
whether to go into reserve mode, add or delete sequences, and edit the content of each sequence. By
default, sequences are held in the C:\Sequences folder, one sequence per XML file.

When run, a sequence affects the server that it is on. Where there is a Leader-Follower relationship,
the same commands can be phrased as ASCII-UDP instructions to the IP addresses of Followers.
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What commands can you use?

Click the [Help] button for the list of external control commands, annotated for those that are non-
sequence, or sequence-only commands. Examples of use are given, with basic rules in the header
to the Help page. This page on your server will relate to the version of Delta you are using. A few
commands may not be available in other versions.

Here are some example commands:

EYEGOTOXYZ x y z
Move the interactive mode eye-point to X Y Z (in mm)

EYEGOTOXYZAZEL x y z h p r
Move the interactive mode eye-point to X Y Z (in mm)
Heading, Pitch and Roll (in degrees)

DELAY time
Delay the sequence for the amount of time specified. This can be written as 100ms, 1.2s or
100f for 100 frames.
Note: Avoid TimelineOpacity commands in the same sequence as Delay commands; place
TimelineOpacity in its own sequence.

SENDASCII text telnetport
Send this text out of the Telnet port.

SENDASCIIUDP ipaddress port ascii
Send the ascii string to the ipaddress and UDP port

SENDASCIISERIAL Comport baudrate parity databits stopbits ascii
Send the ascii string to the Comport.

Version 2 SENDASCII Format

SENDASCII2 data="any text" port=telnetport
Send this text out of the Telnet port, note that it is 1001 for the first connected device on a
multi-Telnet port, 1002 for the second etc.

SENDASCIIUDP2 data=text ipaddress=ip port=theport
Send the ascii string to the ipaddress and UDP port

SENDASCIISERIAL2 data="any text" port=theport baudrate=thebaudrate parity=p databits=n
stopbits=s
Send the ascii string to the Comport with the parameters specified
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SENDASCII2 Examples

SENDASCII2 data="some text \x0d" port=1002

SENDASCIIUDP2 data="some text \x0d" port=1002 ipaddress=10.100.101.102

SENDASCIIUDP2 data="some text \x0d" port=$myport ipaddress=$myipaddress

SENDASCIISERIAL2 data="some text \x0d" port=COM2 baudrate=38400 parity=n databits=7
stopbits=1

TESTPATTERN name
TESTPATTERN pattern=crosshatch x=50 y=20 or TESTPATTERN pattern=pixelgrid enable=true

BEAMS [r g b rg rb gb rgb ]
Set the overall beams

GEOMETRY [ on/ off ]
Set the overall geometry on or off

BLENDS [ on/ off ]
Set the overall blending on or off

Sequences can be called from external control via the Sequence or SequenceAll command; you can
also list the available sequences using ListSequences, and reload them using ReloadSequences.
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Debug Sequences

Select the Debugging checkbox (bottom right) to show the Watch and Trace windows (right) on the
sequence editor. These will show in all the sequence tabs:

In the sequence above, the Tracecomment command sends any text to the Trace window, the
Tracevar command sends the value of the $myipaddress global variable and the watchvar command
sets the $count global variable to be shown in the Watched Global Vars window.

Debugging Commands

Traceclear
Clear the trace messages window

Tracelist
Output a list of global variables to the trace messages window, optionally only the Watched
variables

Traceon
Turn on tracing
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Traceoff
Turn off tracing

Traceseqname
Trace the current sequence name to the trace window

Tracenoncode [off/on]
Show every active line of the sequence (not including code lines) in the trace window

Watchclear
Clear the watched variables

Watchvar $variablename [off / on]
Turn on or off Watching for this variable

LOG message="[string]" file=[c:/filename.txt] timestamp=[y/n] level=[level]
Log a message. File is optional and can be a relative or absolute path to a file, if no file is given
the message will log to the delta log file, the directory must already exist. Optionally timestamp,
default is to add timestamp. Optionally record a level, level can be NOTE, WARNING, ERROR,
FATAL

Run Sequences

By choosing [Run Sequences] from the Sequence Editor, a set of 100 buttons are presented in 5
pages. You can set each one to any of the available sequences for immediate use.
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To make the pages distinctive, each one can be given a different background image (.BMP only).
Select Background > Load Image for the background and Draw Box Background to give a contrasting
background to the sequence names. Backgrounds only show when the Lock checkbox (top right) is
selected.
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Global Variables

You can add and use your own variables that can be used in any sequence. Select the Global
Variables tab in the Sequence Editor and click the + Add button. These variables are created in the
server and persist after closing.

The same dialog can be returned to, to edit a variable, by double clicking the variable name:
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Variables can also be created, set and read by sequences (see: ‘Global Variable Commands’ in Help).

Parameters

You can choose any name for the global variable, and it can be one of the following styles:

Int
whole number, value in the range -2147483648 to +2147483647

Float

floating point 1.17 ´ 10-38 to 3.4 ´ 1038

String
character array, up to 128 characters in length.

Attributes:

Read Only
Check this if the value cannot be changed within a sequence.

http://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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Watched
Check this if you want to be able to see the current value in the debugging panel (as shown
above; switched on in the Edit tab).

Using Variables

Variables can be used in sequences to control playback or media, for example this sequence creates
and initialises a global variable (similar to adding via the dialog above) to keep track of which timeline
is active:

Sequence InitialiseVars:

globalvar $i_ WhichTimeline = 0

This sequence then uses these variables to control show playback when the sequence is triggered
(from external control, from the timeline or from the buttons in the sequence editor).

Sequence ShowControl:

if ($i_ WhichTimeline =1)
 {
 play tl=2
 sequence TL1AudioDown
 sequence TL1VideoDown
 delay 1000
 stop tl=1
 $i_ WhichTimeline =2
 }
else
 {
 play tl=1
 sequence TL2AudioDown
 sequence TL2VideoDown
 delay 1000
 stop tl=2
 $i_ WhichTimeline =1
 }

This sequence interrogates the $i_ WhichTimeline variable and if it is 1, plays timeline 2, triggers off
other sequences which fade down timeline 1, then stops timeline 1 after a delay. It then sets the $i_
WhichTimeline to 2 so that the next time the same sequence is called, the Else part is called to
reverse the actions and start timeline 1 while stopping timeline 2.



379

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

A further example is a realtime clock, where a text resource is placed on the timeline and this
sequence is triggered (once only, since it keeps running) to update the text resource contents with a
string representing the current local time:

Sequence RTC:

#start
$mystringvar2=$currenttime
textparams MyRTC $mystringvar2 150 255 255 0 tl=1

Delay 500ms
gotolabel #start

In this sequence, the $mystringvar2 is a String type variable (previously created in a sequence or the
editor), and it is set to the reserved variable ‘$currenttime’ which fills it with (for example) 10:20:41.
The Textparams command then sets the resource named ‘MyRTC’ to this value and the text size is
150, the colour is 255,255,0 (yellow) and the timeline is 1.

Code Syntax

Comment

Can have full line comments like this or
$myvar = 2  // after the code comment

Compare

valid tests  =  !=  and  or  <  >
if ($myvar = $myvar2)
if ($myvar = 2)
if (2 = $myvar)
if ($myvar > $myvar2)
if ($myvar and 2)
if ($myvar!=2)

and/or only work on Int type variables
greater than or less than work on int or float type variables

Add, Subtract, Multiply, Divide

$myvar = $myvar2 + $myvar3
$myvar = $myvar2 + 2
$myvar = 2 + $myvar2

The above lines can use + – * /
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Concatenate arguments and strings

Addition with string variables concatenates them. Adding an int or a float to a string will concatenate
the int or float as a string.

mediainsert resourcename = $thisClip + $thisVersion
mediainsert resourcename = $thisClip + $thisVersion + "_444"
mediainsert resourcename = $thisClip + $thisVersion + '_444'
load "C:\\Shows\\" + $showName

Use to concatenate the values of variables as strings, and explicit strings, within the argument of a
function. Explicit strings can be enclosed by single or double quotes.

Create Global Variables

Global Variables can be int, float or string
globalvar $myintvar = 1
globalvar $myfloatvar = 6.54
globalvar $mystringvar = "movie"
globalvar $myintvar = 1  readonly

Adding readonly will create a variable with that value, which will not be written to the registry
thereafter.
Creating a global variable which already exists will do nothing.

Set a Global Variable

$myintvar = 12
$myfloatvar = 16.54
$mystringvar = "movie2"
$myvar = $myothervar

Special Variables

$myvar = $seqrandom[4,40]
Sets $myvar to a random value between 4 and 40

$myvar = $absoluteframe[2]
Sets $myvar to the current absolute frame of timeline 2

$mystringvar = $absoluteframe[1] smpte
Sets $mystringvar to the current absolute frame in smpte mode of timeline 1

$mystringvar = $absoluteframe[1] digits=5
Sets $mystringvar to the current absolute frame formatted to 5 digits where possible

$mystringvar = $currenttime
Sets $mystringvar to the current clock time of the server

$mystringvar = $currentdate
Sets $mystringvar to the current date in dd/mm/yyyy

$mystringvar = $currentdate usa
Sets $mystringvar to the current date in mm/dd/yyyy

$replacevarmode = [0/1]
0 is the default search replace mode, 1 is a simple string replace mode



381

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

Special Keywords

$persistsequence
Adding this keyword to your sequence will call this sequence to persist through filenew / open.

$startblock
All lines up to $endblock are completed in 1 frame

$endblock
All lines from start block up to $endblock are completed in 1 frame

Note : do not put Gotolabel loop inside start/end block as this will cause high CPU use.

Increment / Decrement

$myval++
$myval--

Conditional Branching

if (condition)
// Do something

else
// Do something else

Multiple if or if-else blocks are allowed, no nesting is allowed

Jump to lines

#start  // label is designated by #
$myintvar = 12
if ($myintvar>0)
$myintvar--
// do something 12 times
gotolabel #start

Note: the full list of sequence code supported is accessed from the Sequence Editor > Help button.

Active Sequences

Sequences that are running are shown in this dialog. When you run a sequence, it is given a unique
name of SequenceName_X where X is an internal counter.To cancel a specific sequence, right click
on it in the list and select cancel, or from external control call CANCELSEQUENCE entry-reset_1 from
the list below. To cancel all sequences, call CANCELALLSEQUENCES.

Note that this list is updated every 1 s.

https://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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Sequence Panel: Apply Sequences Dynamically

The Sequence Panel enables sequences to be applied and triggered manually from assigned buttons,
irrespective of any sequences applied to layers in a timeline. Indicators in the lower half of the panel
can be used to show any text or the value of any global variable and separately: set the related LED to
a specific colour.

To open the Sequence Panel, from DeltaGUI menu, View > Sequence Panel.

This shows on the right side of DeltaGUI and contains 6 initially blank, user-configurable buttons and 6
user-settable indicators for quick access to frequently required sequences.
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Assigning Sequence Buttons

The 6 sequence buttons can be assigned in two ways, using the mode button which cycles between
Active, Choose, and Edit mode.

Choose
click the button to which you want to assign a sequence, and from the drop-down list of all
sequences on the server, select the one you want.

Edit
click the button you want to edit, and type in the name of a sequence. This can be the name of
a sequence you have yet to create.

Return to Active mode and save the assignment by saving the show. Buttons with active, assigned
sequences will now run them when pressed.

You can also set the buttons from a sequence, for example:
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panelsequence index=1 sequence="ENABLE COMMS"
panelsequence index=2 sequence="DISABLE COMMS"
panelsequence index=3 sequence="MeshMove"
panelsequence index=4 sequence="MeshRewind"

Sequence Indicators

The sequence indicators can be accessed from a sequence, to set the colour of the LED or the text in
that slot:

$teststring = "My Indicator Text"
$replacevarmode = 1
SEQUENCEINDICATOR index=1 text="$teststring" state=none

$smpte = $absoluteframe[1] smpte
SEQUENCEINDICATOR index=2 text="$smpte" state=none

$myvariable=0
SEQUENCEINDICATOR index=3 text="My Variable 1" state=$myvariable

$myvariable=1
SEQUENCEINDICATOR index=4 text="My Variable 2" state=$myvariable
SEQUENCEINDICATOR index=5 text="Disabled Text" state=grey

State can be:

off, 0, false, red - to show a red LED
on, 1, true, green - to show a green LED
dis, disable, grey - to show a grey LED
none - to show no LED

Note the use of $replacevarmode=1 and double quotes around the variable to preserve the whole
value of the variable including spaces.

Serial Events

Serial event devices are XML-based files which hold a human readable name linked with command
bytes for the particular serial device. Permanent (open) TCP (client) connections are directed to the
required permanent TCP Connection as set up in Configure > TCP Connections (see TCP
Connections ).

An example of this file’s contents is:

<COMMAND0>

96
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<NAME> Play </NAME>
<DATA> PL\x0D </DATA>
</COMMAND0>
<COMMAND1>
<NAME> Power Off </NAME>
<DATA> \xBE\xEF\x00\x00\x00\x00\x00 </DATA>
</COMMAND1>

The human readable control list is shown in a drop-down list for that serial event device, and the
control codes shown below.

From this drop-down list of controls, select the control that this resource should send out when the
playhead plays past it.

The text in the Command Text box is what is sent out the serial port. You can enter ASCII characters
directly, or for non-printing characters for example, use the hex notation of \xEB to send character
235. You can edit this string directly and the new string will be saved with the file, but the Resource
Pool version of this serial Event device is not altered.

If you create a file named ‘External Control.7SE’ in the SERIALEVENTS folder, the contents of this will
be available when adding an external control event to the timeline. This allows standard external
control commands to be available. The format of this file is the same as other serial event 7SE files.

Ø See Appendix A: External Control  

RS232 or Telnet Serial Events

A serial event can be output to any IP address and port instead of an RS232 COM port by including the
following XML snippet (shown in red, note, this is case sensitive) in the serial event file:

451
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<RESOURCENAME>Telnet</RESOURCENAME>
<TELNET>
 <Active>1</Active>
 <IPAddress>192.168.2.8</IPAddress>
 <Port>25</Port>
</TELNET>
<SERIALEVENTS>

You can type in any default IP Address and port.

When the Telnet section is found in a serial event file, it is no longer available in the COM port list
(Configure > Preferences > Communications), and when you edit the properties, the IP Address and
port are shown on the Timeline tab. The serial event is sent out as a UDP packet to the specified
address.

Repeat Frames
Enable Repeat and this value sets the frame interval between repeated instances of this serial
event.

Repeat Count
Enable Repeat and this value sets the number of times this event will be repeated (1 = repeat
once more on timeline).

Add Frame
Enable this to append the current frame to any string output by this serial event

Colour LUTs

Colour LUTs are tables of numbers that apply colour transformations to images. These can be either
a quick way of modifying colour temperature, saturation, vibrance etc., or a more complex
transformation to a vintage look and feel, or that of a well-known movie. Rather than reprocessing the
media, the LUT can be used to modify the media at the point of projection, in Delta.

Colour LUTs have three functions: to calibrate colour, to change the colour space, or to add artistic
effect.

LUT files (.CUBE) must be placed in the C:\Colour folder or as subfolders. As other resources, drag a
Colour LUT into the required resource layer (or background layer), where it becomes effective for
movies or images in that layer, when in scope.

As with all timeline resources, right-click a colour LUT on the timeline to bring up the Resource Editor.
Here you see and can rename its External Control name, be precise about its position and edit its
timeline options.
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Layers and Render Order

Note that on a background layer, a LUT is applied to a particular channel. This can be useful in
balancing out colour between projectors, and a colour calibration application to derive a precise 3D
LUT could be used:

The two-channel playback image below shows the application of a colour LUT (left channel)
compared with the untransformed colour on the right channel:
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To apply a colour LUT to the entire canvas in a timeline background layer, assign copies of the LUT to
each channel.

As with all timeline resources, the render order is relevant. LUTs are applied in this order, and their
effect is additive: Layer 3DLUT > Layer 1D LUT > Channel 3DLUT > Channel 1D LUT.

Additional technical notes on colour LUTs

LUTs can be 1-dimensional or 3-dimensional. 1D LUTs are simpler and map each RGB channel
separately. 3D LUTs use the three colours as axes of a cube (hence the file type). 

Delta uses the standard .CUBE file format.

Splines

On the Splines editing page, you can select any of the pre-defined shapes from the Resource Pool and
add them to the timeline as with any other resource. Splines can be applied to any layers, including
the background layer.

Splines can be edited in the Display Configuration menu > Splines , where they can be saved as Pool
Resources.

Double click a Spline resource to edit its properties on the timeline.

163
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Spline Timing

By default, the spline is set to Equal Timed mode, where the total time of the spline is split equally
among the number of nodes in the spline, which means the speed between nodes is dependent on
the onscreen distance between the nodes.

In Node Timed mode, you can edit each node and change its time along the node, giving fine control
over speed.

The two modes are shown differently on the timeline, with Node Timed spline showing the time of
each node as a tick mark descending from the spline box, and Equal Timed spline showing the tick
mark within the spline body:
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Node-Timed Splines

To change modes and edit the node time, right click, select Properties and then Spline Properties.

To edit the node times, select Node Timed from the drop down, then double click one of the nodes to
edit the node location onscreen or the time of that node. Note that a node cannot be set later than the
next node or earlier than the previous node and that the first and last nodes are fixed at 0% and 100%.

Art-Net and DMX

Delta can output an Art-Net data stream (which can then be converted to DMX using Ethernet-DMX
convertors) and also take Art-Net inputs which can carry out any of the external control commands
within Delta.

Shown below is a timeline with various input and output Art-Net resources:
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Create Art-Net I/O Resources here: DeltaGUI Menu: View > ArtNet and DMX Editor

Edit Timeline resources directly with the Art-Net Resource Editor

Output Art-Net

Once output is enabled (see Config > Preferences > ArtNet and DMX), Delta is broadcasting an Art-Net
datastream to the network address(es) specified. With no Art-Net resources on the timeline, all
output channels will be set to 0.

Creating Art-Net output resources

Output Art-Net resources can be created using the Editor (DeltaGUI Menu: View > ArtNet and DMX
Editor), which is shown below with a typical 5-channel DMX controlled Floodlight device.

Base Address
This is the first active channel this device will have, so if set to 15 and choose the first output
channel as DMX Channel 1, this will actually be 15.

Mode > Fade
In Fade Mode, the output values will change from the previous value to the preset values over
this fade time, so by the end of the fade time, the values in that resource are active. You can set
the Fade Time in seconds in this mode.

Mode > Instant
In Instant Mode, the output values will change instantly from the previous value to the preset
values, so at the start of the resource, the values in that resource are active.

Mode > Tween
In Tween Mode, the output values will change to the values in the resource by the start of the

351
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resource, so the values smoothly change from the previous resource to this resource’s values
by the start of the resource.

In Instant or Tween Mode, the Tween Group is active (TG 0 – TG 65535). To separate different
instant or tween resources, you can put them in different Tween Groups, so that a resource with
TG12 will only tween from a previous resource also in TG12. A special case is Tween Group 0 (Global)
which till tween from any previous tweening resource, regardless of its tween group and also any
tweening resource ahead of the Tween Group 0 resource will tween from its values.

Mixing different Art-Net output resources

For the same Art-Net channels, you cannot mix Tween mode resources and Fade types (this will lead
to indeterminate values), but Tween and Instant can be mixed. This means that fade type output
resources should be kept on separate channels to tween or instant resources.

Note: All Art-Net output resources persist from the start of the resource, there is no end frame.

Art-Net and DMX Editor showing Output resource

The device shown above has 5 ‘Sliders’, where each one is assigned parameters:

Slider Name
Memorable name for this channel
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Channel Count
You can choose 1, 2 or 4 channels for this slider.

For 1 channel used, the range is 0 – 255

For 2 channels, 2 adjacent channels are ganged for a range of 0 – 65535

For 4 channels, 4 adjacent channels are ganged for a range of 0 – 4294967295

Note that if you choose higher channel count, adjacent DMX channels are used, so for example if
Slider 1 is Channels 1 and 2, Slider 2 should start at Channel 3 minimum, otherwise you have
overlapping channels with unpredictable results.

DMX Channel
The only (channel count of 1) or base (channel counts of 2 or 4) channel for this slider

Output Channels
This is an addition of Base Address and the base DMX Channel

Slider / Slider Value
You can use the slider to set the output value, or for more accuracy, type in the value

Enabled
Check this box to use this slider

Delete (Slider)
Press this to delete the slider

Fade/Instant/Tween
Choose the mode of this resource (see descriptions above):

Fade: Select the Fade time in seconds

Instant: Select the Tween Group

Tween: Select the Tween Group

Input Art-Net

This can be enabled separately from Art-Net output in the Config > Preferences > ArtNet and DMX
page. To show Input resources in the Art-Net and DMX Editor, press the Show Inputs button, then you
can select the pool or timeline input Art-Net resource from the list.

129
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Creating Art-Net input resources

Shown below is an example ‘mediacolour’ input device where the device listens to channels 1,2 and
3, and if any changes in values within those channels are detected, sends an internal MEDIACOLOR
command constructed from the Control Message and Slider Names as below.

In the next example, the Slider Names are X and Y, and the Control Message is MEDIAMOVE
resourcename %X %Y, so in this case the %X string in the message is replaced with the value of the X
Slider, %Y with the value of the Y Slider, so that that actual message sent internally is:

MEDIAMOVE resourcename 100 101

Which will change any visual resource with a name of ‘resourcename’ to 100 in X and 101 in Y.
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Note that if the Control Message does not find the %Variable name in the Sliders, it will send that
string directly, which may cause the command to fail.

SubNet
0 – 15, these are separate Art-Net SubNets which can be listened to

Universe
0 – 15, these are separate Art-Net Universes which can be listened to

Persist
If enabled, this Input device will listen from the first frame on the timeline onwards (no end), if
disabled, it will only listen if the timeline current frame is within the scope of this resource.

More Examples: Marker Selections

An input Art-Net resource is required to go to a marker depending on the value of Art-Net channel 1,
so you add an Input Art-Net resource to the timeline at frame 0, set it to Persist, then have one slider
with a name of ‘Name’, set to channel 1 and the control message is:

GOTOMARKER %Name

Or optionally, include the play command at the end
GOTOMARKER %Name play
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Now create markers on the timeline with Marker Name of ‘1’ and ‘2’ and place them on the timeline
where you need, then when channel 1’s value changes from 0 to 1 to 2, gotomarker commands will
be issued of GOTOMARKER 0, GOTOMARKER 1, GOTOMARKER 2 and since the marker exists for 1
and 2, these commands will succeed, where the value of 0 will do nothing, since there is no marker
named ‘0’.

More Examples: Setting Global Variables

An Input Art-Net resource is required to set 3 global variables for use by a sequence, so you add an
Input Art-Net resource to the timeline at frame 0, set it to Persist, then have three sliders with names
of ‘Ch1’, ‘Ch2’ and ‘Ch3’ (set to channels 1, 2 and 3) with the control message:

globalvarset cmd=realtime $ch1=%Ch1 $ch2=%Ch2 $ch3=%Ch3

When any Art-Net values in channels 1, 2 or 3 change, the command is issued like this for values of 3,
45 and 88:

globalvarset cmd=realtime $ch1=3 $ch2=45 $ch3=88

This in turn sets (or creates and sets) $ch1, $ch2 and $ch3 variables to the values shown, which can
be used within any sequence, for example to control media colour, position etc. The benefit of this is
that the values can be manipulated in the sequence, for example offsetting or scaling them as
required based on other inputs or variables.

The cmd=realtime is used to speed up this command, disabling logging so that for fast movement of
channel values, the command is actioned as fast as possible.

More Examples: External Control LCTimeline

This Logic Control command is for real-time conditional actions based on an integer value. Example:
play="75,50,100" will cause the timeline to play if 75 is between 50 and 100. This is most useful for
Art-Net commands where 75 would be replaced with the value of an Art-Net input.

In the following example, actions have been assigned to a series of 7 named Art-Net/DMX faders
(named variables %fader1, %fader2 etc.). The full LCTimeline control is:

lctimeline rewind="%fader1,0,20" stop="%fader1,40,120" cue="%fader1,160,220" play="%
fader1,240,255" tl=1\r\n
lctimeline rewind="%fader2,0,20" stop="%fader2,40,120" cue="%fader2,160,220" play="%
fader2,240,255" tl=2\r\n
lctimeline rewind="%fader3,0,20" stop="%fader3,40,120" cue="%fader3,160,220" play="%
fader3,240,255" tl=3\r\n
lctimeline rewind="%fader4,0,20" stop="%fader4,40,120" cue="%fader4,160,220" play="%
fader4,240,255" tl=4\r\n
lctimeline rewind="%fader5,0,20" stop="%fader5,40,120" cue="%fader5,160,220" play="%
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fader5,240,255" tl=5\r\n
lctimeline rewind="%fader6,0,20" stop="%fader6,40,120" cue="%fader6,160,220" play="%
fader6,240,255" tl=6\r\n
lctimeline rewind="%fader7,0,20" stop="%fader7,40,120" cue="%fader7,160,220" play="%
fader7,240,255" tl=7

Pool and Timeline Resources

There are 2 built-in Output Art-Net resources (‘Blank’ has no channels, and ‘Demo ArtNet’ has 5 active
channels) and 1 built-in Input Art-Net resource (‘Demo Input ArtNet’ has 3 input channels connected
to a Mediacolor external control command).

When you edit a Built-in Pool resource, changes are discarded on server exit, but if you create a new
Output or Input Pool resource, this is saved into the C:\ArtNet folder as a small XML device file and
any changes you make are reflected to that device on disk immediately.

When you edit a Timeline resource, changes are instant and will be saved into the normal show XML.

Common Controls to Input and Output

Create Copy
Copy the current selected resource to a new one.
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Reset
Remove all sliders from the selected resource.

Create New
Create a new blank device.

Add Slider
Add one slider (will be added after the last active channel).

Add Multiple
Add multiple sliders at a set base channel.

Arrow Buttons
Navigate to the next, previous, first or last slider.

Delete (Resource)
Delete the selected resource on the timeline or resource pool. Note that you cannot delete the
built-in pool resources (Demo ArtNet or Blank ArtNet) and that deleting the others permanently
removes them from the server (from the C:\ArtNet folder).

Note that editing an Output Art-Net resource from the timeline (using the normal resource editor)
gives a cut down version of this dialog where you can change most parameters apart from
Channel, Channel Count and you cannot add or remove sliders from this dialog.

Playlist / AV Assembly

These are a Container  type resource.

A playlist is a resource which can contain other resources (known as child resources), which can be
movies, images, audio, text and capture types. These continually play in sequence, independent of
the timeline playing or not, so the server does not have to be playing for the movies, capture etc.
inside the playlist, to be playing.

AV (audio-visual) Assemblies , are Containers designed to hold one movie and N audio resources
for that movie, so that they are kept together as a group. For example, a single movie and 6 audio
resources can be placed in to the AV Assembly, then this resource can be moved around the timeline
as a grouped set of resources.

Playlists are simple ways to create a running show – add a playlist to the timeline, then drag and drop
resources into the playlist resource from either the timeline or the resource pool. If the playhead is
anywhere in scope of the playlist, they will play in sequence, looping from the end item to the start
automatically.

53

404
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Once a playlist has been populated, you can edit it by right clicking and choosing Edit Playlist
Contents, which shows the dialog below for the selected playlist.

In the dialog above, 4 movies are shown, which will continually play from top to bottom – you can
move items up or down the list using the arrow buttons shown, select and delete one child resource
or empty the playlist using the Clear All button.

The item that is currently playing is shown in a different colour on the left whilst on the right, the
length of the movie, fade up and down time and play mode is shown. By default, each child resource
is added with a default length:

Movies Native non-looped length of the movie

Image 10s

Audio Native non-looped length of the audio

Capture 10s

Text 10s

General notes

· You can remove items from a playlist by right clicking on it and choose Detach from parent.

· Multiple playlists can be in scope at the same time (subject to the performance limits of the
server) so that you can spatially separate them using playlist or resource overrides on the screen
location.
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· You can save a preset of a playlist or AV Assembly which will then appear as a resource in the
Resource Pool – when you drag this preset onto the timeline, it will contain all the saved child
resources as well.

· When you drag a playlist or AV Assembly to the wastebasket or delete by some other means, all
child resources are also deleted from the timeline

· The Current and Next items in a playlist are shown on the resource, with progress bar showing
how far through the current item is.

Individual Child Resource Overrides

You can edit each resource and change this length by double clicking or right clicking to choose
General Override Properties for that child resource. In the image below, the ‘Mountains and Snow’
movie is shown overridden to 12s instead of its native 15s length. In the main playlist editor, this is
shown in green as 12s* to indicate it is overridden from native properties.

Note that audio and video will be seamlessly looped if necessary to meet the set duration.

Also on this dialog, you can override the play mode from its default of playing once before moving
onto the next item. Other modes available are:

Play N Times
Choose to play a set number of times before moving on
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Repeat Until Triggered
Continually loop this child until a trigger is received from external control (PLAYLISTNEXT with
or without Immediate) or using the Advance or Advance At End of Clip buttons. This will also
transition with any set fades.

Force No Loop
Play this item once only and then show black until triggered

Other items on that dialog are:

Start from last item played
When the playhead plays into the playlist, choose to always play the first item or the last one
played by that playlist.

Audio Visual Offset (AV Assembly only)
Offset the audio from the video in an AV Assembly (see below) in seconds, this can be negative
as well.

Set Timing from Longest Audio File (AV Assembly)
For an AV Assembly only, choose the length of the AV Assembly from the longest audio
resource instead of the default movie length.

Sync to Leader / Control Name
Follower only, in order to sync up a playlist on Leader and Follower servers, with this set, will
trigger the same items on both servers at the same time. This requires the external control
name of the Follower playlist to be the same as that on the Leader. If the items are not the
same, so some are missing on the Follower compared to the Leader, black will be shown on the
Follower.

Global Playlist Resource Overrides

It is also possible to override all child resources by right clicking on the Playlist itself and choosing
General Override Properties.
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In the image above, the Playlist item overrides are shown, with a 30 s duration and cross fade of 1 s.
All child resources are shown green with 30 s* to show they are overridden.

Note that the 12s override previously set on the single child resource is overridden by the global
playlist parent resource to 30s.

Other controls specific to Playlist level overrides:

Fade Up / Fade Down
Set the time in seconds for the child resources to fade up and down

Cross Fade
Instead of fade up/down to black, start playing the next item while the existing one is playing
and fade the current one down, achieving a cross fade between the items. 

Note that if the two adjacent resources are movies, you are requesting double the bandwidth
from the server during the crossfade time, which may impact performance.

More Detail

In addition to overriding duration etc., on the dialog above, you can override many other things such
as screen location, colour and more. To set these override values, right click on the Playlist item (from
timeline or the playlist editor) and choose Resource Override Properties. This shows the common
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resource editing dialog pages as shown below, but with the addition of an Override Children checkbox
in the lower left corner of each page.

In the example shown, the playlist screen location is set to X,Y 0,0 and 1920 ´ 1200 in size.

With the Override Children checkbox selected, all visual child resources will be forced to this size. All
Override Children checkboxes are also shown on the right side of the Edit Overrides dialog for a quick
way to enable them.

Audio Visual Assemblies

Also known as AV Assemblies, these Containers are designed to hold one movie and N audio
resources for that movie, so that they are kept together as a group. For example, a single movie and 6
audio resources can be placed in to the AV Assembly, then this resource can be moved around the
timeline as a grouped set of resources.

AV Assemblies can contain any single resource from the following list (Movie, Image, Text, Capture)
as well as a number of audio resources – you cannot drag in a second visual resource from that list.

You can construct an AV Assembly by dragging a ‘Demo AV Assembly’ which is empty onto the
timeline, then dragging audio and visual resources into it. You can edit it as before by right click and
choose AV Assembly Contents as shown below:
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You can override individual resources as before (right click on a child resource, choose General
Override Properties) or override all child resources (right click on the Demo AV Assembly and choose
General Override Properties). You can also override resource properties of all child resources as
before (right click on the Demo AV Assembly and choose Resource Properties, then choose which
pages to override).

To move an AV Assembly into a playlist, move it from a different layer than the playlist.
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AV Assemblies, once created, can be dragged into a playlist as shown below:
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In this case, all audio and visual resources within the AV Assembly will be played as a set.

Timeline Effects

Timeline effects supplied with Delta include dynamic effects
that are addressed solely via External Controls, and timeline
effects.

Timeline Alpha: applies to the background layer and fades
the current timeline between transparent and opaque.

Transparency: applies to the resource layer and fades the
layer between transparent and opaque.

Fade: applies to the resource layer and fades the layer
between opaque and black.

Transform Animator: applies to the resource layer and
applies configurable motion affects to resources in that layer
(see Transform Animation ).361
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For effects controls, double-click on the effect in the timeline to open the Resource Editor. Properties
of the effect in the Timeline tab are simple and typically include direction, level and duration.

Shader Effects

Shader effects in Delta allow users to create and control the behaviour of the way all media assets
are rendered, through Delta Effects, by writing OpenGL fragment and vertex shaders. Effect
parameters can be controlled via External Controls .

Creating and using effects

Effects can be controlled either through the DeltaGUI or via external control over TCP, UDP or HTTP.
This guide demonstrates the process of creating and controlling effects, using the above sample
effects created by 7thSense for you to use and experiment with.

Users with Notch Builder or Playback licences and keys, can import and apply DFXDLL files. Files are
added to the C:\Effects\Notch folder.

Ø Using Notch Effects  

Delta Effects File Extensions

There are three file extensions which may be used to create your effects: .xml files are used to define
the properties for control within a shader, whilst .frag and .vert are the OpenGL shaders used to
create the Delta Effects functionality. Each effect may have a frag or vert file, or both.

xml files

This simple example demonstrates the basic code structure:

420

413
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<Type>
Effect, Colour or Transition

<Name>
the name of the effect

<Description>
a short description of the effect

<PropFloat>
Property Float (or PropInt for an integer)

<Index> unique index number for each property

<Name> name of the property

<Description> description of the property

<Default> the default setting for that property on initial selection

<Minimum> the minimum setting that the property can reach

<Maximum> the maximum setting that the property can reach



410

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 2: DeltaGUI Software

frag files

Each frag code consists of 3 functions as seen in the example below:

· userTexturedMod()

· userSampleMod()

· userColourMod()

fCustom[n] lines link to the PropFloat [Index value] line of the xml.

Note: you should use iCustom[n] if integer values are declared in the xml.

For more information on writing frag files, see the examples in the Using Delta Effects section below.

vert files

Vertex shader capability is currently in early development and as such, it is provided as is and will be
expanded over time. We welcome your feedback on the possible further development of this area.

Using Shader Effects

In Flatplane mode, Effects resources may be applied to the background (to affect all layers), or to
media layers (to affect all media in that layer), in the DeltaGUI.
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In Dome (Frustum) or Mesh mode, Effects resources may only be applied to media layers.

Click on the Effect to reveal its properties and a range of effect parameters in the form of slider
controls.

Double-click to open the general properties dialog.
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Note how the Effect parameters on DeltaGUI relate directly to the functions in the frag file:

Number of blocks = blockCount, Transition Size = transSize and so on …

Using Multiple Effects

Effects are not additive, and are opaque, so as in image or movie resources, cannot be run
simultaneously in the same layer. Only the first effect can be seen. However, you are able to run one
effect after another in the same layer.

Where effects overlap in different layers, including the background, lower effects will only be seen
during the overlap where an effect in a higher layer runs to or from transparency. So, for example, a
Gradient Fade Transition in an upper layer can reveal a background Shimmer.

Degradation Shader

Using the Degradation shader (available from December 2020) enables you to swap between 4:2:2
and 4:4:4, and/or between 8-bit and 10-bit on the fly.
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These are not true sliders:

· 1 = 4:2:2, anything less than 1 = 4:4:4

· treat the bit numbers as integers (e.g. 8.4 means 8-bit).

Using Notch Effects

Licensed users of Notch visual effects can build their own effects, or use
predefined Notch effects.
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For the Notch file to be interpreted by DeltaServer, Notch Playback (or Builder) and an appropriate
Notch key and driver are required to be installed on the Delta Media Server. Without this, Notch
Effects resources cannot be processed.

When compiling a Notch Block for media server, create a 64-bit target, unless specifically requiring 32-
bit. The Notch designer must expose those parameters that the player will want to manipulate, so
that they appear in DeltaGUI as available (see illustration below).

These Notch Blocks are saved as DFXDLL files, which should be copied to the C:\Effects\Notch
folder.

Notch effects files will now appear in the Effects resource area under their file names, when the list is
refreshed. The refresh action creates the required Delta XML file. As with all effects, the DFXDLL and
XML files must remain in the same location.
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Note how here the /Notch Layer parameter stays visible at the top of the parameter stack, so that
Notch layers can be selected and their parameters dynamically changed.

Performance

The additional load placed on a media server will depend on the complexity of the Notch effect and
the framerate being used.
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Creating Slideshows

This DeltaGUI wizard can help setup a quick slideshow (chain) of audio, images or movies (Wizards >
Create Slideshow).

From the initial dialog, choose one or more audio files, images or movies (optionally filter the type
using the check boxes in the top right), then click the add (+) button to add them to the list. If you hold
Control down while clicking, you can select multiple resources before adding, hold Shift down to
select multiple from the first selected resource.

Once in the lower Timeline Resources area, you can select them and remove (again with Control or
Shift) by clicking the subtract (–) button. If you want to re arrange the order, select one resource, then
click the up or down arrows in the right side to move.
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Once the list is complete, press the Next button to move onto the options page.

On this page, select the various options as described below and press Create. The result will be
inserted into the requested layer, with each ‘slide’ being automatically faded up and down in turn.
These remain separable resources, whose properties can be adjusted – or disrupted if treated
casually.

Once the slideshow is created, save it as any other show to a new name.

Timing

Time per Resource
Defaults to 6s, choose this for the amount of time a resource is visible.
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Transition Time
Defaults to 1 s, choose this for the amount of time crossfading. For no cross-fading, set to 0.

Options

Movie Auto Play
Turn on autoplay for all movies in the slideshow.

Add Timeline Loop at End
Add a loop at the end of the slideshow so when playing, it loops and restarts.

Use Movie Natural Length
Instead of the Time per Resource value (default 6s), use the movie’s native length.

Keep Existing Timeline resources
Disabled : Delete existing (non-background) content, then insert all slideshow resources
starting at frame 0.
Enabled : Do not delete existing resource on the timeline before creating the new slideshow.
The slideshow contents will be inserted from the current timecode onwards, so you can build
part of a slideshow in one session, move the current timecode, and choose different resources
to insert at the new position, without disturbing the previous contents.

Placement
Fullscreen makes each resource fill the whole canvas
Fit Canvas will maintain the aspect ratio of the media, fitting the height or width to the whole
canvas as required.

Text Overlay Position

Add Filename Overlay
When enabled, use the parameters in this area to show a text overlay of the current resource
filename with a coloured bar behind it for clarity.

Text Size
V Small, Small, Medium or Large for the text overlay text size.

Text Colour
Colour of the text overlay.

Overlay position
Top or Bottom of the canvas..
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Background Transparency
off (no bar), 25, 50, 75% and Opaque for the bar behind the overlay text.

Background Colour
colour of the bar behind the overlay text

Marker Options

Add Marker at Each Resource Start
Places a marker at the start frame of each resource, named "Slide1", "Slide2" etc.

Start Marker Stops Timeline On Play
If enabled, each marker has the Playing Action set to Stop so that playing into each marker
stops the timeline.

Add Prior Marker Before Resource Start
Add another marker before the resource start – the Number of Frames Before Resource Start
box is used here. This is used if a customer wants to skip to just before the next item in the
slideshow by using the Ctrl+Arrow keys in DeltaGUI.

Prior Marker Stops Timeline on Play
If enabled, Prior marker has the Playing Action set to Stop so that playing into it stops the
timeline.

Mesh Options

Eye-point
Choose which eye-point to place the slideshow resources on when in Mesh Mode.

Create
Press this to create the slideshow.
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External Controls

Once the show is created with the effects positioned on the timeline, you can control the effect
properties via external control (Telnet, UDP or HTTP). TCP and UDP control is documented under the
DeltaGUI Help button. HTTP is available through the latest version of our Delta  Web Service, (see
separate user guide).

Secure Communications

For secure communications, e.g. using PuTTY, SSH can be enabled (see Communication
Configuration ).107
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Connect to your server IP using appropriate software (e.g. PuTTY in this example) to access the Delta
show.

Type commands into the console (e.g. status) to return the data required

You are now able to access and control the properties of effects that you have on the timeline. Some
examples include:

listeffects source=timeline

returns

name=Venetian Concentric with Warp Transition:ctrlname=ShaderEffect_11313
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geteffectparams ctrlname=ShaderEffect_11313

returns the parameters of the effect

(resource and property names and values)
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External controls also allow you to change the properties of an effects resource:

Seteffectparams ctrlname= ShaderEffect_11313 propertyname="Vertical Centre" value=0.8

Note the quotation marks around the propertyname: without them the system will not see the name
(as in the first example above)
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Your changes will be reflected in DeltaGUI and display output.

Ø See Appendix A: External Control  451
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Viewing and Previewing Shows

Delta (v. 2.4 and later) has a web browser-based Preview function via Web Real-Time Communication
(WebRTC). [Please see Delta User Guides prior to v. 2.4 for information on previous Preview
functionality.]

WebRTC streaming allows Delta Playback to be previewed in a browser (Firefox or Chrome are
recommended). Preview is available from either DeltaGUI, or by logging in remotely to any connected
Delta server via IP address, using Delta Web Service, which is based on the widely-used open source
Apache web server.

Enable WebRTC Preview

To use the WebRTC preview capability you must enable WebRTC Preview in the DeltaGUI
Preferences screen:

· In DeltaGUI, click Configure > Preferences > Preview Window

Click the Enable WebRTC Preview checkbox, then click OK.

Preview Format is also used to fit the web Preview frame to your canvas.

Note: The Peer Name and Port details default in automatically but even if you change them,
Preview is programmed to search and find appropriate details on connection, so it won’t matter if
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you want to call the server by another name.

Enable NDI® Preview (from Delta 2.6)

With an NDI viewer, you can instead preview a show in an NDI monitor such as NewTek NDI® Studio
Monitor, or MediaLooks. The size viewed via NDI is the Display > Preview Setup > Canvas Size:

Note that to view the info., stats or graph in NDI, you will need to turn these on in the usual way
through the Config button in web preview (with WebRTC also enabled).

For displaying movie frame title, number or time, you can apply a Movie Timecode text resource. See
Resource Editor: Text .

Using Delta Preview

The preview window is launched from DeltaGUI or from within Delta Web Service. See Managing
Delta-Servers: Delta Web Service.

345

https://www.newtek.com/ndi/sdk/
https://www.newtek.com/ndi/sdk/
https://www.medialooks.com/video-transport
https://portal.7thsense.one/user-guides/MC255-managing-servers/mds_delta_web_service.html
https://portal.7thsense.one/user-guides/MC255-managing-servers/mds_delta_web_service.html
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From DeltaGUI

Click the Preview button (top-centre of DeltaGUI). The Preview window opens in a new browser
window and shows live preview of the show. From Delta 2.7, this is an https:// connection to the IP
address of your server, port 8484 (e.g. https://1.100.101.227:8484).

Delta Preview Window

The preview window in browser reflects live playback and has the same options to show information,
playback statistics, performance graph and audio VU meter as the playback window. Click Config:
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Click Config again to close the options. The size and position of stats text and graph lines are
controlled from the Playback window, not the browser page.

From here you can navigate to other Web Service features. See Delta Web Service in the user guide,
Managing Delta Servers.

Ø See more controls and explanation in Playback Window  

From Stack Overview (optional install)

Open a web browser and connect to the IP address of your server, port 8000 (e.g.
1.100.101.227:8000). From Overview, select the required server, and connect to preview live:

37

https://portal.7thsense.one/user-guides/MC255-managing-servers/index.html?mds_delta_web_service.html
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For full details on the Stack web interface, see the DWS User Guide.

Preview External Controls

The Delta Command line accepts the External Controls as listed in DeltaGUI, Help > External Control.
Click the send button to send the string command to the Delta server.

https://portal.7thsense.one/user-guides/MC255-managing-servers/mds_delta_web_service.html
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Recording

A show, or part of a show, can be recorded to disk, in effect compositing all the layers into one for
reduced load, or playback on another machine.

Recording is also used for carving media between channels to optimise bandwidth, by presenting
each channel with only its required part of the media.

See the section on Real-Time Recording  if you need to record live capture to disk as well.

Art-Net Recording  enables Art-Net inputs to be recorded and then rerun in simulation scenarios.
This may be useful in optimising inputs, or to allow inputs to be simulated as shows are developed.

To set up recording, click the red Record button on the timeline controls:

This will bring up the main dialog, with three tabs, for each kind of recording.

(Note that recording is not enabled in reverse playback mode.)

Record a Show or Carve Media

Clicking the Record button on the timeline controls brings up the following dialog.

Create the job

Here two recording jobs have been set up:

435

437
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A Job is a recording event, comprising channel selection, duration, resolution, output format and
destination. A number of jobs can be created, and checked items will run sequentially. In this
example, two recording jobs are set up, one at full resolution and one at low resolution.

Path Variables

This button offers help on using variables to define the path names:

Add a recording job

Start by adding a job. You can also select an existing job, press ‘Copy’ and edit the details to create a
similar one:
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Double-click any job to edit its details.

Path
Usually in E:\movies, append the folder name you want to use. (Here, we just called it
‘MyShow’). In this folder, if you are recording more than one channel, assign the channel
subfolders using these variables exactly as written here, for automatic naming:
{channelName} will append the channel names you have given in your show (they can be
renamed before you record)
{resName} will append the name of the resolution template (see below) that this job will use

Base Name
This is the name for the recorded movie, which will be the prefix for every frame, to be followed
by the automatic addition of frame numbers and file extension. If the frame name is to be the
same as the channel and resolution variables used in the path, type @@

Offset
This is the number from which you want the frame sequence to begin.

Number of digits
Choose enough digits for the number of the last frame (including any offset).

Start and Stop
These can be defined in SMPTE, frames or seconds, or ‘Set to Show Length’ for the whole
length of the show.

Press OK to return to the main dialog.

Configure the Output

Resolution Templates
Multiple resolution templates can be added and named:
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Channel Names
This is not local naming, but the names already assigned in the show. They may, however, be
edited here.

Channels (to record)
Select the required job and use the checkboxes to select which channels are to be recorded for
this job.

File Type
Choose your required format from the drop-down list:
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Note that JPG and PNG frame sequence formats cannot be played back on Delta.

Skip Existing
Skip any movie files already in that folder. If recording a large show in parts, use File Offset to
resume numbering the frames at the right point each time and Skip Existing to avoid
inadvertent frame duplication.

Filter Movies
With Filter Movies on, during recording, there is an additional filtering render pass performed
(called MipMapping) which can improve the quality of the recorded imagery, especially if there
is also a change in resolution such that the output recorded resolution is lower than the source
material.

Force Patterns, Grid, Playback Statistics and Graph
Check this to ensure these diagnostic and alignment aids are turned off before recording.

Pack 7TH Files in 10
This should be left blank for an SSD based server, but for standard HDD based servers, this
should be checked.

Record the Show

Pressing RECORD will start the server recording as configured above, the Recording button will go red
and the record button on the main GUI is shown surrounded by red. You can press the timeline Stop
control to stop recording or press the red RECORDING button:
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Files output from this example

Note that for multiple channels, the frame is advanced, then all channels are saved to disk for that
frame, before moving onto the next frame.

Ø See also: Carving Media for Dome Displays 

Real-Time Recording

Real-time recording (previously referred to as Preview recording) is recording of every frame to disk
(including live capture) in a fixed format of 7th 4:4:4:4. This is in contrast to the standard recording,
which is non-real-time (so would not capture any live capture frames to disk). Real-time recording is
started and stopped from the DeltaGUI dialog, external control or sequence commands (see below)
and the record path and filename are configured in Preview Recording page of the Recording dialog,
or through commands below.

Note: Real-time recording must be enabled in Preferences > System ‘Enable Real-time recording’.

Real-time recording is independent of the play mode of the timeline, so it can record all output
including stopped sections of a show.

https://portal.7thsense.one/user-guides/MC256-managing-media/mm_carving_media_for_dome_display.html
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Recording a show, and real-time recording cannot be performed simultaneously: starting one after
the other will stop the first.

The recording location can be accurately set in the Recording dialog (press the Record button to
access) or by using the external control / sequence commands:

In the dialog above, the output resolution of the recorded movie is linked with the Preview format, so
choose one of the presets from the GUI (Network & Recording) Preview Format dropdown, or choose
custom and enter the Custom Recording Format in the boxes provided.

Start & Stop with record button
Enabling this option starts the timeline playing after you press the Record button on this page –
note that due to the nature of preview recording, there will be additional recorded frames
before playing and after stopping.

Note that if Server (Hardware) Preview Format is selected (assuming preview hardware is fitted to
the server), this chosen format overrides the preview & recording format.

Once Real-time Recording is started by pressing the Record button on the dialog, the button turns
yellow to show recording is active and the Record button on the main GUI window is surrounded by
yellow as well.

Note that pressing the yellow Recording button stops real-time recording (or an external control
command) – by design, Play & Stop do not stop real-time recording.
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External Control / Sequence commands

REAL-TIME_RECORD mode=[start / stop / continue] Start or stop preview recording with the
configured parameters. If disk is full, you will get back REAL-TIME_RECORDSTATUS=DiskFull and
recording will not start. If already recording and send in start or continue, you will get back REAL-
TIME_RECORDSTATUS=AlreadyRecording and recording will not start

REAL-TIME_RECORDSETTINGS [fullpath=path] [filename=file] [startframe=start] [stopframe=stop]
lockgui=[true/false] [OutputPixels=W] [OutputLines=H] Set any of the preview recording parameters.
If recording is already started, this command will be ignored and you get Status=Error
StatusInfo=AlreadyRecording

Note that for a path, you must escape backslashes and quote like this: "e:\\Movies\\My Path"

REFRESHMOVIE drive=[A,B,C,D...Z] Refresh Movies in the specified drive to get an up to date list

DELETE_DISKMEDIA [resourcename=name] [controlname=ctrl] Delete the specified resource from
disk, pool and timeline permanently.

A typical usage would be to configure the record path and filename, then start recording with REAL-
TIME_RECORD mode=start, play the timeline for the active part, then issue REAL-TIME_RECORD
mode=stop. The show control system would then call REFRESHMOVIE drive=E to make the server
aware of the new movie, use MEDIAINSERT… to insert it onto the timeline, and play the newly
recorded movie. If this recorded movie is not required permanently, issue DELETE_DISKMEDIA
resourcename=recordedmoviename which deletes it permanently from the disk.

Art-Net Recording

This feature enables Art-Net inputs to be recorded and rerun in simulation scenarios. This may be
useful in optimising inputs, or to allow inputs to be simulated as shows are developed.
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Start
first DMX channel to record

End
last DMX channel to record (recording includes all channels between Start and End)

Universe
Universe being recorded

Subnet
Art-Net Universe being recorded

Save as
the number of bytes which make up a data point to be recorded

Input Network
The IP from which the recording is being listened to

Input Subnet
The IP subnet being listened from

Number of frames to record
This is the number of Art-Net frames to record (not movie frames).

ArtNet Input Enabled
This is essentially the same checkbox that can be found in Config > Preferences > ArtNet & DMX
to enable Art-Net input.
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Loop playback at file end
Plays the Art-Net recording continuously until playback is cancelled.

Set Save file
Set the file to record to. When this is set, and Input is enabled, the Record button becomes
available.

Set Playback File
The file to be read from, in order to playback Art-Net. Once this is set and Art-Net input is
disabled, the PlayBack button becomes available.

External Controls

Use the External Control (listed under ‘Recording Commands’): ARTNET_RECORD. 

With this control you can set any of the Art-Net recording parameters. Use Recording Mode to change
whether you’re recording, playing back or neither. Note, you will need to ensure you are in the correct
Art-Net input/output mode, See ARTNET external control (listed under ‘Media Commands’).

Example:
artnet_record StartChan=1 EndChan=13 Universe=3 Subnet=2 ByteRange=2 InputIP=192.168.71.10
InputIPSubnet=255.255.255.0 NumberFramesToRecord=80 SaveFile=C:\Movies\Record\art_test.txt
PlayBackFile=C:\Movies\Record\artnetrec.txt RecordingMode=Idle LoopPlayback=true 

Note: Save and PlayBack files are .txt files.

https://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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Audio Equalisation

Access the global audio equalisation from GUI menu View > Global EQ Levels. This dialog shows
controls which can shape the frequency response of the audio output.

Equalisation

Vertical sliders affect the 15 frequency bands shown above, from this area you can change the mix of
bass or high frequencies affecting the overall sound of the audio.

Press Reset to set back to a flat equalisation (no effect on audio).

Low Pass Filter

A low pass filter, if enabled, allows all frequencies up to the Upper Frequency set using the slider.
After this value, the volume smoothly reduces. Use this slider to remove unwanted high frequency
sound.

Press Reset to allow all frequencies (no effect on audio).
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High Pass Filter

A high pass filter, if enabled, allows all frequencies from the Lower Frequency set using the slider.
Before this value, the volume smoothly reduces. Use this slider to remove unwanted low frequency
sound.

Press Reset to allow all frequencies (no effect on audio).

Overall Volume

This is the same overall volume slider as in the main frame toolbar or Sequence Editor.

Output Level Visualisation

To see a visualisation of the audio levels for each channel on the playback window, turn on the VU
meter (Main Toolbar) while the audio is playing and enable one of the above areas.

Audio equalisation is stored in the show XML file.





Part 3: DeltaOffline



444

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Part 3: DeltaOffline

Part 3: DeltaOffline

DeltaOffline is a licence-limited mode of the full DeltaServer and DeltaGUI software, designed for use
by show creators on a PC rather than a Delta Media Server. Without the demands for storage and
playback performance, the user can access all the facilities of the Delta software to create and save
shows, sequences and controls.

· Access to DeltaOffline, licences and training resources can be obtained on request from:
info@7thSense.one.

Anything created in DeltaOffline can be played back without limitations on a full Delta licence with
Delta Media Servers. Similarly, anything created in the full licence can be loaded and edited in
DeltaOffline.

mailto:info@7thSense.one
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Installing DeltaOffline

Since DeltaServer and DeltaGUI are pre-installed, users will not normally need to run a Delta
installation themselves. DeltaOffline, however, will need to be installed on a separate PC. This licence
(software, or possible a licence dongle key) only allows the Delta software to operate as DeltaOffline.

Run the ‘Delta[version] x64 Setup.exe’ file:

Agree to the terms and install both DeltaGUI and DeltaServer:
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The install wizard will finish with the choice to run the software, so if your licence is a USB dongle key,
first ensure you have plugged it into your PC. At this stage DeltaServer will prompt you to enter a
digital license key.

Choose ‘Configure as a standalone program’ and enter the provided licence key.

· Allow licensing to access the Internet to check/activate licence > OK

· Product Registration > Provide valid Company and Contact name. 

There needs to be Windows firewall clearance to run both DeltaServer and DeltaGUI.

The installation will drop shortcut icons onto your Desktop to open DeltaServer and DeltaGUI.
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Running DeltaOffline

Launch Delta from a PC, and click OK to open DeltaServer and its Playback window:

Press F to take back the Playback window out of full-screen mode. You will see a floating watermark
in random positions and colours, per channel, over any media (or black if the current timeline is
empty). This example shows media over 3 channels:

Preview (DeltaGUI, click Preview) or via the Delta Web Service, will not show the watermark:
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Limitations and Use

The DeltaOffline licence allows you to build, load and save shows exactly as you would with a full
licence, but playback is limited.

Every 30 seconds, the timeline clock will automatically stop any media playing, and the watermark
will include ‘Playback Stopped’. If in full-screen mode, the playback window will restore to previous
normal size.

SDI output and high bit-depth are not supported.
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Appendices

There may be aspects of using Delta that can better be found in our other guides. Please refer to our
online support portal at https://portal.7thsense.one/online-help/ for all aspects of using, maintaining
and developing your installations.

Ø Appendix A: External Control

Ø Appendix B: Licensing the Server

Ø Appendix C: SDI Output option

Ø Appendix D: SMPTE/Transport Control Setup

Ø Appendix E: Shortcut Keys

Ø Appendix F: Command Line Switches

Ø Appendix G: Troubleshooting

Ø Appendix H: Windows 10 Unified Write Filter

Ø Appendix I: Express Mode, Creating Shows Programmatically

Ø Appendix J: Selective Resource Indexing

Ø Appendix K: OSC and External Controls
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Appendix A: External Control

Delta Media Servers can be controlled remotely using external controls to and from DeltaServer using
serial or IP-based controllers. This includes serial (RS-232/422/485) as well as TCP and UDP.

In addition, Delta web service has a fully-featured HTTP API for interacting with servers over a local
network.

Ø External Control Commands  

Full External / Sequence Control

DeltaGUI menu, Help > External Control provides this complete list of Delta sequence and external
control commands:

Ø Vs2.0 External / Sequence Control Protocol 

New controls are added on a regular basis, but do not work retrospectively, so always refer to your
installed Help from your DeltaServer.

External Control Commands

Notes on the External Controls help page

· Commands are not case sensitive, and individual commands are activated by Carriage Return
(Hex 0D, decimal 13)

· If paths are used the character \ must be escaped with a second \, e.g.: path="Images\
\foldername".

· To specify a timeline for a command, add TL=X in the command, X=Timeline number or R for
Reserve timeline.

· If you have named the timelines, you can also use TL=myname (note that timeline naming
enforces unique names)

· Some commands (marked !) : are non-realtime which could interrupt playback if playing, or will
stop playback as part of the command.

· Non-realtime commands (marked with an additional *) : if Seamless Loop mode is enabled will
not interrupt playback.

· Non Sequence commands (marked E) : Some commands are external control commands only,
not sequence commands .

· Sequence Only commands (marked S) : Some commands are sequence commands only, not
external control commands .

451

https://portal.7thsense.one/user-guides/MC255-managing-servers/sf_dws_api.html
https://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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· Optional parameters or choices between parameters are enclosed in [ ].

For the complete list available to your version of Delta, go to DeltaGUI menu, Help > External Control.

Ø To see the latest Help file online go here. 

Delta Media Servers can be controlled remotely using external controls to and from DeltaServer using
serial or IP-based controllers.

This is a set of built-in English-language commands, allowing an external controller to control the
timeline. You can also add custom events to the timeline which output strings on the external control
COM port / Telnet port.

To specify a timeline for a command, add TL=X where X is the timeline in the range 1-32 or use R to
specify the Reserve timeline. You can also use TL=ALL to specify all timelines.

In addition, by using View > Timeline Names, you can give a unique name to each timeline, this shows
in DeltaGUI and you can also use TL=myname to address a specific timeline.

Note: File names or marker names must be enclosed in double quotes if there is a space in the
name.

Some commands only work with a Leader server, since Follower units receive these commands from
the Leader:

PLAY Play the show (instant start if cue already done)

CUE Cue the show and wait for the Play command

STOP Stop the show

ADVANCE n Step forward n frames

STEPBACK n Step back n frames

REWIND Rewind the show to frame zero

RATE n Set the framerate to n frames per second

RATESCALE factor Change the rate of the timeline by a multiple (1.3, 0.75 etc.)

LOADALL "file name" Load the filename on all servers

MERGEALL "file name" Merge the filename on all servers

SEQUENCEALL sequencename Run the sequence on all servers

http://portal.7thsense.one/user-guides/resources/ExternalControlHelp.html
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LAYERFADEALL [layer /name] opacity Set the transparency of this layer/resource

DISPLAYALL [fullscreen/windowed/minimized] Set all server’s playback windows

GOTOMARKER "marker name" [play] Move to a named marker on timeline, and optionally start playing from there.

GOTOFRAME framenumber [play] Move to the framenumber specified and optionally start playing from there

GOTOTIME timecode framerate [play] Move to a timecode at a specific framerate, optionally play. So "Gototime 0:1:0:15 
30.00" will move to 1hour and 15 frames for a framerate of 30 fps, if your timeline
is set to 24 fps, the same command will move to 1 hour and 12 frames (12 frames
is 50% of 24 fps).

MARKERSEARCH direction=[next / previous]
play=[true / false]

Stop, search for the next or previous marker in the timeline, move to that marker
and optionally play

CLIPSEARCH clip=[next / previous] [play=true/false]
[currentstart=true/false]

Search for the start of the next or previous clip (any visual resource such as
movies, images, videocapture), optionally play immediately

if currentstart is true, it will find the start frame of the current visual resource. By
default, currentstart is false, meaning it will find the start of the clip prior to the
visual resource which is currently in scope and also loop round to the first or last
resource.

Please note: From 2020 7thSense deprecated the terms master and slave for the dependencies
between devices. We now refer throughout to ‘Leader’ and ‘Follower’ in our products.

To maintain functionality, both terminologies continue to work internally, but our documentation no
longer uses the former terms. Users of pre-2020 products will need to observe the equivalence and
continue to use the previous legacy terms.

Return Codes

When first connected to Delta, External Control returns a statement such as:

ApplicationName Deltaserver.exe¿

Welcome to the 7thSense Delta Telnet interface, Help[CR] for commands¿

SERVER: ServerNode1¿

READY¿

Where ¿ is the 0x0d 0x0a Carriage Return / Linefeed Pair

Note the SERVER name is taken from the PC.

If a command is not recognised by Delta, it will return:

BAD¿

If a command is identified (no checks are run on parameters), it will return:

OK¿
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Certain commands return more information:

STATUS will return a string such as this:

SERVER  : ServerNode1 (Leader)¿

FILE   : stratosphere show1.xml¿

MODE   : Stopped¿

CURRENTFRAME: 2646¿

FRAMERATE: 30.0¿

LICENCE : Permanent¿

MOVIEDRIVES: C E¿

OTHERDRIVE: C¿

GRAPHICS: 1920 X 1080 60 HZ¿

SMPTE : OFF¿

AUDIOLEVEL: 100¿

VIDEOLEVEL: 100¿

¿

OK¿

In this return information:

The SERVER is taken from the PC, and will be (Leader) or (Follower)
The FILE is the current loaded filename
The MODE can be Stopped, Preparing to Play or Playing
The CURRENTFRAME is the current frame number
The FRAMERATE is the current framerate
The LICENCE can be Permanent or will show a date for time expired licences
LOAD "file" will return the STATUS information after the load

LISTSHOWS [path] will return a list of XML files in the path specified such as:

Show List ¿

08newsting.xml ¿

08newsting.xml.xml ¿

showcase 2006 novidcap.xml ¿

HD Test 1.xml ¿

tile 2006 hd3.xml ¿

OK ¿

LISTMARKERS

Marker List ¿

Start: 5 ¿

Images: 420 ¿

Movies: 780 ¿

Audio: 1382 ¿

Video Capture: 1980 ¿

Text: 1680 ¿

Crossfades: 2280 ¿

OK ¿
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Example Dialog
ApplicationName Deltaserver.exe
Welcome to the 7thSense Delta Telnet interface, Help [CR] for commands
SERVER: athlon2600
READY

status¿

SERVER  : Server1 (Leader)
FILE   : ball bounce.xml
MODE   : Stopped
CURRENTFRAME: 311
FRAMERATE: 25.0
LICENCE : Permanent
MOVIEDRIVES: C C C C
OTHERDRIVE: C
GRAPHICS: 1920 X 1080 60 HZ
SMPTE : OFF
AUDIOLEVEL: 100
VIDEOLEVEL: 100
OK

listshows¿

Show List
08newsting.xml
test.xml
test2.xml
TILE.xml
OK

load " TILE.xml "¿

SERVER  : athlon2600 (Leader)
FILE   : TILE.xml
MODE   : Stopped
CURRENTFRAME: 0
FRAMERATE: 25.0
LICENCE : 30.12.2006
MOVIEDRIVES: C E V W
OTHERDRIVES: C
OK

play¿

OK

status¿

SERVER  : athlon2600 (Leader)
FILE   : test.xml
MODE   : Playing
CURRENTFRAME: 22
FRAMERATE: 37.5
LICENCE : 30.12.2006
MOVIEDRIVES: C E V W
OTHERDRIVES: C
OK
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stop¿

OK

Troubleshooting External Control

To see what communication is taking place from your control system to the server, on the
DeltaServer dialog, see About > External Control Traffic:

By default, this dialog shows the last 2000 lines of communication (both input & output), if you enable
the Short List checkbox, only the last 200 lines are retained, which speeds up display.
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Appendix B: Licensing the Server

Delta is licensed software, using a physical USB Key or disk based licence, which is locked to the
physical hardware of the Delta PC. This Key is supplied by 7thSense.

To license a Delta PC (if not already done by 7thSense):

· Install Delta using the setup.exe supplied

· Insert the USB Delta Key into USB port.

Microsoft Windows

· Run the setupdrv.exe supplied for Blue dongles.

· Install the dongle in a USB port – the driver should be found automatically.

An unlicensed Delta system will continue to run, but certain features are disabled, and you won’t be
able to save a Delta file.

Note that DeltaGUI does not require a license, only the server, so you can run DeltaGUI from any
PC.

Updating a 7thSense Licence

An update code can be obtained from 7thSense to add features remotely through email.

To update the USB licence, from the DeltaServer dialog menu, choose About > Update Licence:
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The emailed code should be copied into the Change Code edit box and then press [Make Changes] –
any errors will be shown below.

Note that to obtain an update code, you will need to send the Dongle Number and Update Number
to 7thSense – these are shown above or in the About > About Server dialog.

Integrator / Reseller Licensing

If your integrator or reseller has provided your licence, they may have employed an additional service
regarding licence expiry. In this case, they will email you a code that must be ingested using the
DeltaGUI main menu > Wizards > Ingest User Licence:
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Appendix C: SDI Output option

Delta can be configured as having SDI outputs instead of DisplayPort, which is useful in certain AV
installations having long video cable runs.

The SDI option has to be licensed and a compatible SDI output card (typically Matrox) installed.

You can configure the output mode in Config > Display, Output button. In this dialog you can choose
DisplayPort or SDI outputs. In SDI mode, you can select the various HD video formats which are
stored in C:\program files\7thSense\Delta\System\SDI_BF.XML. You can edit this XML file to add
other video formats, which will work as long as the mode is supported by that specific SDI card.
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Enable DP Preview
Enable this to also show all channels on the DisplayPort outputs. Note that these are preview
only, and could show video tearing on the DisplayPort outputs in this mode.

Media Colour

Rec709
This is the HD standard in which certain colours are reserved and the media uses a restricted
range of values (8-bit is 16 to 235, 10-bit is 64 to 940). Choose this if the media you have
conforms to the Rec709 standard.

Full Range
Select this option if the media uses the full range of colours (0-255 in 8-bit, 0-1023 in 10-bit.

Audio

Note that for servers with Bluefish 4K Neutron cards, audio can be optionally made to stream via SDI
(up to 8 channels). Please contact 7thSense Design for advice.

Once installed, in SDI mode, audio will always be streamed via SDI and not output on any other sound
device.

SDI Timing

When in SDI mode, the timing is taken from the SDI card, so in DeltaGUI, Config > Preferences >
Timing:

· Check or Uncheck the LTC Control – Enabled checkbox, according to the LTC / SMPTE chase
mode you need.

· Timing Mode is ‘Use hardware’

· Framerate is ‘Custom’ and type in the actual framerate you need (e.g. 23.976)

· Set Automatic Framerate to unchecked and select ‘Custom’, type in 23.976

· Set Force Framerate to unchecked
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Appendix D: SMPTE/Transport Control Setup

For Delta to listen to SMPTE LTC timecode (and play, stop, jog and shuttle from an external controller,
accordingly) you must have one of the following:

1. An LTC timecode device that can generate SMPTE timecode (interfaced into Delta via
Soundman, LTC Reader or Adrielec card).

Note: SoundMan and LTC Reader are listed as Local LTC in the dropdown menu. Adrielec would
appear on the list separately if the card is detected.

or

2. A Midi (MTC) device (interfaced into Delta via suitable MIDI input port).

or

3. RS422 Sony 9-pin D Serial Connector (or RS232 connector with suitable cabling and adapter).

Configure Delta for listening to an external 422 device

In DeltaGUI, click Configure > Preferences > Timing

Tick the Enabled checkbox to enable the SMPTE tracking and select its correct device.
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Sony RS422

Delta version 2.4 onwards has three new options (as above) to allow for Sony RS422 connections.

The connection for Sony 422 is a 9-pin D Serial Connector. Its COM port should be set in Device
Manager to match that within Delta (which defaults to 78 in the registry).

BlackMagic

Blackmagic uses a DeckLink card which retrieves the COM port from the hardware automatically.

For Blackmagic cards, ensure that you get the correct cable and adapter as the physical pin-out for
4K Blackmagic cards in a Delta server may require a M/F adapter as they are set to be ‘Controllers’
– which is the same connection as required for the show control hardware itself. Older Blackmagic
cards are set to be ‘Followers’ and so the standard controller-Follower cable should be correct.

Bluefish SDI

A Bluefish SDI card does not require the COM port to be set, as it is controlled internally.
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Once a SMPTE device is selected, press the LTC button in the lower left area of DeltaGUI to allow the
external controller to run the show. Note that the playback controls will disappear since, at this point,
we are purely tracking the incoming timecode in DeltaGUI.

Note: In this case LTC Chase is ON for Timeline 1 but this is not automatically applied to any other
timeline – click to select a timeline then click SMPTE ON/OFF as required for each.

RS422 Transport Controls

(for outputting to an external LTC device)

In order for Delta to have some control over the external LTC device, configure a comport to have the
following parameters in Configure > Preferences > Communication:

COM: 38400, Odd Parity, 8 Data bits, 1 Stop bit, set to Transport Control
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Connect this COM port to the external LTC device input via an RS422 converter like this:

Now, when you enable SMPTE tracking by pressing the DeltaGUI SMPTE button, the transport
controls remain, and when you play, stop / drag the slider, you are communicating to the external LTC
controller via Sony Protocol commands.

Example Devices

RS232 – RS422 Moxa™; Transio TCC-100; Sony™

MTC Input M-Audio™; MidiMan

External LTC Device CB Electronics™; P2MMC

Adrielec PCIe-TC LTC Reader card
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Appendix E: Shortcut Keys

The main menu can be navigated by Alt+ keys, for example Alt+V+M for the markers list, or Alt+C+T
for TCP connections.

The following are also listed in DeltaServer: About > Shortcut Keys, and DeltaGUI: Help > Shortcut
Keys.

Common to both GUI and Server

P Play

H Halt the playback

R Stop and rewind the timeline to frame 0.

F1 – F12 Control+F1 – F12

Shift+F1 – F12 Control+Shift+F1 – F12

0 – 9 Control+0 – 9

Shift+0 –9 Control+Shift+0 – 9

A marker on the timeline can be set to one of the function keys or numeric keys for quick access to a
timeline position. Using the Control or Shift keys, up to 88 markers can be accessed by a key.

Home Rewind to frame 0

Left Arrow Step back one frame

Right Arrow Step forward one frame

Ctrl+Left Arrow Search previous marker

Ctrl+Right Arrow Search next marker

Ctrl+Shift Left Arrow Move the current timeline to the start of the previous movie

Ctrl+Shift Right Arrow Move the current timeline to the start of the next movie

Alt+F1 Help file

Server Playback Window

F Toggle the playback window fullscreen or windowed

S Show playback statistics 

Q Reset statistics display

G Show the graph
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A Show the Audio levels 

Shift+arrows Position the playback statistics on screen

Ctrl+arrows Size the width and height of the playback statistics block (and type size)

Ctrl+Shift+arrows Position the graph block

Ctrl+Shift+Q/W Make graph block narrower/wider

Ctrl+Shift+Y/H Make graph block taller/shorter

GUI

Space Toggle playing

Ctrl+G Goto Dialog

Ctrl+C Copy

Ctrl+X Cut

Ctrl+P Paste

Ctrl+B Paste At

Ctrl+A Select all

Ctrl+D Deselect all

Del Delete all selected

Ctrl+R Reserve Mode toggle

Ctrl+M Add Marker at current frame

Ctrl+F Find a resource

Ctrl+Q Toggle Resource Pool Width

Ctrl+T Show the Timelines dialog

+ / - or [ / ] Zoom in or out on the timeline.

Shift+Z Zoom to the extents of all media on the timeline

Ctrl when dragging a resource or selected resources: Copy.

Ctrl when incrementing or decrementing a value: 10 × speed

Shift when incrementing or decrementing a value: 1/10 × speed
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Appendix F: Command Line Switches

Listed in DeltaServer and in DeltaGUI > Help > Command Line Switches.

These switches can be sent to the server application to modify its startup behaviour. Enter them in
the Target box of a shortcut.

DeltaServer (affects this run only)

-minimized Show the server dialog and playback window minimized.

-minimizedialog Show the server dialog minimized.

-fullscreen Show the playback window fullscreen.

-delay n Delay the server startup for n seconds

-nopool Do not look for pool resources on disk at startup

DeltaServer (changes also stored for next run)

-leader Change the current mode to Leader

-follower Change the current mode to Follower.

-group n Change the current group to n

-smpte_on Enable tracking SMPTE

-smpte_off Disable tracking SMPTE

DeltaGUI

-group N Force DeltaGUI to accept only connections from group N

-selectgroup Force DeltaGUI to show a dialog on start to select the single group to allow
connections from.

Note that when starting DeltaGUI with no command line parameters, any other instance of
DeltaGUI will be terminated on that PC. However, if you run with Group N or selectgroup command
line parameters, this will not happen, so on the same PC you can have one DeltaGUI on Group 3 and
another on Group 6 and so on.
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Appendix G: Troubleshooting

DeltaGUI will not connect to the server

Ø See also Communication Configuration  

DeltaGUI automatically looks for all servers on the same network. If it cannot find the server, it could
be one of the following:

Server does not have an IP Address

For DeltaGUI to find a server, the server must have a valid IP address. This happens when the
Ethernet interface of the PC is connected to another Ethernet device such as a Hub or Switch. If the
server IP address is 0.0.0.0, this indicates it does not have a valid IP Address.

Corrective Action – Connect the server to an Ethernet Hub or switch and attach the DeltaGUI PC to
the same hub or switch. Check if a DHCP server is available or set the server to a static IP Address in
the same range as the DeltaGUI PC.

Server has a different IP range to the DeltaGUI PC

If the server has an IP Address of 10.100.100.200 and a Netmask of 255.255.255.0, it could never be
found from a DeltaGUI PC which is on 192.168.2.100, since they are on completely different IP
ranges.

Corrective Action – Change the DeltaGUI PC, or the server’s IP Address to the same range – e.g.
DeltaGUI on 10.100.100.88, server on 10.100.100.200

DeltaGUI has blocked this group

You can type a list of groups into the DeltaGUI to which it will not connect. This list is held in the
Preferences dialog, at Configure > Preferences > Communication > [Ethernet], [Blocked Groups].

Corrective Action – Check the server’s group is not listed in this edit box, if it is, remove it from this
list and press OK.

Another DeltaGUI is connected

Only one instance of DeltaGUI can connect to a server at a time, if you have multiple groups, use the
SelectGroup command line switch on DeltaGUI to force it only to look at this one group – in that way
you can have multiple DeltaGUIs on a single PC connected to multiple servers (in different groups).
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To understand which DeltaGUI is connected, minimise the playback window (F key) to find the server
dialog (through VNC), then the status indication will highlight the IP address of the DeltaGUI machine.
You can also choose GUI > Kill GUI from the DeltaServer dialog. Alternatively, send in the KILLGUI
external control command to kill the currently attached DeltaGUI. Note that this is safe to do as the
contents of the server, even if not saved, are not altered by the DeltaGUI terminating (though the
person using the DeltaGUI may be surprised when it disappears).

DeltaServer and DeltaGUI versions are mismatched

The version of DeltaServer and of DeltaGUI must match. Software version in each is found in Help >
About.

Can you ping the server’s IP?

If you have confirmed that your IP addresses are setup in a workable manner, ‘Ping’ will confirm that
you have network access to the DeltaServer. ‘Ping’ is a Windows Command Line command that
sends an ICMP Echo Request command to another device on the IP network and awaits a response.
Here is an example where a server known to exist at IP address 10.100.101.230 is sent a ‘Ping’ from
a remote PC:

Is there a firewall blocking communications on your DeltaGUI computer OR
on DeltaServer itself?

From the factory, the proper Windows firewall exceptions should always be opened.
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Delta will not play smoothly

When playing movies, the playback is jerky or random, this could be one of the following:

Server is playing movies from a disk that is not fast enough

Normally, Delta has a RAID or SSD drive for movie playback, if playing from the C: operating system
disk, this may not be fast enough.

Corrective Action – Check the server is configured to use a fast enough movie disk (Configure >
Preferences > Drives, check the Movie drive is RAID or SSD).

Corrective Action – Check the movie transfer disk rate by hovering over the movie on the DeltaGUI
timeline, this shows it in MegaBytes/second. For example, a 8Mb/s movie may be ok on the C: drive,
a 50Mb/s movie will need 2 disks in RAID0, a 180Mb/s movie will need SSDs or 8 disks in RAID5.

Disks and graphics appear ok, but movie playback is not smooth

Check the playback window graph and playback statistics (press the G and S keys):
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If the yellow line is on the top red line as in the left part, playback will be smooth, if there are yellow
spikes in the graph well above the top red line, something is causing bad playback.

Corrective Action – Check there is not another application running which is taking high CPU time.

Corrective Action – Check the FrTm value (shown above) matches the expected frame time, e.g.
33.3ms for 30 fps, 40ms for 25 fps and 41.7ms for 24 fps. If this is not the case, check the EDID to
projector or monitor matches the expected video format.

Ø See also User Information / Stats  

System Diagnostic Logs

In the event of system malfunctions, diagnostic logs are a great assistance. The more 7thSense can
access of the circumstances the better. We may ask you to send us DeltaServer logs, MiniDump log
files, and Windows Event logs.
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System Logs

You can create a system log to send back to us using DeltaServer dialog’s Save System Log option,
found in the server dialog menu – About > Save System Log.

This creates a date and time-stamped folder by default into the C:
\program files\7thsense\Delta\Logs folder.

It contains these folders:

\Logs
\Sequences
\Shows
\System
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and a copy of the 7thSense registry:

Zip this folder up and send it to 7thSense support if requested.

Delta from version 2.5 also produces a MiniDump file if the server crashes. Find any file beginning
‘DeltaServer_MiniDump~’ in C:\program files\7thsense\Delta\Logs, and send that as well.

From any remote networked PC, you can access the logs from the IP address of the required server,
for example:

\\10.100.101.56\7thSense\Delta\Logs

Windows Event Logs

Use VNC to access a remote server (use connection password 7th), and search ‘Event’ from the
Windows Search to access Event Viewer.

Find Custom Views > Administrative Events and right-click to select ‘Save All Events in Custom View
As...’
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Save the Windows log file back into the Delta Logs folder (C:\program files\7thsense\Delta\Logs) as
a .evtx file, and using default export settings if prompted.

This log may not have all the information we need. A more comprehensive set of logs may be
required. If so, expand ‘Windows logs’ on the left, and export (right-click, ‘Save all Events As...’)the
Application, Security, Setup and System logs separately:
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A suggested naming convention might use the server name and date as prefix and suffix:

Delta**** Application dd-mm-yy’
Delta****Security Logs dd-mm-yy
etc.
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Appendix H: Windows 10 Unified Write Filter

Applies to servers running Windows 10 Enterprise and Delta 2.6 only, where the feature has been
explicitly turned on in Windows.

Making use of the Unified Write Filter (UWF) enables protection of the server C:\ drive by locking write
access. Whilst changes or additions can be made, they are written to a copy of the source on a virtual
‘overlay’. This means that any changes at all made to any files on the C:\ drive, will be lost on reboot.
There are several warnings and indicators in DeltaGUI when the feature is enabled, including greyed-
out Save menu items, so that intended development work is not made only to be lost. External drives
are not locked.

When this Windows feature has been enabled on a Delta server, it is controlled using the Delta
external control command SETUWF. This interacts with the Windows UWFMGR app.

When UFW is Implemented

Since it is important not to create a show or make changes that cannot be saved, the UFW ‘locked’
status is apparent in the DeltaGUI menus and title bar.

· In DeltaGUI any menus involving changes will be greyed out, and the resource pool will display a
warning:
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· The server front panel display will be dark green in colour, showing a ‘Server Locked’ message:
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· Viewed in Stack Overview, a locked server will display a blue ‘Read Only’ status in its Health
column:

https://portal.7thsense.one/user-guides/MC255-managing-servers/sf_overview.html
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Appendix I: Express Mode, Creating Shows
Programmatically
Delta shows can be constructed, managed and run using external control commands. There is an
application, StackExpress, that writes these Express Mode shows for you via a simple web browser
interface.

However, the JSON files created in this way can also be programmed manually as scripts. These can
be loaded into Delta, again using external controls, and with Delta running in Express Mode, the
programmed show will run.

Configuring Delta for Express Mode

Express Mode in Delta can be enabled in one of three ways.

External Control

The quickest method to enable/disable Express Mode is to call the external command:
SETEXPRESSMODE ENABLED=[Y/N].

Registry Edit

Alternatively it can be done through the Registry Editor by navigating to:
HKEY_LOCAL_MACHINE\SOFTWARE\7thSense\Delta. From there locate ExpressMode and change
the value to 1.

On Load

If neither of these methods is used, Express Mode will be enabled automatically when a media json
config file is loaded using the LOADMEDIAJSON external control command.
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The JSON Structure

Top Level Structure

At this level, there should only be timeline objects and the “tlToEdit” field.

Add a timeline object in the format of “tl-x”: {} for every timeline you want to create.

The “tlToEdit” field specifies which timeline object from the JSON to load into the show.

Config Structure

ClipCount
Should match the number of clips in the “Clips” array.

StartFrame
The frame on which to start placing clips.

Timeline
Should match the number of the outer object, e.g. for tl-1 this must be 1.
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KeepDisplayConfig
Set to 1 to keep the current display config, set to 0 to overwrite the current display config.

Layer
The layer on the timeline on which to place the clips.

Channel
(Not used.)

Merge
Set to 1 if you have a base file you want to merge the express layer into, rather than completely
overwriting the existing file.

ClearExpressLayer
(If “Merge” is set to 1)

0: Load in clips from this file without clearing the current Express layer.

1: Clear the current express layer before loading in the new clips.

Dirty
Set to 1 if “Merge” is 1 and the clips in this file have changed since Delta last processed this file,
otherwise set to 0.

JSONFileVersion
Should always be 1.
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Clips Structure

ID
Used to name the clip on the timeline. Will be formatted as “Clip_{ID}” : {Name}. Should be
sequential. Avoid clashes with other clips.

Type
The type of resource. Can be “Movie”, “Image”, or “Capture”.

MediaType
Needs to match the file extension of the media; e.g. “tga”, “mp4”, “jpg”. If “Type” is “Capture”
then leave this blank (“”).

Length
The length in frames of the resource. For movie resources, if this does not match the number of
frames in the movie, it will be trimmed or looped to meet this value.

Name
The name of the resource on disk (excluding the extension). If on a movie resource, looks in “C:
\Movies”, if on an image resource, looks in “C:\Images”, if on a capture resource this should be
the name of the capture device, e.g. “Integrated Webcam :ID 10000”.
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InPoint
Trim a movie resource to start from a specified frame. Must be between 0 and the total number
of frames in the movie and always less than Outpoint.

OutPoint
Trim a movie resource to end on a specified frame. Must be between 0 and the total number of
frames in the movie and always greater than InPoint. Set to “end” to not trim the movie.

(Ensure “LengthMode” is set to the correct value when using “Length” vs “InPoint”/”OutPoint”.

CrossFade
Leave as 0.

PlayMode
“PlayOnce”: This clip will play once then move on to the next clip.
“PlayCount”: This clip will play the amount of times specified in “PlayModeDetails” before
moving on to the next clip.

PlayModeDetails
The amount of times to loop this clip (only if “PlayMode” is “PlayCount”).

Size
Leave as “FullScreen”.

FadeMode
“None”: No transition between clips.
“Transparent”: A fade in/out is applied to the clip with a length specified in
“FadeModeLength” (seconds).

FadeModeDetails
Always “both”.

FadeModeLength
Time in seconds to fade in/out of resource (if “FadeMode” is “Transparent”.

PlaySpeed
Sets the play speed of a movie resource. Doesn’t affect the length of the resource on the
timeline.

DisableCodecAudio
Only used for Codec Movie resources. If set to 1 then the movie’s audio will be disabled.

MatchAudio
Search for any audio files which contain the same resource name as the movie and add them
to the timeline at the same frame as the movie and 4 layers lower.
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EndTransition
“Play” – continue playing after this clip.
“Stop” – stop playback after this clip.

StopType
“EndTransition” must be “Stop” for this to have any effect.
“Last”: Stop at the end of this clip
“First”: Stop at the beginning of the next clip

Actions
Place Delta sequences on the timeline

id Sequential action ID

frame The RESOURCE frame number to place the sequence on

tlFrame The TIMELINE frame number to place the sequence on

action The name of the sequence to add to the timeline

valid Set to “true”

LengthMode
“length” – Use the “Length” field to determine the length of the resource.
“in/out” – Use the “InPoint” and “OutPoint” fields to determine the length of the resource.

Ingesting into Delta

Once the JSON file has been created, copy it into C:\7thsense\JSON name it media.json.

To trigger Delta to generate the timeline, use the LOADMEDIAJSON external control.
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This takes one argument, “tl=x” where x is the number of the timeline you want to populate. This does
not have to match the “tlToEdit” field in the top level of the JSON file. “tlToEdit” specifies which of the
timeline objects to process from the JSON file, whereas the tl argument to the LOADMEDIAJSON
command specifies which timeline within Delta onto which to load content.

If you wish to populate multiple timelines, then it is recommended to store all the timelines in
media.json (as tl-1, tl-2, etc.) and load them one at a time by updating “tlToEdit” to point to the desired
timeline, and calling LOADMEDIAJSON TL=X to upload it to the correct timeline in Delta.
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Appendix J: Selective Resource Indexing

This appendix refers to managing unnecessary resource indexing, for example with the distribution of
media carves across many servers. Indexing takes time on start-up, and Delta 2.8 offers a way of
doing this using a registry key. See Resources Area .

Registry Edits

7thSense software uses the Windows Registry extensively, and on occasion we make
recommendations for changes.

· Before making any changes, close DeltaGUI and DeltaServer.

· DeltaServer can take up to 10 seconds to fully close in the background, even if it appears that
all the Windows have closed. Ensure that Delta has fully closed before opening and/or
refreshing, and finally editing. The best way to ensure this, is to watch Windows Task Manager
> Details list. You will see ‘DeltaServer.exe’ in this list if DeltaServer is still running. If it won’t
close for any reason, you can right click on it in the list and choose ‘End Process Tree’.

· Make a note of any setting before you change it, in case you want to change it back.

· Only make the changes as recommended and only to those registry keys.

Method

The Registry key 7thSense/Delta/ResourceCarveGroup is created on Delta start if doesn’t exist and
initialised to a blank string:
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If the Registry key is blank, there is no change to the way all resources are ingested and indexed
(enumerated).

· To introduce selective enumeration, the folders to be filtered must bear the prefix: 7C_.

· A value entered in the key will be used as a variable to include or exclude these prefixed folders
according to this value in the folder name.
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Right-click to Modify the key value.

If the Registry key contains a string value ‘MyFilter’ (example):

· Any folder name that follows the pattern: 7C_MyFilter_* will be enumerated and all resources
contained in this folder will appear in the resource pool.

· Any folder name that follows the logical ‘NOT’ pattern: 7C_!MyFilter_* will be specifically
excluded. None of the subfolders or resources in this folder will be enumerated and will not be
available in the resource pool.

· The string, or part of the string, can be a Global Variable , written in the form:
string{{globalVarName}}
example: 
registry key = This{{carveNumber}}
matching folders will be: 7C_This_value of carveNumber_*
so where carveNumber = 14, contents of all folders named: 7C_This14_* will be enumerated

· Where a global var is not recognised, the var element will be ignored.
example:
MyFilter{{unknownVar}} will just be read as MyFilter.

· Folders without the 7C_ prefix will be processed normally; all resources they contain will be
enumerated and be available in the resource pool.
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Appendix K: OSC and External Controls

OSC (Open Sound Control) is a network messaging protocol originally designed for musical
performances or show control. Its non-standardised messages make it a dynamic, configurable and
low-latency interface for Delta External Control commands. Using a cross-platform control
applications such as Touch OSC or Medialon Manager allows Delta controls and Delta Sequences to
be run alongside other applications for show control.

OSC messages employ an address pattern, similar to URIs, a type tag (i=integer, f=float, s=string,
b=blob). Messages are user-defined, so 7thSense has established all the common commands for you
to operate with Delta, which can be supplemented or replaced. These create the equivalences for the
common Delta External Controls.

There is no acknowledgement response in OSC, which listens on all available NICs.

Full specifications, syntax and usage for OSC can be found at OpenSoundControl.org.

Multi-platform TouchOSC modular control surface toolkit is available from Hexler, along with a
complete manual for building interfaces on Windows, Mac or Android.

Delta OSC Commands

A help file of all Delta OSC commands is installed in 
C:\Program Files\7thSense\Delta\System\DeltaOSCCommands.html

Ø Click here for this same file DeltaOSCCommands.html on the user portal 

All basic commands are installed with Delta 2.8, along with a user-configurable file,
DeltaUserOSC.xml in the same place, into which any additional user commands can be written, for
example to run your own specific Delta sequences. This user file is not overwritten when Delta is
reinstalled or updated, but keep a safe backup.

The help file shows how commands and arguments must be structured:

https://hexler.net/touchosc#get
https://opensoundcontrol.stanford.edu/
https://hexler.net/touchosc
https://hexler.net/touchosc/manual/getting-started-osc#touchosc
https://portal.7thsense.one//user-guides/resources/DeltaOSCCommands.html
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Examples

From the help file, we can see that the OSC command to set an audio level will generate the external
control AUDIOLEVEL which requires an argument with an (i)nteger value to complete Delta control %
VAR1%.

If we want to move and resize a piece of media, more information is required for /media/move/xywh:

Here we need a (s)tring for the media External Control name, and four following (i)ntegers for the
respective VAR values.

For complex controls you can choose whether to build a sequence and use OSC to run it, or to
construct more complex OSC commands of your own.
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Implementation with TouchOSC

First of all ensure that TouchOSC and Delta are communicating. The default Delta port is 57120
(Communication Configuration ) but is configurable in Delta. Set the same value for the TouchOSC
Send Port in Edit > Connections (there is no receive for OSC):

TouchOSC has a graphical working space into which controls can be added, (box, button, label, text,
fader etc.). It is the name of the control, in the TouchOSC Document Tree, that must match the
DeltaOSC command. Thus a button to ‘go to a Delta timeline marker’ must be named:
‘transport/gotomarker’ (no preceding /).

The arguments are added to the Messages values in TouchOSC. 
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Example

Here, in a TouchOSC file called ‘Delta’, there is a control to move media along x and y axes (OSC
command ‘media/move/xy’):

In the Messages > OSC section, the address inserts a / followed by the name (the control is named to
be the actual OSC command).
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Arguments are then added, in this case sii (string integer integer).

The string is the Delta external control name – in this example what is to be moved – (selected,
yellow above) with a ‘Constant’ type and with its value entered in the Constant field.

The X and Y arguments are integer type: again select each and add its values in the field below.

When operated in TouchOSC run mode, the control in this example will send the message that
contains the media/move/xy command for ‘image 1’ to new x and y position values (seen in the
purple message bar above).

Custom OSC

There is a user-configurable file, DeltaUserOSC.xml in C:\Program Files\7thSense\Delta\System that
can be edited to add user-customised external control arguments. Edit this file to see the example
structure given, and save to the same location:





Document Information
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Document Information

Date Document
edition

Software
version

Revision Details Author/Editor

March 2023 1 2.8.6 New release. Andie Davidson

April 2024 2 2.8.8 Watchdog 1.0.9 (for R-Series servers) Andie Davidson

Windows Registry Settings

This document is supplied for informational purposes only. Any modification to Windows Registry
values that are not exposed via the DeltaServer or DeltaGUI application interfaces – or otherwise
advised by 7thSense personnel – may result in performance degradation and/or complete instability
of the products. Any attempt to engage 7thSense for support in troubleshooting may result in the
reversal of all Registry settings to the factory default or last known good 7thSense-approved
configuration. The customer assumes all risk when manually editing any Windows Registry values
on any 7thSense product.
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.
.obj files     267
.vto files     267

3
3D    

active stereo configuration     145
anaglyph stereo (3D)     143
blue line mode (3D)     143, 145
eye separation (3D)     143, 145
passive stereo configuration     143
wizard     143, 145

3D stereo show wiizard    
audio offset     148

A
align timeline media     290
alignment aids     142
animation    

movement     360
rotation     360
transform     361

Art-Net    
create iput resources     393
create output resources     391
examples     393
input     393
input controls     397
output     391
output controls     397
pool resources     397
recording     437
timeline resources     397

Art-Net and DMX layers     354
Art-Net and DMX settings     129
Art-Net controls     43
Art-Net output, input     351
Art-Net resources     390
Art-Net, DMX controls     52
audio     317

audio levels     321
configure LTC output track     125
configure playback devices     125
equalisation     440
guess mapping preset     121
hi pass/low pass filter     440
levels     127, 440
looping     321

mapping presets     127
mixing     321
seamless joins     321
supported formats     49
surround sound     49

audio mapping (custom)     127
AudioMapper     127
Auto Align licence     216
auto alignment     100
autoalignment    

camera     214
configure Delta     216
licensing     214
preparation     214
pre-warped media     189
refresh Delta AutoAlign     224
use calibration as primary     224
using MPCDI data     225
warp and blend     216

AV assemblies     398, 404

B
background layer     354
blends     43, 158
blocked server groups     107

C
canvas colour     134
canvas position for image     355, 356
canvas types     133
capture     43
carving media     430
cloning resource parameters     290
colour balancing     161
colour balancing and convergence     51
colour balancing projectors     386
colour convergence     161
colour correction     43
colour grading     386
colour LUTs     386
command line switches     467
communication configuration     107
composition mode    

channels and viewports     196
DeltaGUI     196
IntelligentSource     199
layout     191
media optimisation     191
multiple displays     191
principle     191
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container resources     398
containers, AV     404
containers, playlist / AV assembly     53
control PC     13
controls placeholder     343
copy timeline between servers     61
cut timeline media     290

D
debug a sequence     373
definitions of display terms     133
Delta Media Server     12
DeltaAudio     12
DeltaGUI     12
DeltaGUI connection    

troubleshooting     468
DeltaGUI functions     56
DeltaGUI interface, explained     65
DeltaGUI main menu     65
DeltaGUI startup group     57
DeltaMonitor     12
DeltaOffline     444

installation     445
limitations     447
running     447
watermark     447

DeltaServer     12, 30
close DeltaGUI     32
licence update     32
main menu     32
preferences     32

DeltaServer user interface     31
diagnostic logs     471
disk drive configuration (images, audio, movies)    
102
display configuration elements     133
display configuration files     167
display controls     94
Display menu (DeltaGUI)     65
display mode     133
display movie timecode     345
display playback information     131, 426
display timecode     345
display, identify     94
DMX    

examples     393
input     393
input controls     397
output     391
output controls     397

DMX output, input     351

DMX resources     390
Document information     496
dome display configuration     201
dome mode    

alignment     201
canvas definition     201
channel view     203
dimensions     201
display grid     203
interactive view     203
layering     212
panoramic media     212
partial domes     212
playback window     203
preview     203
projector position     208
resource defaults     121
resource mapping types     212
save viewpoints     203
sizing channels     208

E
edge blending     158
editing a mesh .obj     267
editor     317
effects (timeline)    

dynamic audio     407
dynamic keying     407
fade     407
file locations     49
formats     49
timeline alpha     407
transform animator     407
transparency     407

encrypted movies     65
encrypting movies     47
ethernet configuration     107
export geometry     154
express mode     479

JSON structure     480
express mode, set     479
EXR files (warp)     189
external control     451

OSC commands     489
return codes     453
troubleshooting     456

external controls     420
eyepoint    

dome     201
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F
fade     43
fade between timelines     65
fading between layers     86, 88
file location    

Art-Net     52
audio     49
blends     49
containers     53
effects     53
flat colour     51
images     48
movies     44
sequences     54
serial events     50
splines     52
warp geometry     50

find resources     306
flat plane mode    

alignment     178
Auto Alignment     178
blending     178, 187
canvas/panel rotation     169
channel defaults     176
channel joins     173
channel overlap     183
channel resizing, dynamic     169
channel rotation     183
channel setup     179
channels     169
colour correction     187
configuration procedure     178
defaults wizard     179
display configuration     169
display configuration files     188
preview window setup     175
resource defaults     121
viewports: output channels     175
warping     178, 183

frustum (dome) mode     201
full screen playback toggle     31

G
genlock     461
genlock, LTC chasing     104
geometry     364

background layer     150
global variables     376, 393
glossary     19

glossary, Delta     19
GoTo timeline control     343
graph line colours     37
group flashes red     57
grouping servers     13

H
help and guides    

eBook     10
online     10
PDF     10

Help menu (DeltaGUI)     65
hold on last frame     290

I
image scaling     355
images    

supported formats     48
import resources     308
ingest resources     308
ingest, selective     486
install Delta - what is included     17
installing Delta     17
IntelligentSource     337
interactive positioning of resources     356
interactivity     311

enabled in resources     120
gesture, mouse enabled     120
kiosk application     120

L
layer transitions     88
layers area     86
layers explained     88
layout view     356
LCTimeline (logic control)     393
leader-follower     61
leader-follower control     13
LED displays     191
licensing DeltaServer    

7thSense     457
expiry     457
integrator/reseller     457
updating     457

list markers     293
load default show     100
log files     471
loop timeline media     290
LTC     461
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M
macros     365
markers    

snap to marker     293
media layers     354
media resource animation     360
media resources     83
media resources supported     43
menus, DeltaGUI    

main     65
servers     73
workspaes     72

merge autoalignment     100
merge common resources     100
merge permanent display config     100
mesh mode    

2D/3D view (calibration)     243
3D calibration     243
active 3D workflow     263
apply lens distortion     243
blending     256
canvas     236
channel beam controls     236
clipping planes     267
configuration     229
DeltaGUI     236
editing a mesh .obj     267
editing points     243
explained     229
eyepoint     236
eyepoint parameters     233, 235
how it works     233
lens modes     243
linked vertex selection     267
manipulating the mesh view     243
media     229
mesh editor     267
mesh not showing on playback     256
movement nodes     275
node movement size     267
node selection size     267
node size     267
projection (flat) mode     229
projector positions     236
setup sequence     234
textured (UV) mode     229
textured mode     260
troubleshooting     256
using multiple meshes     261

warp, distort or edit?     256
warping a mesh     253

mesh models     229
MiniDump log files     471
miscellaneous settings    

autoplay movies     119
cross-fade timelines     119
sync mesh files to DeltaGUI     119
video capture on pause     119

mismatched software version     57
morph     364
motion effects     361
motion paths (splines)     52, 163
motion tracking     277
movies    

encrypted     282
encrypting     47
formats, quality, requirements     47
framerate compensation     318
hold on last frame     318
looping     318
missing frames     282
supported formats     44

MPCDI file sets, location     225

N
NatNet streaming     277
NDI capture     331
NDI output    

configuration     140
outputs presets     140

NDI Preview    
enable     117

NDI, enable     425
non-seamless looping     298
Notch effects     413
NotchLC     44

O
online help     450
optical tracking     277
OptiTrack Motive     277
OSC and external control     489
OSC connection     107
output channel modes     134
output colour space     134
output mode     134
output setup     134
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P
path defaults (other resources)     124
path defaults (show, recording, mesh)     102
permanent geometry     167
pixel shift     134
placeholders    

clone properties     289
controls     286
media     286, 289
replace media     289

playback controls     81
playback problems     470
playback window     65

allow global interactivity     120
audio VU meter     37
display movie timecode     345
display timecode     345
graph     37
information     37
movie timecode     37
quick keys     37
statistics     37
timecode     37

playlist    
child resource overrides     401
overrides, global     402

playlists     53
playlists container     398
point distortion grid     154
preset resources     305
preview    

configure     426
connect     426
external controls     426
from DeltaGUI     426
from Stack web interface     426
web browser     425

preview window settings     117
pre-warped media     189
projection mapping     229
projector colour balance     386
Protecting the C:\ drive     476

R
RAID7th disk array     102
recording     435

Art-Net     437
recording from preview     435
recording from timelines     430

recording shows    
paths and variables     430

render modes     134
replacing timeline resources     290
reserve (timeline) mode     65
reserve timeline     89
reset distortion     154
resource default settings     121
resource editor    

Art-Net and DMX     351
audio     312
audio attributes     321
canvas position     355
capture     312
channel offset (audio)     312
chroma and luma     349
colour controls     351
controls placeholder     343
events     312
framerate compensation     321
general     311
GoTo control     343
looping     321
markers     312
movie attributes     318
movie timecode     345
movies and images     312
text     345
timecode     345
timeline settings     312
video capture     323

resource folders     83
resource layout on canvas     356
resource pool enumeration, selective     486
resource pool width     83
resource properties     306
restoring a mesh .obj     267
reverse playback     81

S
save (shows)     65
save all (shows)     65
save configured resource     305
save locally     65
Scalable Display Manager    

autoalignment     217
boundary     217
calibration     217
cameras     217
display clients     217
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Scalable Display Manager    
eye point     217
file locations     217
import to Delta     217
orientation     217
perspective     217
projectors     217
screen shape     217

SDI configuration     459
seamless audio joins     298
seamless looping     298, 301
search resources     306
select server for DeltaGUI     73
sequence blocks     365
sequence editor     365

active sequences     381
assign buttons     374
code syntax     379
pages     374
running     374
variables     376

sequence panel    
assign buttons     382

sequences     365
debug     373
run     374
write or edit     369

serial events     384
Telnet     50, 385

serial ports     107
server connections     57
server group (assign)     99
server group mode (output)     134
server grouping     61
server groups     13, 57
server information     111
server messages     80
server status, DeltaServer     31
server type (assign)     99
shader effects     43, 53, 410

bit-depth shader     412
degradation shader     412
fade     408
frag files     408
Notch     408
transparency     408
vert files     408
xml files     408

shortcut keys, DeltaGUI and DeltaServer     465
show mode    

defaults on load     122

streaming video     122
show-building     354
Show-mode     65
slideshows    

creating     416
timing     416

slow DeltaGUI PC     75
SMPTE device     104
snap to grid     356
splines     43, 52

configuration     163
controls     163
snap to grid     163
timing     388

split timeline media     290
Spout capture     325
SSH     107
ST 2110     134
ST 2110 preview     117
ST maps     189
Stack web interface     12, 425
startup preferences     100
startup sequence     100
stereo (3D)    

active     145
passive     143

stream capture     336
surface geometry     152
switches    

beams     280
warp     280

system architecture     12
system logging     99
system logs, DeltaServer     471
system preferences     99

T
TCD     301
TCP connection (server)     107
TCP connections (client)     96
templating a timeline     290
terms and definitions     19
test patterns     142
text     43
timeline    

add resources     282
aligning media     290
arranging resources     286
Composite mode     91
configure properties     310



503

M723-2 DeltaServer and DeltaGUI 2.8 : User Guide 
 
                                                                                                    © 2024 7thSense

Index

timeline    
control lines     293
controls     81, 284
cross-fade     89
cutting media     290
delete media     303
dialog     91
disable layer     303
disable resource     303
disable visual resources     91
duration of resources     284
face     91
geometry properties     290
Global Z mode     91
group selection of resources     287
layer properties     290
length     104
lock resource     303
looping media     290
markers     293
media placeholders     289
mode     91
movie properties     290
multiple     89
naming     89
naming and selection     73
normal mode     91
opacity     91
outline media     304
playback controls     91
positioning resources     284
replacing resources     286
reserve     89
reserve timeline, assign     91
resource editor     310
resource properties     290
splitting, cutting, concatenating media     290
summary     307

timeline controls    
DeltaServer     32
GoTo     343

timeline resource properties     86
timing    

Adrielec     463
BlackMagic     461
BlueFish SDI     461
configuration     104
control area     82
control network connection     104
external LTC     463
framerates     104

mode     104
MTC input     463
RS422 devices     461
RS422 transport controls     463

timing controls     43
timing controls distribution     301
timing group     13
toolbars and buttons     94
transform animation     361

absolute     361
relative     362
speed     363

transition effects     410
transitions     43
transparency     43
troubleshooting     468

mesh mode     256
mesh not showing in playback     256

U
UDP connection (server)     107
uninstalling Delta     17
user interface    

active timeline indicators     114
autosave     114
colours     113
control lines     75
decluttering     75
DeltaGUI password     114
DeltaGUI update options     75
fade, transparency     114
file modified warnings     115
graphics     112
grid snap     112
highlights     75
intelligent resources     114
juddering GUI when playing     75
layer preferences     75
layer sizes     112
resource window     114
snap options     75
snap to grid/resources     112
tooltips     75, 112
update frequency     112

user stats settings (playback window user
information)     131
UV mapped media     229

V
variables     376
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version (Delta)     14, 57
version (DeltaGUI)     65
video capture    

deinterlace     323
device IDs     323
freeze group     323
groups     339
Spout     325
web resource     328

View menu (DeltaGUI)     65
view server list     61
VIOSO     225
VNC password     99

W
warp    

background layer     150
colour convergence     152
controls     152
distortion     364
grid     152
point distortion     154
surface     152, 364
timeline     364
timeline (channel)     151

web resource    
JavaScript events     328
transparency     328

WebRTC    
enable     117

WebRTC, enable     425
Windows 10 UWF     476
Windows event logs     471
wizard    

slideshow     416
Wizards     65
wobulation projectors     134

X
XDL files     167
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